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Notice

This manual contains information that is proprietary to RAD Data Communications Ltd. ("RAD"). No
part of this publication may be reproduced in any form whatsoever without prior written approval by
RAD Data Communications.

Right, title and interest, all information, copyrights, patents, know-how, trade secrets and other
intellectual property or other proprietary rights relating to this manual and to the ASMi-52 and any
software components contained therein are proprietary products of RAD protected under international
copyright law and shall be and remain solely with RAD.

ASMI-52 is a registered trademark of RAD. No right, license, or interest to such trademark is granted
hereunder, and you agree that no such right, license, or interest shall be asserted by you with respect
to such trademark.

You shall not copy, reverse compile or reverse assemble all or any portion of the Manual or the
ASMi-52. You are prohibited from, and shall not, directly or indirectly, develop, market, distribute,
license, or sell any product that supports substantially similar functionality as the ASMi-52, based on or
derived in any way from the ASMi-52. Your undertaking in this paragraph shall survive the termination
of this Agreement.

This Agreement is effective upon your opening of the ASMi-52 package and shall continue until
terminated. RAD may terminate this Agreement upon the breach by you of any term hereof. Upon
such termination by RAD, you agree to return to RAD the ASMi-52 and all copies and portions thereof.

For further information contact RAD at the address below or contact your local distributor.

International Headquarters North America Headquarters

RAD Data Communications Ltd. RAD Data Communications Inc.
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Limited Warranty

RAD warrants to DISTRIBUTOR that the hardware in the ASMi-52 to be delivered hereunder shall be
free of defects in material and workmanship under normal use and service for a period of twelve (12)
months following the date of shipment to DISTRIBUTOR.

If, during the warranty period, any component part of the equipment becomes defective by reason of
material or workmanship, and DISTRIBUTOR immediately notifies RAD of such defect, RAD shall have
the option to choose the appropriate corrective action: a) supply a replacement part, or b) request
return of equipment to its plant for repair, or c) perform necessary repair at the equipment's location.
In the event that RAD requests the return of equipment, each party shall pay one-way shipping costs.

RAD shall be released from all obligations under its warranty in the event that the equipment has been
subjected to misuse, neglect, accident, or improper installation, or if repairs or modifications were
made by persons other than RAD's own authorized service personnel, unless such repairs by others
were made with the written consent of RAD.

The above warranty is in lieu of all other warranties, expressed or implied. There are no warranties
which extend beyond the face hereof, including, but not limited to, warranties of merchantability and
fitness for a particular purpose, and in no event shall RAD be liable for consequential damages.

RAD shall not be liable to any person for any special or indirect damages, including, but not limited to,
lost profits from any cause whatsoever arising from or in any way connected with the manufacture,
sale, handling, repair, maintenance or use of the ASMi-52, and in no event shall RAD's liability exceed
the purchase price of the ASMi-52.

DISTRIBUTOR shall be responsible to its customers for any and all warranties which it makes relating
to ASMi-52 and for ensuring that replacements and other adjustments required in connection with the
said warranties are satisfactory.

Software components in the ASMi-52 are provided "as is" and without warranty of any kind. RAD
disclaims all warranties including the implied warranties of merchantability and fitness for a particular
purpose. RAD shall not be liable for any loss of use, interruption of business or indirect, special,
incidental or consequential damages of any kind. In spite of the above RAD shall do its best to provide
error-free software products and shall offer free Software updates during the warranty period under
this Agreement.

RAD's cumulative liability to you or any other party for any loss or damages resulting from any claims,
demands, or actions arising out of or relating to this Agreement and the ASMi-52 shall not exceed the
sum paid to RAD for the purchase of the ASMi-52. In no event shall RAD be liable for any indirect,
incidental, consequential, special, or exemplary damages or lost profits, even if RAD has been advised of
the possibility of such damages.

This Agreement shall be construed and governed in accordance with the laws of the State of Israel.



General Safety Instructions

The following instructions serve as a general guide for the safe installation and operation of
telecommunications products. Additional instructions, if applicable, are included inside the manual.

/N

Warning

/N
1

/o

Warning

Safety Symbols

This symbol may appear on the equipment or in the text. It indicates
potential safety hazards regarding product operation or maintenance to
operator or service personnel.

Danger of electric shock! Avoid any contact with the marked surface while
the product is energized or connected to outdoor telecommunication lines.

Protective earth: the marked lug or terminal should be connected to the building
protective earth bus.

Some products may be equipped with a laser diode. In such cases, a label

with the laser class and other warnings as applicable will be attached near

the optical transmitter. The laser warning symbol may be also attached.

Please observe the following precautions:

¢ Before turning on the equipment, make sure that the fiber optic cable is
intact and is connected to the transmitter.

e Do not attempt to adjust the laser drive current.

¢ Do not use broken or unterminated fiber-optic cables/connectors or look
straight at the laser beam.

¢ The use of optical devices with the equipment will increase eye hazard.

¢ Use of controls, adjustments or performing procedures other than those
specified herein, may result in hazardous radiation exposure.

ATTENTION: The laser beam may be invisible!

In some cases, the users may insert their own SFP laser transceivers into the product. Users are alerted
that RAD cannot be held responsible for any damage that may result if non-compliant transceivers are
used. In particular, users are warned to use only agency approved products that comply with the local
laser safety regulations for Class 1 laser products.

Always observe standard safety precautions during installation, operation and maintenance of this
product. Only qualified and authorized service personnel should carry out adjustment, maintenance or
repairs to this product. No installation, adjustment, maintenance or repairs should be performed by
either the operator or the user.



Handling Energized Products

General Safety Practices

Do not touch or tamper with the power supply when the power cord is connected. Line voltages may be

present inside certain products even when the power switch (if installed) is in the OFF position or a fuse is
blown. For DC-powered products, although the voltages levels are usually not hazardous, energy hazards

may still exist.

Before working on equipment connected to power lines or telecommunication lines, remove jewelry or any
other metallic object that may come into contact with energized parts.

Unless otherwise specified, all products are intended to be grounded during normal use. Grounding is
provided by connecting the mains plug to a wall socket with a protective earth terminal. If an earth lug is
provided on the product, it should be connected to the protective earth at all times, by a wire with a
diameter of 18 AWG or wider. Rack-mounted equipment should be mounted only in earthed racks and
cabinets.

Always make the ground connection first and disconnect it last. Do not connect telecommunication cables
to ungrounded equipment. Make sure that all other cables are disconnected before disconnecting the
ground.

Connection of AC Mains
Make sure that the electrical installation complies with local codes.
Always connect the AC plug to a wall socket with a protective ground.

The maximum permissible current capability of the branch distribution circuit that supplies power to the
product is 16A. The circuit breaker in the building installation should have high breaking capacity and must
operate at short-circuit current exceeding 35A.

Always connect the power cord first to the equipment and then to the wall socket. If a power switch is
provided in the equipment, set it to the OFF position. If the power cord cannot be readily disconnected in
case of emergency, make sure that a readily accessible circuit breaker or emergency switch is installed in the
building installation.

In cases when the power distribution system is IT type, the switch must disconnect both poles
simultaneously.

Connection of DC Mains

Unless otherwise specified in the manual, the DC input to the equipment is floating in reference to the ground.
Any single pole can be externally grounded.

Due to the high current capability of DC mains systems, care should be taken when connecting the DC supply
to avoid short-circuits and fire hazards.

DC units should be installed in a restricted access area, i.e. an area where access is authorized only to
qualified service and maintenance personnel.

Make sure that the DC supply is electrically isolated from any AC source and that the installation complies
with the local codes.

The maximum permissible current capability of the branch distribution circuit that supplies power to the
product is 16A. The circuit breaker in the building installation should have high breaking capacity and must
operate at short-circuit current exceeding 35A.

Before connecting the DC supply wires, ensure that power is removed from the DC circuit. Locate the
circuit breaker of the panel board that services the equipment and switch it to the OFF position. When
connecting the DC supply wires, first connect the ground wire to the corresponding terminal, then the
positive pole and last the negative pole. Switch the circuit breaker back to the ON position.

A readily accessible disconnect device that is suitably rated and approved should be incorporated in the
building installation.

If the DC mains are floating, the switch must disconnect both poles simultaneously.



Connection of Data and Telecommunications Cables

Data and telecommunication interfaces are classified according to their safety status.

The following table lists the status of several standard interfaces. If the status of a given port differs from
the standard one, a notice will be given in the manual.

Ports Safety Status

V.11, V.28, V.35, V.36, RS-530, SELV  Safety Extra Low Voltage:
X.21, 10 BaseT, 100 BaseT,
Unbalanced E1, E2, E3, STM, DS-2,
DS-3, S-Interface ISDN, Analog voice
E&M

Ports which do not present a safety hazard. Usually
up to 30 VAC or 60 VDC.

xDSL (without feeding voltage), TNV-1 Telecommunication Network Voltage-1:

Balanced E1, T1, Sub E1/T1 Ports whose normal operating voltage is within the

limits of SELV, on which overvoltages from
telecommunications networks are possible.

FXS (Foreign Exchange Subscriber) TNV-2  Telecommunication Network Voltage-2:

Ports whose normal operating voltage exceeds the
limits of SELV (usually up to 120 VDC or telephone
ringing voltages), on which overvoltages from
telecommunication networks are not possible. These
ports are not permitted to be directly connected to
external telephone and data lines.

FXO (Foreign Exchange Office), xDSL  TNV-3 Telecommunication Network Voltage-3:
(with feeding voltage), U-Interface

ISDN Ports whose normal operating voltage exceeds the

limits of SELV (usually up to 120 VDC or telephone
ringing voltages), on which overvoltages from
telecommunication networks are possible.

Always connect a given port to a port of the same safety status. If in doubt, seek the assistance of a
qualified safety engineer.

Always make sure that the equipment is grounded before connecting telecommunication cables. Do
not disconnect the ground connection before disconnecting all telecommunications cables.

Some SELV and non-SELV circuits use the same connectors. Use caution when connecting cables.
Extra caution should be exercised during thunderstorms.

When using shielded or coaxial cables, verify that there is a good ground connection at both ends. The
earthing and bonding of the ground connections should comply with the local codes.

The telecommunication wiring in the building may be damaged or present a fire hazard in case of
contact between exposed external wires and the AC power lines. In order to reduce the risk, there are
restrictions on the diameter of wires in the telecom cables, between the equipment and the mating
connectors.



Caution 14 reduce the risk of fire, use only No. 26 AWCG or larger telecommunication line cords.

Attention  poyr réduire les risques s'incendie, utiliser seulement des conducteurs de
télécommunications 26 AWG ou de section supérieure.

Some ports are suitable for connection to intra-building or non-exposed wiring or cabling only. In such
cases, a notice will be given in the installation instructions.

Do not attempt to tamper with any carrier-provided equipment or connection hardware.

Electromagnetic Compatibility (EMC)

The equipment is designed and approved to comply with the electromagnetic regulations of major
regulatory bodies. The following instructions may enhance the performance of the equipment and will
provide better protection against excessive emission and better immunity against disturbances.

A good earth connection is essential. When installing the equipment in a rack, make sure to remove all
traces of paint from the mounting points. Use suitable lock-washers and torque. If an external
grounding lug is provided, connect it to the earth bus using braided wire as short as possible.

The equipment is designed to comply with EMC requirements when connecting it with unshielded
twisted pair (UTP) cables. However, the use of shielded wires is always recommended, especially for
high-rate data. In some cases, when unshielded wires are used, ferrite cores should be installed on
certain cables. In such cases, special instructions are provided in the manual.

Disconnect all wires which are not in permanent use, such as cables used for one-time configuration.

The compliance of the equipment with the regulations for conducted emission on the data lines is
dependent on the cable quality. The emission is tested for UTP with 80 dB longitudinal conversion loss
(LCL).

Unless otherwise specified or described in the manual, TNV-1 and TNV-3 ports provide secondary
protection against surges on the data lines. Primary protectors should be provided in the building
installation.

The equipment is designed to provide adequate protection against electro-static discharge (ESD).
However, it is good working practice to use caution when connecting cables terminated with plastic
connectors (without a grounded metal hood, such as flat cables) to sensitive data lines. Before
connecting such cables, discharge yourself by touching earth ground or wear an ESD preventive wrist
strap.

FCC-15 User Information

This equipment has been tested and found to comply with the limits of the Class A digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the Installation and Operation manual, may cause harmful interference to the radio
communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.



Canadian Emission Requirements

This Class A digital apparatus meets all the requirements of the Canadian Interference-Causing
Equipment Regulation.

Cet appareil numérique de la classe A respecte toutes les exigences du Reglement sur le matériel
brouilleur du Canada.

Warning per EN 55022 (CISPR-22)

Warning This is a class A product. In a domestic environment, this product may cause
radio interference, in which case the user will be required to take adequate
measures.

Cet appareil est un appareil de Classe A. Dans un environnement résidentiel, cet
Avertissement appareil peut provoquer des brouillages radioélectriques. Dans ces cas, il peut
étre demandé a I'utilisateur de prendre les mesures appropriées.

Dieses ist ein Gerat der Funkstorgrenzwertklasse A. In Wohnbereichen kénnen
Achtung bei Betrieb dieses Gerdtes Rundfunkstrérungen auftreten, in welchen Fallen der
Benutzer fir entsprechende Gegenmafinahmen verantwortlich ist.




Declaration of Conformity

Manufacturer's Name: RAD Data Communications Ltd.
Manufacturer's Address: 24 Raoul Wallenberg St.

Tel Aviv 69719

Israel

declares that the product:
Product Name: ASMi-52
Conforms to the following standard(s) or other normative document(s):

EMC: EN 55022: 1994 Limits and methods of measurement of radio disturbance
characteristics of information technology equipment.

EN 55024: 1998 Information technology equipment — Immunity characteristics
— Limits and methods of measurement.

Safety: EN 60950: 2000 Safety of information technology equipment.

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 89/336/EEC, the Low
Voltage Directive 73/23/EEC and the R&TTE Directive 99/5/EC. The product was tested in a typical
configuration.

Tel Aviv, 30th June, 2002

vl -

Haim Karshen
VP Quality

European Contact: RAD Data Communications GmbH, Otto-Hahn-Str. 28-30,
85521 Ottobrunn-Riemerling, Germany



Quick Start Guide

Installation of ASMi-52 should be carried out only by an experienced technician. If
you are familiar with ASMi-52, use this guide to prepare the units for operation.

1. Installing ASMi-52

Connecting the Interfaces
1. Connect the line to the RJ-45 rear panel connector dedicated SHDSL.
2. Connect the DTE to the appropriate rear panel connector.

3. Connect the control terminal to the rear panel CONTROL connector.

Connecting the Power
e Connect the AC or DC power to the ASMi-52 modem.

The unit has no power switch. Operation starts when power is connected
to the rear panel power connector.

2. Configuring ASMi-52

Configure ASMi-52 to the required operation mode via an ASCII terminal
connected to the rear panel CONTROL port directly or via a modem link.

Connecting the Terminal
» To connect the terminal:
1. Connect the terminal cable to the CONTROL connector of ASMi-52.
2. Turn the control terminal on.

3. Configure the terminal to the default communication parameters: 9.6 kbps,
one start bit, eight data bits, no parity, one stop bit.

4. Select the full-duplex mode.
5. Turn the terminal echo off.

6. Disable any type of flow control.

You are now ready to start a control session.

ASMi-52 Ver. 2.5 Configuring ASMi-52 1
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Configuring the Master Clock

» To configure the master clock:

e From the System Configuration menu (Main Menu > Configuration > System
Configuration > Master Clock), configure the central ASMi-52 clock to
external or internal and remote ASMi-52 clock to the receive clock.

Configuring the SHDSL Interface
» To configure the SHDSL interface:

e From the SHDSL Configuration menu (Main Menu > Configuration > Port
Configuration > SHDSL Configuration), configure the following SHDSL
parameters:

= SHDSL compatibility

= Power backoff

= Snext margin, if line probing is set to adaptive

= Current margin, if line probing is set to adaptive

= Power spectral density (for ASMi-52 with 2-wire line interface and line
probing set to fixed)

= Line probing
= Line type (for 4-wire ASMi-52 units only)
» Loop attenuation threshold

= SNR margin threshold.

Configuring the DTE Interface

ASMi-52 includes a serial, ET, T1, or 10/100BaseT DTE interface configured as a
single interface. ASMi-52 can be multiplexed as i.e., ET + Serial DTE interface, or
E1 + 10/100BaseT DTE interface, or Serial + 10/100BaseT DTE interface, in
which case each pair of interface has to be configured separately.

Configuring the Serial Interface

» To configure the serial interface:

e From the DTE Port Configuration (Main Menu > Configuration > Port
Configuration > DTE Configuration), select the required data rate.

Configuring the E1 Interface

When configuring an E1 interface, you have to select the modem’s framing mode
and assign each E1 timeslot to carry data or idle code.

If in your application, an ASMi-52 unit with an E1 interface operates opposite
another ASMi-52 unit, the E1 settings of the remote device are automatically
matched to those of the local modem (the Units Identical Setting value is set to YES
by default). The Units Identical Setting value of the local modem overrides the
management commands of the remote supervisory terminal.

2 Configuring ASMi-52 ASMi-52 Ver. 2.5
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» To configure E1 parameters:

Note

From the E1 Port Configuration menu (Main Menu > Configuration > Port
Configuration > E1 Port Configuration), configure the following E1
parameters:

= Framing mode

= Timeslot assignment

You can configure timeslot O to be looped or transparent:

» Looped — timeslot O is sent back to the ET interface, when operating
opposite remote units with a serial data interface.

= Transparent — timeslot O is transmitted to the remote modem.

If you operate ASMi-52 with the G732S framing, timeslot O is always
transparent and timeslot 16 is always connected.

When operating a 2-wire ASMi-52 with ET interface opposite ASMi-52 with
V.35 interface (not in LS mode), assign at least three timeslots, excluding
timeslot O, to carry data.

When operating a 4-wire ASMi-52 with E1 interface opposite ASMi-52 with
V.35 interface (not in LS mode), assign at least six timeslots, excluding timeslot
0, to carry data.

Configuring the T1 Interface

» To configure the T1 parameters:

From the T1 Port Configuration menu (Main Menu > Configuration > Port
Configuration > T1 Port Configuration), configure the following T1 parameters:

* Framing mode

= Line coding

* Receive gain

* Interface type

= Transmit signal mask

= Timeslot assignment

Configuring the 10/100BaseT Interface

» To configure 10/100BaseT parameters:

ASMi-52 Ver. 2.5

From the LAN Configuration menu (Main Menu > Configuration > System
Configuration > LAN Configuration), configure the following LAN parameters:

= Bridge static table
* Aging timeout
* LAN rate

Configuring ASMi-52 3
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Versions

ASMi-52 Ver. 2.5

Chapter 1

Introduction

1.1 Overview

ASMi-52 is an SHDSL modem that operates in full-duplex over 2/4-wire lines and
offers a cost-effective solution for delivering digital data to customer premises over
existing copper cables. ASMi-52 handles multiple data rates in the range of
64-4608 kbps. The unit is available with a single data port or as a multiplexer with
two data ports. The modem supports X.21, V.35, RS-530, E1 and T1 interfaces. In
addition, ASMi-52 may contain an Ethernet/Fast Ethernet bridge with VLAN
support (via management LAN port), or an IP router (IR-IP).

ASMi-52 uses TC-PAM coding and complies with the ITU-T G.991.2 requirements,
see page 1-7.

Certain multiplexer application combinations are possible. See Table 1-4 for the
multiplexer applications.

DTE Interface
ASMi-52 supports the following DTE interfaces:

e X21

e RS-530

e E1,as per G.704
e TI1

e Ethernet/Fast Ethernet bridge with VLAN support (combined with management
LAN port)

e [R-IP (IP router).

The following combinations of interfaces can be multiplexed:
e V.35 + LAN

e ET+ LAN

e E1 + serial port (V.35, X.21, RS-530)

Line Interface
e ASMi-52 for operation over a 2-wire line

e ASMi-52 for operation over a 4-wire line.

Overview 1-1
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Unit Enclosure

ASMi-52 is available in a plastic, metal, or rail-mount enclosure.

Applications

Figure 1-1 illustrates a typical ASMi-52 application, in which standalone modems
operate opposite each other. Figure 1-2 shows ASMi-52 units operating opposite a
centrally located DXC rack. Figure 7-3 shows ASMi-52 modems operating opposite
a centrally located LRS-24 rack.

The following multiplexer applications are supported:
e A multiplexer unit opposite the same type of multiplexer unit

e A DXC opposite multiplexer units (the multiplexer unit is a CPE), where the
DXC supports a multiplexer (the CPE is the receive clock source)

e A multiplexer unit configured as a single unit opposite a single unit (where a
multiplexer unit is configured as a single unit)

e A multiplexer unit opposite an E1 unit, where the single or multiplexer unit is
configured as an E1 single unit.

Central Office | / Customer Premises \

Router Router

V.35 V.35

ASMi-52 ASMi-52

ASMi-52 ASMi-52

Router Router

Router Router

ASMi-52 ASMi-52

Router P \ Router /

Figure 1-1. Standalone Modem Application

1-2 Overview ASMi-52 Ver. 2.5



Installation and Operation Manual

Chapter 1 Introduction

Central Site

E1, T1, V.35 X.21,

A
/

RS-530, Ethernet LRS-24 4-wire

Remote Site A \

£F=

LAN Router

V.35

ASMi-52 Router

Public
Network \ | X
4-wire
Optimux-XLE 1
-
Remote Site B \
SNMP Management
Station

\ / E Ethernet

2-wire

ASMi-52

E Ethernet

2-wire

KASMi-SZ -I—/

Figure 1-2. ASMi-52 Modems Operating Opposite a Centrally Located LRS-24 Rack

4 N

f ASMi-52 e
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—
LRS-24
‘‘‘‘‘‘ ASMi-52 ~
Public P V.35
Network \ | —
ASMi-52CD ASMiL52 foulans
ASMi-52CD/4 A—— Ethernet - |
—
Router
SNMP Management RemOte SIte
Station

- 4

\

Figure 1-3. ASMi-52 Modems Operating opposite ASMi-52CD Cards
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Features
Functionality
ASMi-52 can be configured to operate in a CO (central office) or CPE (customer
premises equipment) mode.
Line Interface
ASMi-52 extends the range of data transmission over 2/4-wire lines up to 7.0 km
(4.3 miles), by employing SHDSL TC-PAM technology. ASMi-52 operation
complies with the requirements of the ITU-T G.991.2 standard. In addition, 4-wire
ASMi-52 units can be configured to operate over 2-wire lines.
Table 1-1 lists typical ASMi-52 ranges over 2/4-wire 26 AWG line.
Table 1-1. Typical Ranges (26 AWG)
Data Rate 2-wire 4-wire
[kbps] [km] [miles] [km] [miles]
64 7.5 4.6 — —
128 7.0 4.3 7.1 4.4
256 6.7 4.1 6.8 4.2
384 6.5 4.0 6.7 4.1
512 6.3 3.9 6.6 4.1
1024 5.3 3.3 6.0 3.7
1536 5.0 3.1 5.6 3.5
2048 4.5 2.8 4.7 2.9
2304 4.2 2.6 4.5 2.8
4096 - - 3.7 2.3
4608 - - 3.0 1.8
Note

1-4

The typical ranges are based on error-free lab tests without noise.

ASMi-52CD/4W operates at data rates up to 4608 kbps, depending on internal or

external clock.

Overview
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Note

ASMi-52 Ver. 2.5

DTE Interface
ASMI-52 supports the following DTE interfaces:

e X.21

e V.35

e RS-530

e [ET1,asperG.704
e TI1

e Ethernet/Fast Ethernet bridge with VLAN support (combined with management
LAN port)

e [R-IP (IP router).

When ASMi-52 is ordered only with the 10/100BaseT port, it can be used to
transfer user and management data.

An unbalanced ET interface is provided via an adapter cable (CBL-RJ-45/2BNC/ET).
The impedance conversion (1202to 75 is performed by ASMi-52 automatically
when the adapter cable connection is detected.

ASMI-52 supports multiple data rates between the range of 64 kbps and
4608 kbps. The data rate depends on the following factors:

e Unit rate mode (regular or low speed)

e Line interface type (2-wire or 4-wire)

e DTE interface type of the local and remote units (serial or E1/T1)

e Clock mode (internal or external)

e Single or multiplexed.

Table 1-2 and Table 1-3 detail the ASMi-52 data rates with the possible
combinations of rate mode types, line/DTE interface types, and clock modes.

Overview 1-5
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Table 1-2. ASMi-52 Data Rates

DTE Interface and Clock Mode

Line Interface

Local ASMi-52 Remote ASMi-52 2-wire 4-wire
Serial DTE interface, ~ Serial DTE interface | nx 64 kbps (n =1, 2,...32,36) nx128kbps (n =1, 2,...32, 36)
internal clock
Serial DTE interface, ~ Serial DTE interface | n x 64 kbps (n =1, 2, ..., 36) nx128 kbps(n =1, 2, ..., 36)
external clock
Serial DTE interface  E1 DTE interface n x 64 kbps (n = 3, 4, ..., 32) nx 128 kbps (n = 3,4, ..., 16)
E1 DTE interface Serial DTE interface | n x 64 kbps (n = 3, 4, ..., 32) nx 128 kbps (n = 3,4, ..., 16)
E1 DTE interface E1 DTE interface nx64kbpsin=1,2,...,32) nx64kbps(n=1,2,...,32)
T1 DTE interface T1 DTE interface nx64kbps(n=1,2,...,24) nx64kbps(n=1,2,...,24)
Multiplexer Serial/E1 DTE nx64kbps(in=1,2,...,32) nx64kbps(n=1,2,...,32)
(any) interface
Table 1-3. ASMi-52 Data Rates (Low Speed Mode)
Unit and DTE Interface Type Line Interface
Local Unit Remote Unit 2-wire 4-wire
ASMi-52 in low nx64kbps(n=1,2,...,32) nx64kbps(n=1,2,...,32)
speed mode
ASMi-52 in low ASMi-52 with serial | n x 64 kbps (n = 3, 4, ..., 32) nx 128 kbps (n = 3, 4, ..., 16)
speed mode DTE interface
ASMi-52 with E1 nx64kbps(n=1,2,...,32) nx64kbpsin=1,2,...,32)
DTE interface
Note  The data rates for a multiplexer modem in Table 1-2 include the entire data rates

1-6

sum for all the interfaces.
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Notes o

Multiplexer Applications

must have a DTE or IR port.
e The hardware of a single unit-based product with a LAN port manager is

different from that of a multiplexer-based product.

Chapter 1 Introduction

The multiplexer unit cannot be configured as a device with LAN only port. It

The hardware has different options for the modem to work as a multiplexer.
Table 1-4 shows all the available multiplexer combinations that can be used.

Note  Software for a multiplexer version is available but is not transferable to a single port
unit.
Table 1-4. Possible Multiplexer Applications
CO/CPE E1 Serial DTE LAN ; Serial
E1+Serial DTE E1+LAN DTEALAN
E1—E1 E1<E1 E1<Serial DTE
E1 E1oE EloSerial DTE | EToLAN | E1eSerial DTE
E1<>E1+Serial E1<Serial
DTE EToETHLAN DTE+LAN
N N Serial DTE<>E1 | Serial DTE-ET SEQ::LID;?
Serial Serial DTEET Sel’lé% DTE«~ Seria
DTE Serial DTE DTE~LAN Serial DTE&
Serial DTE
. LAN<ET LAN<ET LAN < Serial
LAN<Serial DTE
LAN LAN«ET DTE LAN<LAN
LAN<«>Serial
DTE
E1E1 E1<sSerial DTE E1LAN Ele ';T?e”a' E1E1 E1<sSerial DTE
. Serial DTE
Serial DTEET | ¢ o "o V.35<LAN E1<E1
E1+Serial . E1<Serial
DTEGET E1«<Serial DTE E1—ET+LAN DTE-+LAN
T Serial DTE—E1 | Serial DTE&ET SEZELP;‘E_’
DTE
Serial DTE—
Serial DTE
E1+Serial
DTE«E]
E1+Serial DTE E1+Serial
—E1+Serial DTEGET
DTE
ASMi-52 Ver. 2.5 Overview 1-7
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Table 1-4. Possible Multiplexer Applications (Cont.)
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CO/CPE E1 Serial DTE LAN . Serial
E1+Serial DTE E1+LAN DTESLAN
E1E1 E1oSerial DTE E1LAN EMESTJFES”'E" E1E1 E1oSerial DTE
E1+LAN«ET E1ET
. E1<Serial
E1+LAN E1eSerial DTE | E1<ET1+LAN DTE-+LAN
E1+LAN<«ET E1+LAN«ET
E1+LANw
E1+LAN
. Serial DTE«~ Serial . Serial DTE
Serial DTE-ET Serial DTE DTEGLAN Serial DTEET | ool DTE
Serial DTE+ .
LANGET Serial DTE—E1
; Serial DTE—
Serial Serial DTE
DTE+LAN
Serial DTE+ Serial DTE+
LAN<ET LAN<ET
Serial DTE
+LANoSerial
DTE +LAN
DXCe—E1+ DXCe—E1 DXC«sSerial
Dxc Serial DTE +LAN DTE+LAN
LRS-24 LRS-24 LRS-24 < Serial
LRS-24 E1+Serial DTE E1+LAN DTE+LAN
Note  Serial DTE = V.35, X.21, RS-530, IR-IP

1-8

Note

The following are multiplexer conditions when working with the ASMi-52 unit:

e E1+Serial DTE can work as an ‘ET port only’.

e ET+LAN can work as an ‘ET port only’.
e LAN+Serial DTE can work as a ‘Serial DTE port only’.

e ET1+Ethernet and Serial DTE+Ethernet can be configured as a single port only
(‘ET only” or ‘Serial DTE only’) while the Ethernet port operates as a
management port only.

ASMi-52 ET or Serial DTE units with a LAN management port previously released

with software versions earlier than version 2.5 cannot operate as a multiplexer unit
(ET+LAN, Serial DTE+LAN) with version 2.5 due to hardware differences.

Timing

ASMI-52 supports three clock modes:

e Internal, derived from its internal oscillator (CO mode)
e External, supplied by the attached DTE

Overview
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e Receive, recovered from the received line signal (CPE mode).

Management

ASMi-52 supports the following management options:

e ASCII terminal or Easy Config hand-held device via V.24/RS-232 terminal port
e Telnet via a dedicated 10/100BaseT port

e SNMP network management (RADview) via a dedicated 10/100BaseT port

e PC, running a Web browsing application (ConfiguRAD)

¢ Inband management via a dedicated timeslot (units with E1/T1 interface only).
EOC

ASMi-52 provides an inband management channel (EOC) for end-to-end system
management and supervision. This management channel uses SHDSL overhead
bits and operates without interfering with data transmission.

ConfiguRAD

ConfiguRAD is a user-friendly Web-based terminal management system used for
remote device configuration and maintenance. It is embedded in ASMi-52 and
provided at no extra cost. ConfiguRAD can be run from any standard Web
browser.

Dial-In

The V.24 terminal port supports a dial-up modem connection for remote
management of ASMi-52 over telephone lines.

Dial-Out

The V.24 terminal port supports alarm dial-out.

Diagnostics

ASMi-52 supports activation of the following:

e Local loopback

e Remote loopback

e Remote loopback at the SHDSL repeater (activated from the local unit)

e Internal Bert (multiplexer units only) vs. multiplexer.
All tests can be activated from the local unit or from the remote unit.

ASMI-52 includes an internal Bit Error Rate Tester (BERT) for complete testing of
the local and remote modem and the link quality without any need for an external
test equipment. ASMi-52 runs an internal pseudo-random 511-bit test pattern in
accordance with the ITU V.52 standard.

Real time alarms provide information on the system status, indicating management
failure, synchronization loss and other conditions.

Overview 1-9
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Note

Statistics Collection
ASMi-52 supports SHDSL and E1/T1 statistics collection.

Alarm Reporting

ASMi-52 alarms are relayed via a dedicated 6-pin terminal block connector.

SHDSL Repeaters

Up to eight SHDSL repeaters can be installed in line to increase the operation
range of the modem. ASMi-52 provides basic management of the repeaters.

SHDSL repeaters do not support ASMi-52 T1 products.

1.2  Physical Description

Figure 1-4 shows a 3D view of the ASMi-52 unit in the plastic enclosure.

ASMi-52

Figure 1-4. ASMi-52, 3D View

The front panel includes several LEDs, which display the status of power, data flow
and provide diagnostics. For a detailed description of the front panel, see
Chapter 3.

The rear panel includes an AC/DC power connector, a DTE connector, a line
connector, a 10/100BaseT port, a V.24 terminal connector, and an alarm relay
port. The ASMi-52 rear panel is described in greater detail in Chapter 2.

1.3  Functional Description

This section provides a functional description of ASMi-52 in the form of block
diagrams (Figure 1-5 and Figure 1-6).
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Internal
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DTE Modem Glue |, | sHpsL [
Interface Control Signals Logic - "|Line Interface ¢ >
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CPU Data Bus
—>
Power —» 10/100BaseT
Supply > CPU L Manla;%?tment
R

LEDs and Terminal Interface

Figure 1-5. ASMi-52/4W with V.35 Interface and 10/100BaseT Management Port
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Figure 1-6. ASMi-52/4W with Framed E1 Interface and 10/100BaseT Management
Port
The ASMi-52 modem consists of the following major modules:

DTE interface — Prepares the digital data coming from the DTE into a data stream
for modem glue logic. In addition, it translates the data from the
modem glue logic into digital data to be sent to the DTE.

ASMi-52 Ver. 2.5 Functional Description 1-11
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Internal oscillator — Serves as a source of internal clock for the ASMi-52 unit.

Modem glue logic module — Processes the data from/to the SHDSL interface
module.

SHDSL line interface — Translates the received and transmitted data from the line
to the DTE interface.

Power supply — Provides 2.5V, 3.3V, 5V and -5V to the ASMi-52 internal
elements.

CPU - Controls the ASMi-52 operation.

10/100BaseT management port — Provides LAN connection to the SNMP
management station or Telnet host.

LEDs and terminal interface — Provides modem status information via LED
indicators on the front panel, and communicates with the
supervisory terminal.

1.4 Technical Specifications

Line Interface Type 2/4-wire unconditioned dedicated line (twisted pair)
Line Coding TC-PAM
Range See Table 1-1
Impedance 135Q
Connectors e ASMi-52: RJ-45
o ASMIi-52CD: Two RJ-45
Standard ITU-T 991.2, ETSI 101 524
ET Jitter As per ITU G.823
Performance
Protection ITU K.21, ULT950
DTE Interface Data Rate Depends on the DTE/line interface type and clock mode

(see Table 1-2 and Table 1-3)

e 2-wire (external clock): 64-2304 kbps,
2-wire (internal clock): 64-2048, 2304 kbps
(

e 4-wire (external clock): 64-4608 kbps,
4-wire (internal clock): 64-4096, 4608 kbps

e ASMI-52CD/4W:
(external clock): 128-4608 kbps
(internal clock): 128-4096, 4608 kbps

Coding e E1:HDB3
e T1:B8ZS or AMI
Line Impedance e E1:120Q, balanced

75Q, unbalanced (via adapter cable)

1-12 Technical Specifications ASMi-52 Ver. 2.5
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Connector Type

Management V.24/RS-232
Ports Control Port

Interface
Connector
Format
Baud Rate
Ethernet Port
Interface
Connector

Timing

Diagnostics Loopbacks

Performance
Monitoring

ASMi-52 Ver. 2.5
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e T1:100Q, balanced

e X.21: 15-pin, D-type, female

e V.35 -34-pin, female

e RS-530 - 25-pin, D-type, female

e (.703/G.704 E1 — RJ-45, balanced or unbalanced (via
adapter cable)

e T1-RJ-45
e [R-IP (IP router) — RJ-45

e Ethernet (10/100BaseT bridge with VLAN support) —
RJ-45

V.24/RS-232 DTE
9-pin D-type, female
Asynchronous

9.6 to 115.2 kbps

10/100BaseT
RJ-45 shielded

Derived from three alternative sources:
e Internal oscillator
e External, from the attached DTE

e Receive, derived from the received signal

ITU V.54:

e Local analog loopback, activated via the management
software or by the DTE interface signal (V.35 and RS-
530 only)

¢ Remote digital loopback, activated via the
management software or by the DTE interface signal
(V.35 and RS-530 only)

e Remote loopback at the SHDSL repeater
e SHDSL statistics collection
e ET with CRC-4 or T1 with ESF framing per ITU G.706

e E1 without CRC-4 or T1 with SF framing bipolar
violations (BPV)

Technical Specifications 1-13
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Alarm Relay

Indicators

Physical

Power Source

Operation

Connector
PWR (green)
TEST (red)

SYNC A/B
(green/red)

DATA (yellow)
E1/T1 SYNC (red)
AlS (yellow)
ALM (red)
Plastic Enclosure
Height
Width
Depth
Weight
Metal Enclosure
Height
Width
Depth
Weight

Rail-Mount Metal
Enclosure

Height

Width

Depth

Weight

AC/DC Voltage

Power
Consumption

1-14 Technical Specifications
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Normally Open and Normally Closed, using different
pins

Terminal block, 6-pin
Power
Test

Synchronization of DSL line

Data Transfer (except ET and T1 options)
Loss of E1/T1 synchronization (ET and T1 options only)
“All 1s string” is received (E1 or T1 interface only)

Alarm

43.7 mm (1.7 in)
217 mm (8.5 in)
170 mm (6.7 in)
0.5 kg (1.1 Ib)

47.3 mm (1.8 in)
215 mm (8.4 in)
147 mm (5.8 in)
0.7 kg (1.5 Ib)

150 mm (5.9 in)
70 mm (2.7 in)

160 mm (6.3 in)
0.75 kg (1.65 Ib)

Wide range power supply:
100-240 VAC or -48/60 VDC nominal

DC only:
24 VDC

2-wire: 6W max

4-wire: 7W max

ASMi-52 Ver. 2.5
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Environment

ASMi-52 Ver. 2.5

Temperature

Humidity
Shock
(Rail-Mount)

Vibration
(Rail-Mount)

Chapter 1 Introduction

Standalone: 0° to 50°C (32° to 122°F)
Rail-mount: —20° to 70°C (-4° to 158°F)
Up to 90%, non—condensing

I[EC 60068-2-27 shock 15g,

11 ms duration, 18 shocks

e |EC 60068-2-6 vibration T mm

e 2-13.2Hz 90 min

e 0.7g,13.2-100 Hz, 90 min.;
3.5 mm, 3 -9 Hz, 10 cycles

e 1 octave/min.; 1g, 9 — 150 Hz

e 10 cycles, 1 octave/min

Technical Specifications 1-15
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Chapter 2

Installation and Setup

2.1 Introduction
This chapter describes installation and setup procedures for the standalone
ASMi-52 modem.

After installing the unit:
e Refer to Chapter 3 for the operating instructions.

e Refer to Chapter 4 for the detailed system configuration procedures using an
ASCII terminal connected to the ASMi-52 control port.

If a problem is encountered, refer to Chapter 5 for test and diagnostic instructions.

Internal settings, adjustment, maintenance, and repairs may be performed
only by a skilled technician who is aware of the hazards involved.

Always observe standard safety precautions during installation, operation, and
maintenance of this product.

The ASMi-52 standalone unit is designed for desktop or bench installation and is
delivered as a fully assembled unit. No provisions are made for bolting the unit to
a tabletop.

To install ASMi-52:

1. Determine the required configuration of ASMi-52, in accordance with your
application.

2. Connect the line (see Connecting the Line below).
3. Connect the DTE (see Connecting the DTE Interface below).

4. Connect power to the unit (see Connecting the Power below).

2.2 Site Requirements and Prerequisites

AC-powered ASMi-52 units should be installed within 1.5m (5 ft) of an
easily-accessible grounded AC outlet capable of furnishing the voltage in
accordance with ASMi-52 nominal supply voltage.

DC-powered ASMi-52 units require a -48 VDC power source, which must be
adequately isolated from the main supply.

Site Requirements and Prerequisites 2-1
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Allow at least 90 cm (36 in) of frontal clearance for operation and maintenance
accessibility. Allow at least 10 cm (4 in) clearance at the rear of the unit for signal
lines and interface cables.

The ambient operating temperature of ASMi-52 should be 0° to 50°C (32° to
122°F), at a relative humidity of up to 90%, non-condensing.

2.3 Package Contents

The ASMi-52 package includes the following items:

One ASMi-52 unit
Technical documentation CD

Power connection accessories (depending on which power option was
ordered):

= Power cord (VAC) and AC/DC plug (-48 VDC)

= Terminal block kit (24 VDC)

CBL-RJ45/2BNC/E1 adapter cable for unbalanced E1 interface (if ordered)
RM-33 rack mount kit for the plastic case unit (if ordered)

RM-35 rack mount kit for the metal case unit (if ordered)

2.4 Connecting the Interface Cables

Figure 2-1 illustrates the rear panel of ASMi-52 in a plastic enclosure with a 4-wire
line interface, E1 DTE interface, user LAN interface, alarm relay port and the
control port.

Figure 2-2 illustrates the rear panel of ASMi-52 in a metal enclosure with a 4-wire
line interface, the user LAN interface, and the control port.

(GEETS LNE LINE ocE
& ALARM

L
L

)2
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|

2

o

E

LINK | (ACT  © ©
10/100 BASE-T CONTROL E1m1 SHDSL V.35

Figure 2-1. ASMi-52 Rear Panel (Plastic Enclosure)

. ® / ®
UNE LN
ETH M2 25
L L
une [SHIBacr o) =l
101100 BASE-T CONTROL SHDSE

Figure 2-2. ASMi-52 Rear Panel (Metal Enclosure)
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Connecting the Line

The ASMi-52 line interface terminates in an 8-pin RJ-45 connector.

» To connect the line connector:

e Connect the line cable to the RJ-45 connector designated SHDSL.

Connecting the DTE Interface

/N

Warning
>

ASMi-52 Ver. 2.5

The ASMi-52 DTE interface provides interface for input/output data, clock
reference and control signals between the modem and the DTE. The DTE interface
terminates in one of the following connectors:

e X.21 -15-pin, D-type, female

e V.35 - 34-pin, female

e RS-530 - 25-pin, D-type, female

e Balanced E1 — RJ-45

e Unbalanced ET - two BNC coax via adapter cable
e Balanced T1 - RJ-45

e IR-IP-RJ-45

e ETH-RJ-45.

For a detailed description of the IR-IP interface module, refer to Appendix B.

The E1/T1 port is intended for an intra-building non-exposed plant only.

To connect the DTE interface:
e Connect the DTE to the appropriate rear panel DTE interface connector of the
ASMi-52 modem.

Appendix A specifies the DTE connector pinouts.

Connecting the Alarm Relay Connector

To connect the alarm relay:

e Connect the external alarm device to the rear panel terminal block connector
designated ALARM. Refer to Appendix A for the connector pinout and alarm
functions.

2.5 Connecting the Power Cables
ASMi-52 is equipped with a dual input AC/DC power supply. AC or DC power is

supplied to ASMi-52 via a standard 3-prong power input connector on the rear
panel (see Figure 2-1).

Connecting the Power Cables 2-3
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any other cable, the protective earth terminals of this unit must be connected
to the protective ground conductor of the mains (AC or DC) power cord. If you
are using an extension cord (power cable) make sure it is grounded as well.
Any interruption of the protective (grounding) conductor (inside or outside the
instrument) or disconnecting of the protective earth terminal can make this
unit dangerous. Intentional interruption is prohibited.

j Before connecting this unit to a power source and connecting or disconnecting

Warning

Connecting AC Power

AC power should be supplied through the 1.5m (5 ft) standard power cable
terminated by a standard 3-prong plug. The cable is provided with the unit.

» To connect AC power:
1. Connect the power cable to the power connector on the ASMi-52 rear panel.

2. Connect the power cable to the mains outlet.

The unit turns on automatically upon connection to the mains.

Connecting DC Power

DC power is supplied to ASMi-52 via a compatible AC/DC plug for attaching DC
power supply lines.

» To connect DC power:
e Refer to the DC power supply connection supplement.

2-4 Connecting the Power Cables ASMi-52 Ver. 2.5
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Chapter 3

Operation

This chapter provides the following information for the ASMi-52 modem:
e ASMi-52 front-panel indicators

e Operating procedures (turn-on, front-panel indications, performance
monitoring and turn-off)

e ASMi-52 default settings.

Installation procedures given in Chapter 2 must be completed and checked before
attempting to operate ASMi-52.

3.1 Turning On ASMi-52

To turn on ASMi-52:

e Connect the power cord to the mains.

The PWR indicator lights up and remains lit as long as ASMi-52 is receiving
power.

ASMi-52 requires no operator attention once installed, with the exception of
occasional monitoring of front panel indicators. Intervention is only required when
ASMi-52 must be configured to its operational requirements, or diagnostic tests are
performed.

3.2 Controls and Indicators

The front and rear panels of ASMi-52 include a series of LED indicators that show
the current operating status of the unit.

Figure 3-1 shows the front panel of the 2-wire ASMi-52 unit in a plastic enclosure
with an E1 interface. Figure 3-2, Figure 3-3, Figure 3-4, Figure 3-5, Figure 3-6, and
Figure 3-7 illustrate the front panel options for the ASMi-52 4-wire unit in its plastic
enclosure with E1/T1, IR (DTE Serial Data), and Ethernet interfaces.

Table 3-1 lists and describes the front panel indicators. Table 3-2 lists and describes
the rear panel indicators.
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Figure 3-1. ASMi-52 Front Panel, E1 Interface (2 Wire)
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Figure 3-2. ASMi-52 Front Panel, ET1 Interface (4 Wire)
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Figure 3-3. ASMi-52 Front Panel, T1 Interface (4 Wire)
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Figure 3-4. ASMi-52 Front Panel, DTE Serial Interface (4 Wire)
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Figure 3-5. ASMi-52 Front Panel, E1+DTE Serial Interface (4 Wire)
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Figure 3-6. ASMi-52 Front Panel, E1+Ethernet Interface (4 Wire)
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Figure 3-7. ASMi-52 Front Panel, DTE Serial Interface+Ethernet (4 Wire)
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Table 3-1. ASMi-52 Front Panel LEDs

Name Function
PWR (green) On - Power is ON
TST (red) On — A loopback test is active in a local or remote unit
SYNC A On (red) — Link A is not synchronized
(red/green) On (green) — Link A is synchronized
Blinks — The line is connected properly and the
synchronization process is taking place
SYNC B On (red) — Link B is not synchronized
(red/green) On (green) — Link B is synchronized
Blinking — The line B is connected properly and the
synchronization process is taking place
AlS (yellow) On — “All 1s string” is received at the ET interface

YELLOW (yellow)

On — “All 1s string” is received at the T1 interface

E1/T1 SYNC (red)

On — Loss of ET or T1 synchronization

DATA (yellow)

Blinking — Data is being transferred

ALM (red) On — An alarm enters the buffer of local or remote unit
ACT (yellow) For Ethernet, blinks according to the Ethernet traffic activity
(10/100BaseT connector), available only when multiplexed
Table 3-2. ASMi-52 Rear Panel LEDs
Name Function
ACT (yellow) Blinks according to the Ethernet traffic activity (10/100BaseT

connector)

LINK (green)

On — Good link integrity (10/100BaseT connector)

Normal Indications

ASMi-52 Ver. 2.5

Upon turning on ASMi-52, the PWR LED in the front panel lights to indicate that
ASMi-52 is on. Table 3-3 shows the correct status of the indicators a few seconds
after the units were synchronized.

Table 3-3. ASMi-52 Indicator Status

Indicator Status
PWR On

TST Off

ALM Off

SYNC On (green)

If the above LED indications do not appear following initial power activation, refer
to Chapter 5 for the diagnostic test instructions.
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3.3 Default Settings

ASMi-52 is managed by an ASCII terminal or a PC running a terminal emulation
program via a menu-driven embedded software. Table 3-4 lists the default settings
of the ASMi-52 configuration parameters.

Table 3-4. Default Settings

Parameter Default Value
System
Clock Internal
Sys contact -
Sys location -
Sys name -
Host IP address 0.0.0.0
Host [P mask 0.0.0.0
Host default gateway 0.0.0.0
Read community public
Write community public
Trap community public

SNMP allowed

Access allowed

Telnet allowed

Access allowed

WEB allowed Access allowed

DTS IP address 0.0.0.0

DTS IP mask 0.0.0.0

LAN Configuration

LAN operation mode Transparent

Encapsulation CRC No

Bridging Mode Access only

Aging Timeout 10

Autonegotiation Enable

LAN Rate 1. Single 2-wire — 192 kbps
4-wire — 384 kbps

2. ET+LAN N/A (0 kbps)

3. Serial DTE4+LAN  N/A (0 kbps)

Max AutoNeg Capability

100BaseT full duplex mode

Default Settings

ASMi-52 Ver. 2.5
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Parameter

Default Value

Control Port

Control port rate 9600 bps
Data 8
Parity None
Interface DCE
CTS =RTS
DSR ON
Port control mode Terminal
User name -
Password 1234
Pop alarm OFF
Security timeout 10 min
Call Out Mode None
Number of retries 1
Wait for connect 30 sec
Dial mode Tone
Alternate number mode Disable
Primary number -
Alternate number -

SHDSL Interface
Transmission mode Annex B
Power backoff Enable
Snext margin Disable
Current margin Disable
Asym PSD Symmetrical
Line prob* Fixed rate

Units with a 4-wire line interface support only
fixed rate.

Configured wire

ASMi-52 2-wire = 2w
ASMi-52 4-wire = 4w

Loop attenuation threshold

0

SNR margin threshold

0

ASMi-52 Ver. 2.5
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Parameter

Default Value

Serial DTE Interface

Rate

Single:

2-wire — 192 kbps

4-wire — 384 kbps

Multiplexer:

1. E1+Serial DTE, N/A, 0 kbps

2. LAN+Serial DTE:  2-wire — 192 kbps
4-wire — 384 kbps

LLB from DTE

Disable

RLB from DTE

Disable

E1/E1+Ethernet/E1+Serial DTE Interface

Framed mode Unframed
Sync CaT
CRC-4 No
Idle Code ff
Units identical settings Yes

T1 Interface
Framed mode Unframed
Line code B8ZS
Receive gain Long
Interface DSU
Transmit signal mask 0 feet
Fbit configuration Transparent

Sync mode Fast (after 1 sec)
Idle code Ff
Units identical set Yes

3.4 Configuration Alternatives

After installation, ASMi-52 can be reconfigured using different ports and

applications:

e Local out-of-band management via an ASCII terminal or the Easy Config

device connected to the RS-232 port. Usually, preliminary configuration of the
system parameters is performed via an ASCII terminal. Once the ASMi-52 host
IP parameters are set, it is possible to access it via Telnet, ConfiguRAD, or

RADview-Lite for further configuration.

3-6 Configuration Alternatives
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e Remote management via out-of-band 10/100BaseT port or dedicated timeslot.
Remote management is performed using Telnet, or ConfiguRAD (RAD’s
Web-based application), or RADview (RAD’s SNMP-based management
system).

Managing ASMi-52 via a Terminal Port

Note

This section describes how to prepare ASMi-52 and the supervisory terminal for a
control session.

Control Port Interface Characteristics

ASMI-52 includes a V.24 (RS-232) asynchronous DCE port, designated as
CONTROL and terminating in a 9-pin D-type female connector. The control port
continuously monitors the incoming data stream and immediately responds to any
input string received through this port.

The terminal can be connected either directly to the ASMi-52 control port, or
through a modem or any other type of full-duplex data link. The ASMi-52 control
port interface type must be set in accordance with the connection method, as
follows:

e DCE - direct connection to terminals. Since terminals usually have DTE
interfaces, the connection to the port is made by means of a cable.

e DTE - connection through a modem or data link. In this case, you need a
cross-cable (also called a null modem cable) to connect to the CONTROL
connector.

The ASMi-52 control port can be configured to communicate at the following
rates: 9.6, 19.2, 38.4, 57.6, or 115.2 kbps.

The word format consists of one stop bit, 8 data bits, and no parity.

ASMi-52 can also be managed via a hand-held control device, Easy Config. Refer to
Appendix C for detailed description of the device.

Preparing the Terminal

Any standard ASCII terminal (a “dumb” terminal or a personal computer running
a terminal emulation application) equipped with a V.24 (RS-232) communication
interface can be used to configure ASMi-52. Appendix A details the pin
assignments and control signal directions of the ASMi-52 control connector.

Data Terminal Ready (DTR)

When connected and turned on, the terminal sets the DTR line ON (active) to gain
control over ASMi-52 and starts a configuration or monitoring session.

Initiating a Control Session

» To initiate a control session:

ASMi-52 Ver. 2.5

1. Connect the terminal cable to the CONTROL connector of ASMi-52.

2. Turn the control terminal on.
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3. Configure the terminal to the default communication parameters: 9.6 kbps,
one start bit, eight data bits, no parity, one stop bit, VT100 emulation.

4. Select the full duplex mode.
Turn the terminal echo off.

6. Disable any type of flow control.
You are now ready to start a control session.

Navigating the Management Menus

This section provides a general description of the software menu operation and
conventions for navigating the menus.

Choosing Options
» To choose an option:
e Type the number corresponding to the option, and press <Enter>.

The screen for the selected option is displayed.

Note  When a menu option has only two values, typing the option number and pressing
<Enter> will scroll between the available values.
Some of the ASMi-52 menus have a 'Save' option. When choosing options from

these menus, confirm your choice by typing the number corresponding to the 'Save
option, otherwise your entry will be ignored.

Correcting Entries

» To correct an erroneous entry:

e Press <Backspace> to clear the error, then enter the correct characters.
or
Press <Esc> to exit the current menu, and then return to the menu to
re-enter the required value.

Navigating Data Forms

Some of the ASMi-52 management software screens are data forms, which are
bigger than regular menus and require scrolling to navigate between parameters.
For example, the Inventory screen or Manager List menu are considered data
forms.

Use the following keys (case-sensitive) for the data form navigation:

e L —move left, | — scroll left,

e R -move right, r —scroll right

e U-move up, u-scroll up

e D - move down, d — scroll down

e <Tab> - select next changeable cell.

Note  You can display these navigation keys by typing <2> from a data form.

3-8 Configuration Alternatives ASMi-52 Ver. 2.5



Installation and Operation Manual Chapter 3 Operation

Managing ASMi-52 via Ethernet Port

ASMI-52 is equipped with an Ethernet/Fast Ethernet port (10/100BaseT) which
enables communication with ASMi-52 management subsystem using the IP
protocol (see Figure 3-9). The Ethernet management port is configured for a LAN
cross-over connection.

» To prepare ASMi-52 for network management:

1. Connect a LAN network management station to the ASMi-52 Ethernet port
designated 10/100BaseT.

2. Configure the host IP parameters of the ASMi-52 unit via an ASCII terminal.

3. Run an SNMP management application, such as RAD’s RADview, open a
Telnet session, or manage ASMi-52 via ConfiguRAD.

» To start the ConfiguRAD session:
1. Start a Web browser.
2. Disable any pop-up blocking software, such as the Google Popup Blocker.

3. Enter the IP address of the ASMi-52 in the address field of the browser in the
following format: http://<IP address> and then press <Enter> to command
the browser to connect (IP address stands for the actual ASMi-52 IP address
which has to be assigned via an ASCII terminal).

4. In the Login screen, click LOGIN to start the ConfiguRAD management
session.

» To choose an option:
1. Click a link in the ConfiguRAD screen to display the next menu.

2. Once the target screen is displayed, select a value from the drop-down box.

N http:/f172.17.161 18%configurad/home - Microsoft Internet Exploren =2

p g p = =]
File Edit  view Favori tes Tools  Help o

€ - x| |2 ;\J /' ) Search ;\’* Favorites @ Media L) - 2 =
Address 4] http:/f172.17.161. 189/ configurad/home ~| B e Lirks
Google - ~ | f§% Search'web - - [ options -

[RAL)] ASMi-52 O
| data communications | i
ConfiguRbiy~
LOGIN

RAD data communication

Figure 3-8. ConfiguRAD Login

Managing ASMi-52 via a Dedicated Timeslot

ASMi-52 modems with ET or T1 interface can be managed via a dedicated E1/T1
timeslot (DTS) (see Figure 3-9).

The DTS is a management channel that connects directly to the ASMi-52 host
using a separate IP interface, i.e., separate IP address and IP mask. If the LAN and
dedicated timeslot services are configured to have the same IP, the management

ASMi-52 Ver. 2.5 Configuration Alternatives 3-9
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ession over the dedicated timeslot has priority over management via the
0/100BaseT port.

1. Connect the E1/T1 line to the ASMi-52 E1 or T1 port.
2. Start a terminal management session and do the following:
= Assign an IP address and an IP mask to the dedicated timeslot interface
= Enable DTS management
= Assign an E1/T1 timeslot for the management traffic.
3. Run an SNMP management application, such as RAD’s RADview, open Telnet

session, or manage ASMi-52 via ConfiguRAD.

Network Management
Station

—L

A Management Traffic
over IP

|
¢
o
J
[al

Network Management
Station

10/100BaseT E1 Port on E1 Port 10/100BaseT
Management Port DE1B Module ! Management Port
\ o —
___________________ > h ] )
ASMi-52 SHDSL Link

Management Traffic
over IP

Management Traffic over
Dedicated Timeslot

DXC

Figure 3-9. Managing ASMi-52 via LAN Port and a Dedicated Timeslot

Managing ASMi-52 via Web Browser

ConfiguRAD is a Web-based remote access terminal management software. It
provides a user-friendly interface for configuring, collecting statistics, and
performing diagnostic tests on the ASMi-52 units.

To choose an option:

1.

Click a link in the ConfiguRAD screen to display the next menu.

2. Once the target screen is displayed, select a value from the drop-down box or

enter a value in a text box.

Some of the ASMi-52 menus have a 'Save' option. When choosing options from
these menus, you must confirm your choice by selecting 'Save', otherwise your
entry will be ignored.

At the left-hand bottom corner, ConfiguRAD provides some auxiliary management
tools:

3-10 Configura

Status — shows the number of users currently managing ASMi-52

tion Alternatives ASMi-52 Ver. 2.5
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Trace — opens an additional pane for system messages, progress indicators
(ping, software and configuration file downloads) and alarms. It is
recommended to keep the trace pane open all the time.

Refresh All — refreshes all screen elements.

Configuration Menus

Note

ASMi-52 Ver. 2.5

The following is the menu map of the ASMi-52 management software.

Some of the management menu options depend on the type of the DTE interface
installed in ASMi-52:

DTS Configuration (Main menu > Configuration > System Configuration >
Management) is available only for the units with ET or T1 interface.

LAN Rate (Main menu > Configuration > LAN Configuration > Local LAN
Configuration) is available for the units with the user’s 10/100BaseT port.

Data Rate (Main menu > Configuration > DTE Configuration > DTE Remote
Port) is available for the units with a serial DTE interface.

ET Configuration (Main menu > Configuration) is available for the units with an
ET local port.

Figure 3-10 illustrates software menus of the unit that operates with SHDSL
repeater in the line.
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Main Menu 1. Inventory

2. Configuration -| 1. System Configuration }——I 1. Master Clock r— ; :hleceivle
. Intemnal

3. External E1
4. External V35

Local Card Mode 1.E1
. Remote Card Mode 2.DTE

3.E1+LAN
4. E1+V35
4. Low Speed Operation 5.V35 + LAN 1. Sys Contact
2. Sys Location
5. Management -I 1. Device Info I— 3. 555 Name

4. Clear Sys Params
-| 2. Host IP 1. Host IP Address
2. Host IP Mask
3. Host Default Gateway
4. Read Community

- 5. Write Community
3. Manager List 6. Trap Community
1. Telnet Allowed
4. Management Access 2 Web Alowed
-| 5. DTS Configuration I_ 1.DTS Mode
2.DTS IP Address

3.DTS IP Mask
4.DTS to Remote
5. Rem Agent Table

6. VLAN Encapsulation |— 1. VLAN Mode
2.VLAN D
L| 7-MTU[B4 - 1540] 3. VLAN Priority

8. Save

-| 6. Control Port |—— 1. Rate
2. Interface
3.CTS
4.DSR

1. Terminal
5. Port Control 1. Port Control Mode
o e H 2. Dial Out

6. Save 2. Terminal 1. Change Access T_User Name

-| 2.POP Alarm 2. Password

7. G.704 Interface T
S04 inerce Toe 3. Security Timout 3. Clear User Name
1.Local Factory Default 4. Save 4. Clear Password
8. Factory Default 2.Remote Factory Default
3.Local Factory Default wio
MNG 3. Dial out 1. Call Out Mode
4.Remote Factory Default w/o 2. Number of Retries
MNG 4. Save 3. Wait for Connect
4. Dial Mode

1.Local Device Reset 5. Alternate Number

O Reset | Loca Resel 2 Local SHDSL Line Reset Mode

2. Remote Reset 1 Remote Device Reset 6. Primary Number
2.Remote SHDSL Line Reset 7. Alternate Number
10. Save 3. Repeater Reset T Repeater SHDSL Line Reset 8 Save
H 2 L configuraon ] 1. Local LAN |—{ T-Autonegofiaion 2Repeater Number

C 2. Max AutoNeg Capability 1.10BaseT-Half Duplex Mode
3. Default Type 2.10BaseT-Full Duplex Mode
4. Bridging Mode 3.100BaseT-Half Duplex Mode
5. Bridging Table 2.100BaseT-Full Duplex Mode
6. Aging Timeout

2.Remots LAN 6. Fault Indication

Configur 7. QoS Mapping
8. LAN Rate
9. Save
i 1.Power Backoff
H 3. SHDSL Configuration |——| 1. SHDSL Local Port |— I

3.Line Prob
4.Configured Wire (2W/4W)
5.Loop Attenuation Threshold
5.8NR Margin Threshold
6.Transmission Mode
7. Save

~| 2. SHDSL Remote Port |— 1 Power Backoff
2. Snext Margin
3. Current Margin
4. Loop Attenuation Threshold
5. SNR Margin Threshold
6. Transmission Mode

7. Save
3. SHDSL Repeater 1. Repeater Number
—I ” l— 2. Loop ion Threshold
3. SNR Margin Threshold 1. Unframed
4 Save 2.G732N
-I 4. E1 Configuration |——| 1. E1 Local Port ]_ ; ;ramt:l‘d hgode (15 ZZ;ZTS Transparent
. Sync Mode
3.CRC-4 2.62441
4. ldle Code 3.CCITT

5. Time Slots Assign
6. Number TSs for Remote E1
7. Save

—| 2. E1 Remote Port '— 1. Time Slots Assign

2 Save 1. Unframed
i 1. Framed Mode 2.ESF

—| 5. T 1 Configuration i——l 1.T1 Local Port '— 2 Line Code 3,04 (5F)

3. Receive Gain

4. Interface

5. Transmit Signal Mask

6. Fbit Configuration 1. FAST

7. Sync Mode 2.G2441

8. Unit Identical Set 3.CCITT

9. Idle Code

10. Time Slots Assign

11. Save

_| 2.T1 Remote Port 1_ 1. Time Slots Assign
2. Save

1.LB from DTE
Y 6.DTE Configuration |}--{ 1. DTE Local Port 2 riB fom0TE
3. Data Rate

4. Save

—I 2. DTE Remote Port '—' 1. Data Rate

Figure 3-10. Inventory and Configuration Menus
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| Main Menu

—| 3. Monitoring

I

—I 1. Total Alarms |

—I 2. System Monitoring |—-| 1. System Status

2. System Log File

3. System Clear Log File

—I 3. Physical Ports Status |——| 1. Port Status

2. Line Mask

3. Port Log File

4. Port Clear Log File

Chapter 3 Operation

4. Physical Port |_
Statistics

1. SHDSL Port
Performances

l_

. Open Virtua
Connection

1. SHDSL Current Performances

2. SHDSL Al Intervals Local Performances
3. SHDSL Al Intervals Remote
Performances

4. SHDSL Current Day Performances

5. SHDSL All Days Local Performances

6. SHDSL All Days Remote Performances
7. SHDSL Clear Local Performances

8. SHDSL Clear Remote Performances

—| 2. E1 Port Performances |—

1. E1 Current Performances

2. E1 All Intervals Local Performances
3. E1 Allintervals Remote Performances
4. E1 Current Day Performances

5. E1 Clear Local Performances

6. E1 Clear Remote Performances

Run time

3. Bert Performance

Sync loss state
Sync run time (sec)
Sync loss counter

1. Bert Results
2. Inject Single Error Local
3. Inject Single error remote

—| 3. Repeater Test |—

Total bit
4. Bert Clear Local Performance E[r)r:r b: tz
5. Bert Clear Remote Performance Errors (sec)
—| 4. Diagnostics |—-| 1. Local Test |——| 1. Bert |- ] Ber
J —I ! Ber | Pattern
2.LLB [ 2.Bert+RLB I
L] 3.RLB
4. Loop Timout 3. Bert Patterns 1.2E15-1
5.LED Test g g/lark
. Space
4. Save Bert Parameters 4 Allermate
-I 2. Remote test 1. Bert |__l 1. Bert
. +
2 LLB 2.Bert+RLB
3.RLB ) 6. Bert Patterns 1.2E15-1
4. Loop Timout 2. Mark
7. Save Bert Parameters 3. Space
1. RLB Network 4. Alternate

2. Loop Timeout (min)
3. Repeater Number
4. Save

|——| 1. File System |—

—| 1. SW Files |

2. SWAP Local SW Files

—I 2. SW and File Transfer |—

—I 1. SW Download

Tl

1. TFTP IP Server
2. TFTP File Name

1.TFTP

|_

3. Auto Configuration

2. XMODEM
1. XMODEM

3. TFTP Retry Timeout
4. TFTP Total Timeout
5. Save

6. Transfer Command

—| 2. TFTP |—

1. TFTP IP Server
2. TFTP File Name

3. TFTP Retry Timeout
4. TFTP Total Timeout
5. Save

6. Transfer Command

3. Command (Upload/
Download Full/
Download Part

Figure 3-11. Monitoring, Diagnostics and File Utilities Menus
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Logging Out
» To end the current session:

e In the Main menu, click Logout or type & in a terminal management screen.

Note o ASMI-52 allows at least four management sessions to be active at a time. If the
Web-based management sessions were not ended properly (for example, by
closing the Web browser window), you have to wait five minutes before
attempting the next log-in. If you try to log in during the five-minute security
timeout, ASMi-52 does not allow to proceed to the Main menu, displaying ‘Too
Many Users” message. Likewise, the Web-based management session cannot be
initiated, if a terminal or Telnet session is still in progress.

e One session is always reserved as a terminal session from the four available
management sessions, the other three sessions can be a ConfiguRAD or Telnet
sessions. The four sessions can function at the same time.

3.5 Turning Off ASMi-52

» To turn off ASMi-52:

e Remove the power cord from the power source.
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4.1 Configuring ASMi-52 for Management

The configuration of ASMi-52 is performed via a menu-driven embedded
software, using a standard ASCII terminal or a PC running a terminal emulation
application connected to the rear panel CONTROL port. Alternatively, ASMi-52
can be managed from a Telnet host connected to the 10/100BaseT port on the
rear panel.

Configuring Management Parameters

You must define the ASMi-52 internal SNMP agent parameters in order to enable
SNMP and Telnet management (see Figure 4-1). You can also enter additional
information about your ASMi-52, such as the name of the contact person detail,
unit location, etc.

» To access the Management menu:

e From the System Configuration menu, select Management (Main menu >
Configuration > System Configuration > Management).

The Management menu appears (Figure 4-1).

ASMi-52
Management
1. Device Info >
2. Host IP >
3. Manager List >
4. Management Access >
5. DTS Configuration >
6. VLAN Encapsulation >
7. MTU (64 - 1540) e (2240)
8. Save
>
ESC-prev.menu; !'-main menu; &-exit; @-scroll

Figure 4-1. Management Menu

Notes DTS Configuration is available only for the units with the E1/T1 DTE interfaces.
MTU means Maximum Transfer Unit.
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Entering Device Information

The Device Information menu allows you to assign a name to ASMi-52, define its
location, and contact person. These entries may include up to 20 characters.

» To enter device information:

1. Display the Sys Contact menu (Main menu > Configuration > System
Configuration > Management > Device Info > Sys Contact) and enter the
name of a contact person.

2. Display the Sys Location menu (Main menu > Configuration > System
Configuration > Management > Device Info > Sys Location) and enter the
description of the ASMi-52 location.

3. Display the Sys Name menu (Main menu > Configuration > System
Configuration > Management > Device Info > Sys Name) and enter the
name of the unit.

4. Press <Esc> to return to the Management menu (see Figure 4-1).
5. From the Management menu, select Save to save your changes.
» To clear system parameters:

1. From the Device Info menu, select Clear sys params (Main menu >
Configuration > System Configuration > Management > Device Info > Clear
Sys Params).

ASMi-52 displays the following message:

ASMi-52
Clear sys params
Are you sure !!! Clear (Y/N)
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-2. Clear Sys Params Prompt

2. Type Y to confirm the deletion.
ASMi-52 deletes all device info parameters.

ASMi-52
Device Info
Sys description ASMi-52 SA HW Version: 0.00, SW Version:

2.01E24)

1. Sys contact (sss)
2. Sys location ()

3. Sys name ()

4. Clear sys params

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-3. Device Information Menu
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Configuring the Host Parameters

ASMi-52 can be managed by a network management station, which is located on
the LAN connected to the 10/100BaseT port. In order to establish a proper
connection, it is necessary to configure the following: host IP address, subnet
mask, default gateway, its trap, read, and write communities.

» To define the IP parameters:

1.

From the Host IP menu (Main menu > Configuration > System Configuration
> Management > Host IP), type the following:

= 1 to define the host IP address

= 2 to define the subnet mask

= 3 to set the default gateway IP address

* 4 to enter the name of a community with read-only authorization
= 5 to enter the name of a community with write authorization

* 6 to enter the name of a community to which ASMi-52 will send traps.
Press <Enter>.
Press <Esc> to return to the Management menu (see Figure 4-1).

From the Management menu, select Save to save your changes.

ASMi-52
Host IP
1. Host IP address (172.17.161.73)
2. Host IP mask (255.255.255.0)
3. Host default gateway (172.17.161.1)
4. Read community (public)
5. Write community (public)
6. Trap community (public)
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-4. Host IP Menu

Configuring the Network Managers

Define or modify the network management stations to which the SNMP agent of
ASMi-52 will send traps. Up to ten managers can be defined. Entering the IP
address and corresponding subnet mask to define each management station.

» To configure the network managers:

ASMi-52 Ver. 2.5

1.

Display the Manager List menu. (Main menu > Configuration > System
Configuration > Management > Manager List).

The Manager List menu appears (see Figure 4-5).

From the Manager List menu, type a number corresponding to the network
management station that you intend to define or modify, and enter its new IP
address.
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3. Type a number corresponding to a subnet mask of the already defined
network management station, and enter a new value.

4. Repeat step 2 and step 3 to define additional management stations.

5. Press <Esc> to return to the Management menu (see Figure 4-1).

6. From the Management menu, select Save to save your changes.

Manager List

1.
. MNG
. MNG
. MNG
. MNG

V B R
= o

O 0 Jd o i b WN

MNG

MNG
MNG

. MNG
. MNG
. MNG
. MNG

1

O 0 Jd o i b WN

=R
o

ASMi-52

IP (172.17.160.104) 12. MNG 2 MASK ... (0.0.0.0)
IpP (172.17.160.68) 13. MNG 3 MASK ... (0.0.0.0)
Ip (0.0.0.0) 14. MNG 4 MASK ... (0.0.0.0)
IP (0.0.0.0) 15. MNG 5 MASK ... (0.0.0.0)
IP (0.0.0.0) 16. MNG 6 MASK ... (0.0.0.0)
Ip (0.0.0.0) 17. MNG 7 MASK ... (0.0.0.0)
IP (0.0.0.0) 18. MNG 8 MASK ... (0.0.0.0)
IP (0.0.0.0) 19. MNG 9 MASK ... (0.0.0.0)
Ip (0.0.0.0) 20. MNG 10 MASK ... (0.0.0.0)
Ip ... (0.0.0.0)

MASK ... (0.0.0.0)

ESC-prev. menu; !-main menu; &-exit; @-scroll

4-4

>

Figure 4-5. Manager List Menu

Controlling the Management Access

You can enable or disable access to the ASMi-52 management system via Telnet or
a Web-based application (ConfiguRAD). By disabling Telnet, you prevent
unauthorized access to the system when security of the ASMi-52 IP address has
been compromised. When Telnet and Web access are disabled, ASMi-52 can be
managed via an ASCII terminal only.

To define the management access method:

1. From the Management Access menu (Main menu > Configuration > System
Configuration > Management > Management Access),
(see Figure 4-6), select Telnet Allowed to enable Telnet access, or select Web
Allowed to enable management via a Web browser.

The access value toggles between Access Allowed and No Access.
2. Press <Enter> when a required value is displayed.
3. Press <Esc> to return to the Management menu (see Figure 4-1).

4. From the Management menu, select Save to save your changes.

Configuring ASMi-52 for Management ASMi-52 Ver. 2.5




Installation and Operation Manual Chapter 4 Configuration

Note

ASMi-52
Management Access
1. TELNET allowed (access allowed)
2. WEB allowed (access allowed)
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-6. Management Access Menu

Configuring Dedicated Timeslots

ASMI-52 units with an E1 or T1 port support management via a dedicated
timeslot.

A remote E1 device can be managed via DTS if the DTS mode is enabled in both
the CO unit and the CPE unit. The MNG timeslot is transferred over the SHDSL to
the E1 CPE, the CPE forwards the MNG timeslot over the E1 line to the next
device in the chain.

Allocate the same timeslot number for MNG in all devices in the chain. With DTS
mode enabled in all devices, the chain can be managed remotely from one NMS.

In T1 systems, the DTS manages the local unit only; it is not forwarded over SHDSL.

» To configure dedicated timeslots:

ASMi-52 Ver. 2.5

1. From the DTS Configuration menu (Main menu > Configuration > System
Configuration > Management > DTS Configuration), configure the dedicated
timeslot in the following order (see Figure 4-7):

= Assign a DTS IP address

= Assign a DTS IP mask
= Enable the DTS mode.

2. Check the status of the DTS configuration in the Rem Agent Table (see Figure 4-8).

3. From the Management menu, select Save to save the changes.

In the Map Timeslot menu (Figure 4-36), the dedicated timeslot value
changes to MNG (management).

ASMi-52
DTS Configuration
1. DTS Mode (Enable)
2. DTS IP Address (172.17.161.184)
3. DTS IP Mask (255.255.255.0)
4. DTS to Remote (O££/0n)
5. Rem Agent Table <[]
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-7. DTS Configuration Menu
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ASMi-52
Rem Agent Table

SOURCE IP DESTINATION IP PORT

>
ESC-prev. menu; !'-main menu; &-exit; @-scroll; ?-help

Figure 4-8. Rem Agent Table

Configuring VLAN Encapsulation

ASMi-52 is occasionally connected to a VLAN network when management VLAN
messages are required. Virtual LANs enable network managers to group users
logically rather than by physical location. A virtual LAN (VLAN) is an emulation of a
standard LAN that allows data transfer and communication to occur without the
traditional restraints placed on the network.

The VLAN encapsulation feature enables or disables a user to work in VLAN
mode, identify the user to give the user the proper VLAN permissions and to
prioritize a VLAN session.

» To enable VLAN mode:

1. From the Management menu (Main menu > Configuration > System
Configuration > Management > VLAN Encapsulation), select VLAN
Encapsulation (see Figure 4-9).

The VLAN Encapsulation is displayed.
2. From the VLAN Encapsulation menu, select VLAN mode.
3. Enable the VLAN mode feature.

4. Select VLAN Management ID to identify the user.
The identification will grant the user VLAN support.

5. Select the VLAN Priority option if you wish to prioritize the session.

ASMi-52
VLAN Encapsulation
1. VLAN Mode (Enable/Disable)
2. VLAN management ID [1 - 4094] ()
3. VLAN priority (0-7)
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-9. VLAN Encapsulation Menu
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Configuring the LAN Port

Note

Note

ASMi-52 includes a 10/100BaseT port that can be used as a user or management
port. The LAN port operates in a self-learning bridge or transparent mode, with or
without autonegotiation.

If the LAN port serves as a management port only, it operates in transparent mode
with autonegotiation enabled.

Configuring the LAN Port Operation Mode

In the transparent mode, the LAN port operates with a disabled filter, passing all
frames transparently. When operating as a self-learning bridge, the LAN port filters
the packets received from the local LAN and transfers through the link only frames
destined for another LAN.

To configure the LAN operation mode:

1. From the Operation Mode menu, select the Bridging Mode option (Main
menu > Configuration > LAN Configuration > Local LAN Configuration >
Bridging Mode) to enable bridge mode.

If LAN interface is used for data, the Operation Mode is set to Bridge. If Ethernet is
used for management purposes only, then the Operation Mode is permanently set
to Transparent.

The LAN Configuration menu appears.

2. From the LAN Configuration menu, select Save to save your changes.

ASMi-52
Local LAN Configuration
Operation Mode (Transparent)
Bridging Mode (Access Only)
1. Autonegotiation (Enable)
2. Max AutoNeg Capability (100BASE_T-full duplex mode)
3. Bridging Table [1>
4. Aging Timeout (10)
5. Fault indication (No)
6. QoS Mapping (Classification 802.1P) >
7. LAN rate >
8. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll
Figure 4-10. LAN Configuration Menu
Note  |f autonegotiation is enabled, the maximum autonegotiation capability rate is

ASMi-52 Ver. 2.5

100BaseT full duplex mode. If autonegotiation is disabled, it is called default type
or T0BaseT.
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Filling out the Bridging Table

When the 10/100BaseT port operates in the bridge mode, you can assign MAC
addresses to the local or remote LAN.

» To fill out the bridge table:

1. Select Bridging Table from the Local LAN Configuration menu (Main menu >
Configuration > LAN Configuration > Local LAN Configuration > Bridging
Table).

The Bridge Table appears (see Figure 4-11).

ASMi-52
Bridge Table
MAC Address Port Type
1. 0010b340500 LAN Static
2. 0040e108070 DSL Static
3. 00000000000 Static
>
ESC-prev. menu; !-main menu; &-exit; ?-help

Figure 4-11. Bridge Static Table, Normal Mode

2. From the Bridge Table, select an empty cell (the one with MAC address
0000000000 and unassigned port) by typing D to move the cursor downwards
or U to move it upwards.

You can also select an existing MAC address to reassign it.

3. Once the MAC address is selected, type m to enable editing mode.
The Bridge Table enters editing mode (see Figure 4-12).

4. In the editing mode, select MAC Address and enter a MAC address value.

5. Select Port and assign the current MAC address to the local LAN by entering
LAN or to the remote LAN by entering DSL.

6. Select Save All to save the changes.
7. Press <Esc> to exit the editing mode.
» To remove a MAC address from the table:

1. From the Bridge Table, select the MAC address that you intend to remove
from the static table.

2. Enter editing mode, as explained above.

3. Enter zeros for the MAC address value and save the change.
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ASMi-52
Bridge Table
Type (Static)
1. MAC Address ... (00000000000)
2. Port .. 0
I>
|Esc-prev. menu; !-main menu; &-exit; ?-help

Figure 4-12. Bridge Table, Editing Mode

Configuring Aging Timeout

The aging time is the timeout period in seconds for aging out dynamically learned
forwarding information. When the timeout period is over, the bridge removes all
inactive nodes from its database.

» To configure aging timeout:

Note

1. From the Local LAN Configuration menu, select Aging Timeout (Main menu
> Configuration > LAN Configuration > Local LAN Configuration > Aging
Timeout).

The LAN Rate menu appears.
2. Enter a new aging timeout value in seconds and press <Enter>.

3. Select Save to save the change.

Configuring QoS Mapping

The QoS mapping or the so-called VLAN priority feature prioritizes transmission
information according to traffic class. VLAN priority is based on a table of 8
integers (0 to 8) that maps evaluated user priority (see Figure 4-13). Each integer in
the table handles up to four levels of priority and transmits information to the DSL
line according to these priorities (see Figure 4-14). This feature is supported in the
multiplexer unit and in old LAN units.

This QoS mapping or VLAN Priority feature is different from the VLAN Priority under
Management

» To configure VLAN Priority (QoS Mapping):
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1. From the Local LAN Configuration menu, select QoS Mapping (Main menu >
Configuration > LAN Configuration > Local LAN Configuration > QoS

Mapping).
2. Select a User Priority number from the menu, (see Figure 4-13).

The User Priority (Traffic Class 0) menu appears (see Figure 4-14).
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ASMi-52
QoS Mapping (Classification 802.1p)
1. User Priority 0 > (Traffic Class 0)
2. User Priority 1 > (Traffic Class 0)
3. User Priority 2 > (Traffic Class 0)
4. User Priority 3 > (Traffic Class 0)
5. User Priority 4 > (Traffic Class 0)
6. User Priority 5 > (Traffic Class 0)
7. User Priority 6 > (Traffic Class 0)
8. User Priority 7 > (Traffic Class 0)
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-13. QoS Mapping Menu

3. Select any of the 4 level of priority to define the transmission priority of the
information to be transmitted to the DSL line.

4. Select Save to save the change.

ASMi-52
User Priority 5 (Traffic Class 0)
1. Traffic Class 0 = low

2. Traffic Class 1

3. Traffic Class 2

4. Traffic Class 3 = high

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-14. User Priority (Traffic Class 0)

Setting the LAN Rate

When the LAN port of ASMi-52 is used for the DTE connection, the DTE rate is
configured via the LAN rate menu. The LAN rate depends on the rate mode
(regular or low speed, see Configuring Low Speed Operation above) and the line
interface (2-wire or 4-wire).

Note  ASMi-52 units operating in the receive clock mode automatically detect the LAN
rate of the central units and configure themselves accordingly.

» To set the LAN rate:

1. From the Local LAN Configuration menu, select LAN Rate (Main menu >
Configuration > LAN Configuration > Local LAN Configuration > LAN Rate).

The LAN Rate menu appears (see Figure 4-15).

2. From the LAN Rate menu, select the required data rate.

The Local LAN Configuration menu appears.

3. From the LAN Configuration menu, select Save to save the new value.
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ASMi-52
Data Rate (2304 Kbps)
1. 64 Kbps 12. 768 Kbps 23. 1472 Kbps
2. 128 Kbps 13. 832 Kbps 24. 1536 Kbps
3. 192 Kbps 14. 896 Kbps 25. 1600 Kbps
4. 256 Kbps 15. 960 Kbps 26. 1664 Kbps
5. 320 Kbps 16. 1024 Kbps 27. 1728 Kbps
6. 384 Kbps 17. 1088 Kbps 28. 1792 Kbps
7. 448 Kbps 18. 1152 Kbps 29. 1856 Kbps
8. 512 Kbps 19. 1216 Kbps 30. 1920 Kbps
9. 576 Kbps 20. 1280 Kbps 31. 1984 Kbps
10. 640 Kbps 21. 1344 Kbps 32. 2048 Kbps
11. 704 Kbps 22. 1408 Kbps 33. 2304 Kbps
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-15. LAN Rate Menu (2-Wire Version)

Setting the LAN Rate in a Multiplexer Unit

The maximum multiplexer rate is 2048 kbps (general rate). The sum of the data
rate of two interfaces should not exceed 2048 kbps.

For example:

e IR (DTE Serial) Interface + LAN — If IR or the DTE Serial Interface works at
1024 kbps, then LAN cannot work at a speed of more than 1024 kbps
because the sum of both interfaces cannot exceed 2048 kbps.

ASMi-52 has a multiplexer modem with two interfaces. The maximum rate for
LAN is:

e If LAN + E1, then the LAN maximum rate =
2048 kbps — used TSs (timeslots) x 64 kbps

e If LAN + IR (DTE Serial) Interface, then the LAN maximum rate =
2048 kbps — DTE rate

Configuring Autonegotiation

ASMi-52 autonegotiation allows you to operate at the fastest data rate available.
With autonegotiation enabled, the ASMi-52 unit automatically determines
between itself and the DTE the fastest data rate and duplex mode that they can
operate. With autonegotiation disabled, the LAN interface of ASMi-52 operates at
the speed and duplex mode that is configured by the Default type.

>» To set autonegotiation:

ASMi-52 Ver. 2.5

1. From the Local LAN Configuration menu, select Autonegotiation (Main menu
> Configuration > LAN Configuration > Local LAN Configuration >
Autonegotiation).

Toggle between Enable and Disable.
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2. If the autonegotiation is enabled, choose Max AutoNeg Capability from the
Local LAN Configuration menu.

The Set Capability menu appears.

3. Select the required LAN operation mode by choosing one of the following:
= 10BaseT half duplex
= 10BaseT full duplex
= 100BaseT half duplex
= 100BaseT full duplex.

4. If the autonegotiation is disabled, choose Default Type from the LAN
Configuration menu.

The Set Default menu appears.

5. Select the desired LAN operation mode by choosing one of the following:
= 710BaseT half duplex
= 10BaseT full duplex
= 100BaseT half duplex
= 100BaseT full duplex.

6. From the Local LAN Configuration menu, select Save.

Configuring Fault Indication

If ASMi-52 fault indication is enabled and a faulty condition or a loss of signal is
detected on the line, the Ethernet link is disconnected by ASMi-52. If fault
indication is not selected, fault conditions are not passed through to the LAN side.

» To set the fault indication:

1. From the Local LAN Configuration menu, select Fault Indication (Main menu
> Configuration > LAN Configuration > Local LAN Configuration > Fault
Indication).

Toggle between Yes and No.

2. Select Save to save your changes.

4.2 Configuring ASMi-52 System Parameters

This section describes the procedures for configuring system parameters of
ASMi-52.

» To access the Configuration menu:
e From the Main menu, select Configuration.

The Configuration menu appears (see Figure 4-16).
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ASMi-52

Configuration >

o U1 & W N PP

>
ESC-prev. menu; !-main menu; &-exit; @-scroll

. System configuration >
. LAN configuration >

. SHDSL configuration

. E1l configuration

. Tl configuration

. DTE configuration

Figure 4-16. Configuration Menu

The ASMi-52 management software allows you to perform the following:

Configuring master clock

Selecting a local/remote card mode

Configuring the local/remote card

Enabling or disabling low speed operation

Defining management parameters (IP parameters, system information, etc.)
Defining control port parameters

Resetting ASMi-52 defaults

Performing the overall reset of the device or resetting its SHDSL interface.

» To display the System Configuration menu:

From the Configuration menu, select System Configuration.

The System Configuration menu appears (see Figure 4-17).

ASMi-52
System Configuration >
1. Master clock >(Internal)
2. Local Card Mode
3. Remote Card Mode
4. Low Speed Operation (Enable/Disable)
5. Management >
6. Control port >
7. Factory default >
8. Reset >
9. Save
>
ESC-prev.menu; !-main menu; &-exit; @-scroll
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Figure 4-17. System Configuration Menu
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Configuring the Master Clock
ASMi-52 modems support receive, external and internal clock modes.

When configured to the internal or external clock, ASMi-52 modem operates as an
STU-C unit. When configured to the receive clock, ASMi-52 operates as an STU-R
unit.

» To configure the master clock:

1. From the Master Clock menu (Main menu > Configuration > System
Configuration > Master Clock), select the appropriate clock by choosing
Receive, Internal, External E1 or External IR (see Figure 4-18).

The System Configuration menu returns.

2. From the System Configuration menu, select Save to save the changes.

ASMi-52
Master clock (Internal)
1. Receive
2. Internal
3. External El1
4. External IR
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-18. Master Clock Menu

Configuring Local Card Mode

Each multiplexer unit may be configured as a single parameter by the local/remote
card mode. For example, E1 + IR (Serial DTE) Interface may be configured as E1
or as IR (Serial DTE). The multiplexer can be configured as single but it will not
have the characteristics of a multiplexer unit.

For available options and combinations of parameters that complies with
multiplexer conditions, see Table 1-4.

» To configure local card mode:

1. From the Local menu (Main menu > Configuration > System Configuration >
Local Card Mode), select the appropriate configuration by choosing E1, DTE,
E1 + LAN, E1 + V35, or V35 + LAN (see Figure 4-19).

The System Configuration menu returns.

2. From the System Configuration menu, select Save to save the changes
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ASMi-52
Local/Remote Card Mode
1. E1
2. DTE
3. E1 + LAN
4. E1 + V35
5. V35 + LAN
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-19. Local/Remote Card Mode Menu

Configuring Remote Card Mode

The remote card mode configuration option is only available when ASMi-52 is
connected to a remote unit. When connected to a remote unit, each multiplexer
unit can be configured to work as a single unit. For example, E1+Serial DTE, E1
single, or Serial DTE single may be configured as an ETor IR (Serial DTE) unit. A
multiplexer unit configured as a single unit does not behave as a multiplexer unit.
The following applies in remote card mode configuration.

e IR (DTE Serial Interface) as a single unit
e ET asasingle unit

e ET + IR as a multiplexer unit.

» To configure remote card mode:

1. From the Remote menu (Main menu > Configuration > System Configuration
> Remote Card Mode), select the appropriate configuration by choosing E1,
DTE, LAN, E1 + LAN, E1 + V35, or V35 + LAN (see Figure 4-19).

The System Configuration menu returns.

2. From the System Configuration menu, select Save to save the changes

Configuring Low Speed Operation

Note

ASMi-52 Ver. 2.5

ASMi-52 can be configured to work at a speed of 64/128 kbps (2-wire) and
64/128/192/256 kbps (4-wire) when operating opposite devices with E1 DTE
interface. The maximum data rate of ASMi-52 working in low speed mode is
2048 kbps.

To enable the low speed operation:

1. From the System Configuration, select Low Speed Operation (Main menu >
Configuration > System Configuration > Low Speed Operation).

The option value changes to Enable or Disable.
2. From the System Configuration, select Save to save the change.

3. Reset the ASMi-52.

On start up the unit will operate in low speed mode.

Low speed operation is not available in multiplexed operations.
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Configuring Control Port Parameters
The embedded ASMi-52 software enables you to configure the Control port

parameters.
» To access the Control port menu:

e From the System Configuration menu, select Control Port (Main menu >
Configuration > System Configuration > Control Port).

The Control Port menu appears (see Figure 4-20)

ASMi-52
Control Port
1. Rate >(9600 bps)
2. Interface (DCE)
3. CTS (=RTS)
4. DSR (DTR)
5. Port Control >
6. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-20. Control Port Menu

Changing the Control Port Data Rate

The control port of ASMi-52 supports different data rates that can be configured
via the Rate menu (see Figure 4-21).

» To configure the control port data rate:

1. From the Control Port menu, select Rate (Main menu > Configuration >
System Configuration > Control Port > Rate).

The Rate menu appears (see Figure 4-21).

2. Select the terminal rate by typing the number corresponding the required
value, and press <Enter>.

3. Select Save to save the changes.

ASMi-52
Rate (9600 kbps)
1. 9600 kbps
2. 19200 kbps
3. 38400 kbps
4. 57600 kbps
5. 115200 kbps
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-21. Control Port Rate Menu
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Selecting the Control Port Interface

» To select the control port interface:

1.

2.

From the Control Port menu, select Interface (Main menu > Configuration >
System Configuration > Control Port > Interface) to choose the control port
interface: DCE (direct connection to the terminal via a straight cable) or DTE
(terminal connection via modem or data link).

The display is refreshed and the new value appears.

Select Save to save the changes.

Selecting the CTS State
» To select the CTS state:

1.

2.

From the Control Port menu, select CTS (Main menu > Configuration >
System Configuration > Control Port > CTS) to choose the CTS state: ON
(constantly ON) or =RTS (follows the RTS line).

The display is refreshed and a new value appears.

Select Save to save the changes.

Selecting the DSR State
» To select the DSR state:

1.

2.

From the Control Port menu, select DSR (Main menu > Configuration >
System Configuration > Control Port > DSR) to choose the DSR state: ON
(constantly ON) or DTR (follows the DTR line).

The display is refreshed and a new value appears.

Select Save to save the changes.

Configuring the Terminal Port

The Port Control menu allows you to do the following:

Set the port mode (terminal or dial out)
Manage the user name and password
Enable or disable pop-up alarms
Define security timeout

Configure dial-out parameters.

» To access the Port Control menu:

1.

ASMi-52 Ver. 2.5

From the Control Port menu, select Port Control (Main menu > Configuration
> System Configuration > Control Port > Port Control).

The Port Control menu appears (see Figure 4-22).
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ASMi-52
Port Control
Port Control Mode > (Terminal)
Terminal >
. Dial out >

Save

vV & W ihh -

ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-22. Port Control Menu

Configuring the Port Control Mode

The Control port of ASMi-52 operates in one of the following modes:

e Terminal — direct connection to the control terminal (DCE mode) or to the
modem (DTE mode)

e Dial-out — connection to a dial-out modem for alarm reporting
Note  Currently, the connection to ASMi-52 via SLIP is disabled.

» To configure port control mode:

1. From the Port Control menu, select Port Control Mode (Main menu >
Configuration > System Configuration > Control Port > Port Control > Port
Control Mode).

The Port Control Mode menu appears (see Figure 4-23).

ASMi-52
Port Control Mode (Terminal)

1. Terminal
2. Dial out

>

ESC-prev.menu; !'-main menu; &-exit; @-scroll

Figure 4-23. Port Control Mode Menu

2. From the Port Control Mode menu, select the required operation mode.

3. From the Port Control menu, select Save to save the change.

Configuring User Name, Password, Pop-up Alarms and Security
Timeout

The user name, password, pop-up alarms and security timeout are configured via
the Terminal menu.
» To access the Terminal menu:

e From the Port Control menu, select Terminal (Main menu > Configuration >
System Configuration > Control Port > Port Control > Terminal).

The Terminal menu appears (see Figure 4-24).
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>

ASMi-52
Terminal
1. Change access >
2. POP ALARM (No)
3. Security timeout (10 min)
4. Save
>

ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-24. Terminal Menu

To change the user name and password:

1.

4.

From the Terminal menu, select Change Access (Main menu > Configuration
> System Configuration > Control Port > Port Control > Terminal > Change
Access).

The following dialog appears:

ASMi-52
Change Access
1. User name ... 0
2. Password...
3. Clear User Name
4. Clear Password
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-25. Change Access Menu

Select User Name to enter a new user name; select Password to enter a new
password; select Clear User Name to delete the current user; or Clear
Password to delete the current password.

Enter a new user name or password and press <Enter>.

The Terminal menu appears.

From the Terminal menu, select Save to save the changes.

» To enable or disable the pop-up alarms:

ASMi-52 Ver. 2.5

When the pop-up function is enabled, ASMi-52 displays the active alarms at the
bottom of the terminal screen. When the faulty condition causing the alarm is
cleared, the alarm is removed from the screen

1.

2.

From the Terminal menu, select Pop Alarm (Main menu > Configuration >
System Configuration > Control Port > Port Control >Terminal > Pop Alarm)
to choose the pop-up alarms mode: ON (pop-up alarms are enabled) or OFF
(pop-up alarms are disabled).

The display is refreshed and the new value appears.

Select Save to save the changes.
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» To configure the security timeout:

1. From the Terminal menu, select Security Timeout (Main menu >
Configuration > System Configuration > Control Port > Port Control >
Terminal > Security Timeout) to configure the timeout: FOREVER (timeout is
disabled) or 10 MIN (idle disconnect time — 10 min).

The display is refreshed and a new value appears.
2. Select Save to save the changes.
» To change the dial-out parameters:

When the CONTROL port is configured to the dial out mode, you must specify
the dial-out parameters of the port. This enables ASMi-52 to build the call
command that is sent to the dial-out modem. When connecting the dial-out
modem, you must use a cross cable (see Appendix A for the cross cable pinout).
The modem connected to the CONTROL connector must be set up as follows (for
convenience, the Hayes commands required to select the specified parameters are
listed in brackets):

e Auto-answer mode (AT S0=1 and AT S1=1)

e Call set up in response to the CONNECT string (AT XO)

e Noecho (AT EO0)

e Verbose mode (no codes, e.g., CONNECT string instead of 0) (AT V1).

1. From the Port Control menu (see Figure 4-22), select Dial out (Main menu >
Configuration > System Configuration > Control Port > Port Control > Port
Control Mode > Dial Out).

The Dial Out menu appears (see Figure 4-26).

2. From the Dial Out menu, type the following:

= 1 to instruct ASMi-52 to report all alarms (ALL), only major ones (MAJOR),
or disable alarm reporting (NONE).

= 2 to specify the number of dialing retries. 0, no redialing attempts are made
if the call is not established on the first attempt. 1-8, if the call is not
established on the first attempt, ASMi-52 makes the specified number of
redials.

This parameter applies to both primary and alternate numbers:

o If the call is not established after dialing the primary directory number
the specified number of times, ASMi-52 attempts to establish the call by
dialing the alternate directory number (provided the use of an alternate
number is enabled).

o If the call is not established within the specified number of redialing
attempts on neither of the two directory numbers, ASMi-52 stops the
call attempts. When a new alarm report must be sent, the call attempts
are started again. The user is notified that the call attempts failed by a
message recorded in the alarm log file (separate messages are provided
for each directory number).
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3 to specify the time (in sec) ASMi-52 waits for an answer after each dialing
attempt. If the called station does not answer within the specified time,
ASMi-52 disconnects. If additional call attempts are allowed,

ASMi-52 redials immediately after disconnecting. The available selections
are 30, 45, or 60 seconds.

4 to select the dialing mode. TONE, if the dial-out modem is instructed to
use DTMF dialing. PULSE, if the dial-out modem is instructed to use pulse
dialing.

5 to control the use of an alternate number. The alternate number is dialed
after the specified number of call attempts on the primary number failed.
ENABLE, the use of an alternate number is enabled. DISABLE, ASMi-52
stops the call attempts after the specified number of call attempts on the
primary number failed.

6 to specify a primary number to dial.

7 to specify an alternate number to dial.

3. Select Save to save the changes.

ASMi-52
Dial out
1. Call Out Mode (None)
2. Number of Retries [0-8] (1)
3. Wait for connect (sec) (30 sec)
4. Dial mode (Tone)
5. Alternate number mode (Disable)
6. Primary number ()
7. Alternate number ()
8. Save
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-26. Control Port Dial Out Menu

Setting the G.704 Interface Type

The G.704 interface type refers to the remote side hardware and is applicable for
ET only.

» To set the G.704 interface type:

1. From the System Configuration menu, select G.704 Interface Type.

2. Select one of the following values as required:

ASMi-52 Ver. 2.5

Autodetect
Balanced

Unbalanced
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4.3 Configuring the Physical Ports

Configuring the SHDSL Interface

The ASMi-52 configuration software allows you to change the modem’s
transmission mode (Annex A or Annex B).

Examples given below illustrate the local device configuration procedures.
» To change the transmission mode:

1. From the SHDSL Local Port menu, select Transmission Mode (Main menu >
Configuration > SHDSL Configuration > SHDSL Local Port > Transmission
Mode) to choose a transmission mode: Annex A or Annex B for the SHDSL
Local Port.

The display is refreshed and a new value appears.

2. Select Save to save the changes.

Note  ASMi-52 units operating in the receive clock mode automatically detect the
standard compatibility value of the central units and configure themselves

accordingly.
ASMi-52
SHDSL local port configuration
1. Power backoff (Enable)
2. Asym PSD (Symmetric)
3. Line prob (Fixed rate)
4. Configured Wire (2W/ 4W)
5. Loop attenuation threshold (dB) [0 - 127] (0)
6. SNR margin threshold (dB) [0 - 15] (0)
7. Transmission mode (Annex A)
8. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-27. SHDSL Local Port Menu
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Notes

Note

ASMi-52 Ver. 2.5

ASMi-52
SHDSL remote port configuration
Transmission mode (Annex AB)
Asym PSD (Asym/Sym Enable)
Line prob (Adaptive rate)
1. Power backoff (Enable)
2. Snext margin (Disable Snext margin)
3. Current margin (Disable current margin)
4. Loop attenuation threshold (dB) [0-127] (0)
5. SNR margin threshold (dB) [0-15] (O)
6. Save
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-28. SHDSL Remote Port Configuration Menu

Configuring the Power Backoff
You can determine if the transmitted power backoff is used.
To configure the use of the power backoff:

1. From the SHDSL Local Port/SHDSL Remote Port menu, select Power backoff
(Main menu > Configuration > SHDSL Configuration > SHDSL Local
Port/SHDSL Remote Port > Power Backoff) (see Figure 4-27 and Figure 4-28)
to enable or disable power backoff.

The display is refreshed and a new value appears.

2. Select Save to save the changes.

¢ After changing the Configured Wire option, ASMi-52 must be reset to implement
the change.

e When operating in Line prob. Adaptive rate, and the clock is internal, the rate is
limited up to 2048 bps.

Configuring the Snext Margin

The Snext margin indicates the minimum required target margin with a worst-case
self next noise model given the current loop insertion (49 SHDSL next is
considered the worst case). This setting is available only if the rate adaptation is
enabled (see the line probing configuration below).

Disabling the Snext margin parameter allows the use of all line rates, regardless of
line condition.

To configure the Snext margin:

1. From the SHDSL Remote Port menu, select Snext margin (Main menu >
Configuration > SHDSL Configuration > SHDSL Remote Port > Snext
Margin).

The Snext Margin menu appears (see Figure 4-29).
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Select the Snext margin by typing the number corresponding to the required
value.

The SHDSL Remote Port menu appears.

Select Save to save the changes.

ASMi-52
Snext margin (Disable Snext margin)
1. -10 12. 1
2. -9 13. 2
3. -8 14. 3
4. -7 15. 4
5. -6 16. 5
6. -5 17. 6
7. -4 18. 7
8. -3 19. 8
9. -2 20. 9
10. -1 21. 10
11. O 22. Disable Snext margin
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-29. Snext Margin Menu

Configuring the Current Margin

The current margin indicates the minimum required target margin for the local line
conditions during the startup sequence. This setting is available only if the rate
adaptation is enabled (see the line probing configuration below).

Note  Disabling the current margin parameter allows the use of all line rates, regardless of
the line condition.

» To configure the current margin:

1.

From the SHDSL Remote Port menu, select Current Margin (Main menu >
Configuration > SHDSL Configuration > SHDSL Remote Port > Current
Margin).
The Current Margin menu appears. The display is identical to the Snext
Margin menu, except for its title (see Figure 4-29).
Select the current margin by typing the number corresponding to the required
value, and press <Enter>.
The SHDSL Remote Port menu appears.

Select Save to save the changes.
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Note

ASMi-52 Ver. 2.5

Configuring the Power Spectral Density

By configuring the power spectral density, you define the amount of power
applied to the spectrum of frequencies that carry the information signal in order to
achieve a satisfactory level of signal strength at the receiving end of the circuit.

The power spectral density can be configured for the ASMi-52 units with the line
probing set to fixed.

The power spectral density value depends on the selected modems’ compatibility:
Annex A or Annex B. The possible values are:

e Symmetric, supported in both Annex A and Annex B modes.
e Asymmetric, supported in Annex A at 768 kbps and in Annex B at 2048 kbps.
To configure the power spectral density:

1. From the SHDSL Local Port menu, select Asym PSD (Main menu >
Configuration > SHDSL Configuration > SHDSL Local Port > Asym PSD) to
choose the power spectral density value: symmetrical or asymmetrical.

The display is refreshed and a new value appears.

2. Select Save to save the changes.

Remote ASMi-52 units automatically detect the line power density. This parameter
is permanently set to Sym/Asym Enable and cannot be changed.

Configuring Line Probing

By configuring this parameter, you force ASMi-52 to perform line probing in order
to find the best possible rate of transmission — adaptive rate. Or you command the
modem to skip the rate adaptation phase — fixed rate.

Only central ASMi-52 units with the 2-wire line interface support fixed and
adaptive rates, remote units operate with adaptive rate only.

ASMI-52 units with the 4-wire line interface support only fixed rate.
To configure line probing:

1. From the SHDSL Local Port menu, select Line Prob (Main menu >
Configuration > SHDSL Configuration > SHDSL Local Port > Line Prob).

The display is refreshed and a new value appears.

2. Select Save to save the changes.

Setting the Loop Attenuation Threshold

Loop attenuation is different (in dB) between the power transmitted from the
ASMi-52 modem and the power received by the unit operating at the other side of
the application. By setting the threshold, the modem is instructed to generate
minor alarm (LOOP ATTN. OVER LINE A/B) when the selected loop attenuation
threshold value is exceeded.

To set the loop attenuation threshold:

1. From the SHDSL Local Port/SHDSL Remote Port/SHDSL Repeater menu,
select Loop attenuation threshold (Main menu > Configuration > SHDSL
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Configuration > SHDSL Local Port/SHDSL Remote Port/SHDSL Repeater >
Loop Attenuation Threshold).

The loop attenuation threshold can be configured from the SHDSL remote or
local port, or from the SHDSL repeater.

2. Enter the required value (0 dB to 127 dB for the SHDSL remote/local port or
0 dB to 15 dB for the SHDSL repeater).

3. Select Save to save the changes.

Setting the SNR Margin Threshold

The signal-to-noise ratio threshold can be set. ASMi-52 generates minor alarm
(SNR MARGIN OVER LINE A/B) if the signal-to-noise ratio on the line exceeds the
threshold value.

» To set the SNR margin threshold:

1. From the SHDSL Local Port/SHDSL Remote Port/SHDSL Repeater menu,
select SNR margin threshold (Main menu > Configuration > SHDSL
Configuration > SHDSL Local Port/SHDSL Remote Port/SHDSL Repeater >
SNR Margin Threshold).

The SNR margin threshold can also be configured from the SHDSL remote or
local port, or from the SHDSL repeater.

2. Enter the required value (0 dB to 15 dB).

3. Select Save to save the changes.

Configuring the SHDSL Repeater

Configuration parameters of the SHDSL repeaters are similar to those of the
SHDSL device except when selecting a repeater that you intend to configure with
your own set of configuration.

The SHDSL repeaters are configured via the SHDSL Repeater menu.

» To access the SHDSL Repeater menu:

e From the SHDSL Configuration menu, select SHDSL Repeater (Main menu >
Configuration > SHDSL Configuration > SHDSL Repeater).

The SHDSL Repeater menu is displayed (see Figure 4-30).

ASMi-52
SHDSL repeater
1. Repeater number [1-8 (1)
2. Loop Attenuation threshold (dB) [0-127] (0)
3. SNR margin threshold (dB) [0-15] (0)
4. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-30. SHDSL Repeater Menu
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Configuring the DTE Interface Data Rate

ASMI-52 supports multiple data rates between the range of 64 kbps and
4608 kbps, depending on the clock mode and line/DTE interface of the local and
remote units (see Table 7-2 and Table 1-3).

» To select the data rate:

1. From the DTE Local Port menu, select Data Rate.
The Data Rate menu appears (see Figure 4-37). The ASMi-52 screen in
Figure 4-317 is with a 2-wire, internal clock configuration.
2. Select the data rate by typing the number corresponding to the required value,
and press <Enter>.
The DTE Local Port menu appears.

3. Select Save to save the changes.

ASMi-52

Data Rate (384 Kbps)

1. 64 Kbps 13. 832 Kbps 25. 1600 Kbps
2. 128 Kbps 14. 896 Kbps 26. 1664 Kbps
3. 192 Kbps 15. 960 Kbps 27. 1728 Kbps
4. 256 Kbps 16. 1024 Kbps 28. 1792 Kbps
5. 320 Kbps 17. 1088 Kbps 29. 1856 Kbps
6. 384 Kbps 18. 1152 Kbps 30. 1920 Kbps
7. 448 Kbps 19. 1216 Kbps 31. 1984 Kbps
8. 512 Kbps 20. 1280 Kbps 32. 2048 Kbps
9. 576 Kbps 21. 1344 Kbps 33. 2304 Kbps
10. 640 Kbps 22. 1408 Kbps = .. .

11. 704 Kbps 23. 1472 Kbps 72. 4608 Kbps
12. 768 Kbps 24. 1536 Kbps

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-31. Typical Data Rate Menu

Configuring the Data Rate in a Multiplexer Unit

The maximum multiplexer rate is 2048 kbps (general rate). The sum of the data
rate of two interfaces should not exceed 2048 kbps.

ASMi-52 is a multiplexer modem with two interfaces that has the following
maximum rate for Serial DTE interface:

e |f DTE Serial + E1 interface, then the DTE Serial maximum rate = 2048 kbps
—used TSs (timeslots) x 64 kbps.

e If DTE Serial + LAN interface, then the DTE Serial maximum rate =
2048 kbps — LAN rate.
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Configuring the E1 Interface

The following are commonly used acronyms:
e CO - Central Office, where the clock source is set to internal or external
e CPE - customer premise equipment.
When ASMi-52 includes a G.704 E1 port, you can configure the following
parameters:
e Framed mode

= Unframed — Stream of bits at 2.048 Mbps

= G732N - Timeslot 0 contains sync word

= G732S transparent — 16 frames per multi-frame, timeslot 16 is passed
transparently.

Note o |fthe opposite modem is E1, then the Framed Mode value can be is G732N,
G732S Transparent, or Unframed.
e [f the opposite modem is Serial DTE or LAN, then the Framed Mode value can
be G732N, or Unframed
e If frame Mode is Unframed, then all the rest of the parameters are disabled.

e Sync mode: define the time required for the ET port to return to normal
operation after sync loss:

= CCITT - As per requirements of ITU-T Rec.G.732
= Fast — After 1 sec
* 62411 — As per requirements of AT&T TR-62411 (after 10 sec).
e CRC-4: Enabling generation and checking of check bits for the frames

transmitted on the ET port (as per CRC-4 polynomial specified by ITU G.704).
Check bits generation is available only for the G732N framing mode.

e Idle Code: Selecting a code transmitted to fill unused timeslots in the E1
frames.

e Time Slot Assignment — Assigning each timeslot to carry user’s data
e Unit Identical Set

* Yes — copies Sync Mode, Time Slot Assignment and Idle Code definitions to
the remote modem

= No - Sync Mode, Time Slot Assignment and Idle Code must be defined in
both modems individually

e  First time slot for remote E1 — define the first time slot for the remote E1 unit.
The ET port configuration is performed via the E1 Configuration menu.
» To access the E1 Port Configuration menu:

1. From the ET Configuration menu, select E1 Local Port/E1 Remote Port (Main
menu > Configuration > E1 Configuration > E1 Local Port/ET Remote Port).

The ET Local Port/ET Remote Port menu appears (see Figure 4-32 and
Figure 4-33).

4-28 Configuring the Physical Ports ASMi-52 Ver. 2.5



Installation and Operation Manual Chapter 4 Configuration

Notes

ASMi-52
El Local Port
1. Framed mode (G732N)
2. Sync mode (CCITT (complies with G732))
3. CRC-4 (NO)
4. Idle code (££)
5. Time slots assign
6. Unit Identical Set (Yes)
7. Number TS for remote El
8. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-32. E1 Local Port Menu

ASMi-52
El Remote Port
Framed mode (G732N)
Sync mode (CCITT (complies with G732))
CRC-4 (NO)
Idle code (££)
1. Time slots assign
2. Save
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-33. ET Remote Port Menu

Selecting E1 Framing Mode

The Framing mode is configurable if one of the conditions below is fulfilled.

If the local ASMi-52 is configured as CO,

if the local ASMIi-52 is configured as CPE and the remote is not an ET modem.
The remote ASMi-52 is configurable if the local is configured as CO and is not an
ET modem

If Frame Mode is Unframed, then the remaining ET parameters are disabled.

» To select E1 framing mode:

ASMi-52 Ver. 2.5

1.

From the E1 Local Port menu, select Framed Mode (Main menu >
Configuration > E1 Configuration > E1 Local Port > Framed Mode).

The Framed Mode menu appears (see Figure 4-34).

From the Framed Mode menu, select Unframed, G732N, or G732S
transparent.

The ET Local Port menu appears.

Save the changes.
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Note

ASMi-52
Framed mode (Unframed)
1. Unframed
2. G732N
3. G732S transparent
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-34. Framed Mode Menu

Enabling CRC-4 Code Generation

You have to enable the CRC-4 code generation if you intend to gather statistics on
the E1 performance. CRC-4 code generation is available for ASMi-52 units
configured to G732N framing mode.

e CRC-4 code generation is configurable if one of the conditions below is fulfilled.
If the local ASMi-52 is configured as a CO,
if the local ASMi-52 is configured as CPE and the remote is not an ET modem.

e The remote ASMI-52 is configurable if the local is configured as CO and is not an
ET modem.

To enable CRC-4 code generation:

1. From the E1 Local Port menu, select CRC-4 (Main menu > Configuration >
E1 Configuration > E1 Local Port > CRC-4).

The CRC-4 value changes.
2. Save the changes.

Setting the Sync Mode

You can define the time required for the E1 port operating in framed mode to
resume normal operation after loss of synchronization:

e CCITT — As per requirements of ITU-T Rec.G.732
e Fast— After 1 sec
e 62411 — As per requirements of AT&T TR-62411 (after 10 sec).

» To select resynchronization time:

1. From the E1 Local Port/T1 Local Port menu, select Sync Mode (Main menu >
Configuration > ET1 Configuration/T1 Configuration > E1 Local Port > Sync
Mode).

The Sync Mode menu appears (see Figure 4-35).

2. From the Sync Mode menu, select CCITT, FAST, or 62411.
The E1 Local Port menu appears.

3. Save the changes.
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ASMi-52
Sync mode (CCITT (complies with G732))
1. FAST (after 1 sec)
2. 62411 (after 10 sec)
3. CCITT (complies with G732)

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-35. Sync Mode Menu

Defining Idle Code

You can define the code transmitted to fill an idle (unused) timeslot in the E1
frames.

» To define an idle code:

1.

2.
3.

From the E1 Local Port menu, select Idle Code (Main menu > Configuration
> E1 Configuration > E1 Local Port/T1 Local Port > Idle Code)

Enter the required code in the range of 00 to FF, then press <Enter>.

Save the changes.

Mapping E1 Timeslots

When working with framed E1, you can assign each timeslot to carry data or
transmit an idle code. To assign the MNG timeslot, the DTS mode must be set to
enable (see Figure 4-7). Only one timeslot can be assigned to MNG.

» To assign E1 timeslots:

1.

ASMi-52 Ver. 2.5

From the E1 Local/Remote Port menu, select Time slots assign (Main menu >
Configuration > E1 Configuration > E1 Local/Remote Port > Time Slots
Assign).

The Time Slots Assign menu appears (see Figure 4-36).
Assign a timeslot to carry data by typing the corresponding number and press
<Enter>.
The timeslot value changes to:

= DATA - timeslot is configured to carry user data

= MNG - timeslot is dedicated to carry management traffic
= NOT_CONNECT - timeslot is idle.

Repeat step 2 for all timeslots that you want to assign.

Alternatively, you can assign all timeslots to carry data at once by selecting
FULL, or disconnect all timeslots by selecting CLEAR.
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e You can configure timeslot O to be loo or transparent:
Notes can configure timeslot O to be looped spare

* Looped —timeslot O is sent back to the E1 interface, when operating
opposite remote units with a serial data interface.

= Transparent — timeslot O is transmitted to the remote modem.

e [fyou operate ASMi-52 with the G732S transparent framing, timeslot O is
always transparent and timeslot 16 is always connected.

e When operating a 2-wire ASMi-52 with ET interface opposite ASMi-52 with
V.35 interface (not in low speed mode), assign at least three timeslots, excluding
timeslot O, to carry data.

e When operating a 4-wire ASMi-52 with ET interface opposite ASMi-52 with a
V.35 interface (not in low speed mode), assign at least six timeslots, excluding
timeslot O, to carry data.

4. Once you finish assigning timeslots, press <Esc> to return to the E1
Local/Remote Port menu.

5. Save the changes.

ASMi-52
Time slots Assign
1. TSO (LOOP) 17. TSle (DATA) 33. FULL
2. Ts1 (DATA) 18. TsS17 (DATA) 34. CLEAR
3. TS2 (DATA) 19. TS18 (DATA)
4. TS3 (DATA) 20. TS19 (DATA)
5. Ts4 (DATA) 21. TS20 (DATA)
6. TS5 (DATA) 22. Ts21 (DATA)
7. TS6 (DATA) 23. TS22 (DATA)
8. TS7 (DATA) 24. TS23 (DATA)
9. TsS8 (DATA) 25. TS24 (DATA)
10. TS9 (DATA) 26. TS25 (DATA)
11. TS10 (DATA) 27. TS26 (DATA)
12. TS11 (DATA) 28. TS27 (DATA)
13. TS12 (DATA) 29. Ts28 (DATA)
14. TS13 (DATA) 30. TS29 (DATA)
15. TS14 (DATA) 31. TS30 (DATA)
16. TS15 (DATA) 32. TS31 (DATA)
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-36. Time Slots Assign Menu

Mapping E1 Timeslots in a Multiplexer Unit

The maximum multiplexer rate is 2048 kbps (general rate). The sum of the data
rate of two interfaces should not exceed 2048 kbps.
For example:

e IR (DTE Serial) Interface + LAN — If IR or the DTE Serial Interface works at
1024 kbps, then LAN cannot work at a speed of more than 1024 kbps
because the sum of both interfaces cannot exceed 2048 kbps.
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ASMi-52 has a multiplexer modem with two interfaces. The maximum timeslots
that can be used are as follows:

e IfET + LAN, then the maximum TSs (timeslots) = (2048 kbps — LAN rate) /
64 kbps.

e If ET + Serial DTE, then the maximum possible Ts (timeslots) = (2048 kbps —
Serial DTE data rate) / 64 kbps.

If the maximum timeslots available are not sufficient, you can remap the E1/T1
times|ots:

» To map E1 timeslots in a multiplexer unit with E1 + LAN:

1. From the Configuration menu, select LAN Configuration (Main menu >
Configuration > LAN Configuration).

The LAN Configuration menu is displayed.

2. From the LAN Configuration menu, select Local LAN Configuration.
The Local LAN Configuration menu is displayed, (see Figure 4-10).

3. Select LAN Rate from the Local LAN Configuration menu and reduce the LAN
data rate accordingly.

4. Return to ET configuration and use the newly available timeslots.

» To map E1 timeslots in a multiplexer unit with E1 + Serial DTE:

1. From the Configuration menu, select DTE Configuration (Main menu >
Configuration > DTE Configuration).

The DTE Configuration menu is displayed.

2. From the DTE Configuration menu, select DTE Local Port.
The DTE Local Port menu is displayed.

3. From the DTE Local Port menu, select Data Rate.

4. Check the maximum data rate and reduce the DTE data rate accordingly.

Matching Remote Unit Settings With Local Unit Settings

ASMi-52 Ver. 2.5

The Unit Identical Set parameter allows you to match some parameters in the
remote unit with the local unit, without having to define each parameter
individually.

The following parameters are set automatically when the Unit Identical Set
parameter is set to Yes.

e Sync Mode
e Time Slot Assignment (TSA)
e Idle Code

There are certain conditions for the Unit Identical Set.

If the Frame Mode is G732S transparent:

e Only when the local modem is configured as CO, you can configure the Sync
Mode, Idle Code, and TSA.
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e The Unit Identical Set is permanently set to Yes, the parameters are copied to
the remote unit.
If the Frame Mode is not G732S:

e The Unit Identical setting can be set to Yes or No when the local modem is
configured as CO and both modems are E1.

e If the Unit identical set is Yes, then the Sync Mode, TSA and Idle Code are
automatically configured in the remote unit if the following conditions are
met:

= |f the local ASMi-52 is defined as CO.

= |f the local ASMi-52 is defined as CPE and the remote unit is not an E1
modem.

= |n the remote ASMi-52 if the local is defined as CPE and it is not an E1
modem.

e If the Unit identical set is No, then the Sync Mode, TSA and Idle Code are
configurable as follows:

= Local ASMi-52 in any configuration.
= Remote ASMi-52 if the local is defined as CO.
» To match remote unit settings with local unit settings:
1. From the E1 Configuration menu, select Local/Remote Port (Main menu >
Configuration > E1 Configuration > E1 Local/Remote Port).

The E1 Local/Remote Port is displayed.

2. From the E1 Local/Remote Port menu, select Units Identical Setting.
The Units Identical Setting value changes to YES.

3. Save the changes.

Configuring the T1 Interface

ASMi-52 units with T1 interface require configuration of the following parameters:
e Framing mode:
= Unframed - Stream of bits at 1.544 Mbps
= ESF - 24 frames per multi-frame
= SF - 12 frames per multi-frame
e Line coding:
= B8ZS - B8ZS coding
= AMI - AMI coding
e Receive gain (sensitivity of the receive equalizer):
= Long--36dB
= Short- 15 dB
e Interface:
= DSU - DSU interface
= CSU - CSU interface
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e Transmit signal mask (DSU mode) — length of a cable in feet between the
ASMi-52 T1 port connector and the network access point:

= 0feet-0to 133 feet
= 133 feet— 133 to 266 feet
» 266 feet - 266 to 399 feet
» 399 feet — 399 to 533 feet
= 533 feet— 533 to 655 feet
e Transmit signal mask (CSU mode) — relative T1 output transmit level:
= 7.5 dB - attenuation of 7.5 dB relative to the nominal transmit level
= 15 dB - attenuation of 15 dB relative to the nominal transmit level
= 22.5 dB - attenuation of 22.5 dB relative to the nominal transmit level
e Fbit configuration — Fbit transmission mode:
= Transparent - F bits are sampled at TSER
= Internally Source — F bits are sourced internally.
Note  Configuration of the sync mode, idle mode, timeslot assignment and matching of T1

setting of the local and remote units (Unit Identical Set) is identical of that of the ET
interface. Refer to Configuring the ET Interface section above.

» To access the T1 Configuration menu:

1. From the Configuration menu, select T1 Configuration.
The T1 Configuration menu appears.
2. From the T1 Configuration menu, select T1 local port for the local port
configuration or select T1 remote port for the remote port configuration.
The T1 Local/Remote Configuration menu appears (see Figure 4-37).

ASMi-52
Tl Local Port Configuration
1. Framed Mode > (SF)
2. Line code (B8ZS/AMI)
3. Receive Gain (LONG/SHORT)
4. Interface > (DSU/CSU)
5. Transmit Signal Mask (7.5 dB)
6. Fbit Configuration (Transparent/Internally Source)
7. Sync Mode (FAST)
8. Units identical setting (Yes/No)
9. Idle code (££)
10.Time slots assign >
11. Save
>
ESC-prev. menu; !-main menu; &-exit;

Figure 4-37. T1 Port Configuration
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4.4 Additional Tasks

Displaying the ASMi-52 Status

The ASMi-52 software allows you to display the modem system and physical port
information.

The status information is available via the Monitoring menu.

» To access the Monitoring menu:

e From the Main menu, select Monitoring.

The Monitoring menu appears (see Figure 4-38).

ASMi-52
Monitoring
1. Total Alarms [1>
2. System monitoring >
3. Physical ports status >
4. Physical ports Statistics >
5. Repeater status >
6. Open Virtual Connection
>
ESC-prev. menu; !-main menu; &-exit;

Figure 4-38. Monitoring Menu

Displaying the System Status
» To display the system information:

1. From the System Monitoring menu, select System Status (Main menu >
Monitoring >System Monitoring > System Status) to display the device status
information.

The System Status menu appears (see Figure 4-39).
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System Status

Device Type

Clock Source
Software Version
Hardware Version
FPGA Version
Hardware Status
FAILURE)

PS

MAC address
12)
IP address

Alarm Indication
Test Indication

>

ESC-prev. menu;

!'-main menu;

ASMi-52
Local Remote
(ASMi52_SA M (PLASTIC)-STU_C-2W)
ASMi52 SA
(INT) RCV
(2.01E24) (2.01E24)
(0.00) (0.00)
(0.13) (0.13)
(NO HARDWARE FAILURE) (NO HW

(WIDE RANGE PS 48-60 VDC/100-240 VAC)
(WIDE RANGE)

(0 20 D2 20 5F AB) (0 20 D2 21
(172.17.161.73)

(172.17.161.75)

NORMAL NORMAL
(OFF) (OFF)

&-exit;

Note

Figure 4-39. System Status Screen

Alarms are described in Chapter 5.

Displaying the Port Status

» To display the port status information:

1.

From the Physical Port Status menu, select Port Status (Main menu >
Monitoring > Physical Port Status > Port Status) to display the port status.

The Port Status menu appears (see Figure 4-40).

SHDSL
SHDSL

(N)

Framer Type
EOC compatible
Actual PSD
Line rate

El interface
HW status

Test status
Alarm status
REM connected line (1)

ESC-prev. menu;

Port status

ASMi-52
Local Remote
(Standard ANNEX B, Wire mode 2W)
Line (Status: SYNC, State: DATA mode)
(SLOTTED E1)
(PROPRIETARY)

'-main menu;

(ASYM_PSD_DISABLE)

(2048 kbps + 8 kbps)
(IR-G704-E1/BALANCE Data rate:
(NO HARDWARE FAILURE)

(NONE) >

(NORMAL)

2048 kbps)

&-exit;

ASMi-52 Ver. 2.5

Figure 4-40. Port Status Menu

Additional Tasks 4-37




Chapter 4 Configuration Installation and Operation Manual

Note [he physical port alarms are described in Chapter 5.
2. Type N to display the next page.

Accessing the Remote ASMi-52

Accessing the remote ASMi-52 is performed using a virtual connection with your
terminal physically connected to the local unit.

» To access the remote ASMi-52

1. From the Monitoring menu (Figure 4-38), select Open Virtual Connection
(Main menu > Monitoring > Open Virtual Connection).

2. The Login screen of the second ASMi-52 appears.
3. Login to the second ASMi-52.

You now have access to the second ASMi-52 menus.

Note  [f no key press is sensed for a period of 10 minutes, the virtual connection closes
and you are returned to the initial ASMi-52.
» To close a virtual terminal

e From the Monitoring menu of the second ASMi-52, select Close Virtual
Connection.

The Main menu of the first ASMi-52 is displayed.

Entering the User Name and Password

Once you have installed the ASMi-52 modems at the central and remote locations,
and have completed the installation and operation procedures described in
Chapter 2 and Chapter 3, you can start a control session.

You have to enter a user name and password in order to start the ASMi-52
management software (see Figure 4-41 and Figure 4-42).

ASMi-52
USER NAME :
PASSWORD:

Figure 4-41. Password Request Screen (Terminal Session)
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3 http:/#172.17.164.189/configurad/frame - Microsoft Internet Explorer, r:”E'E'
RAD] ASMi-32 '3
ConfigiRidy
Login
User Name:
Password:

Figure 4-42. Password Request Screen (ConfiguRAD Session)

» To enter the user name and password:

1. Type in your user name and press <Tab>.
Note  You can leave the user name field empty (default), the default password is 1234.

2. Type in your password at the > prompt (up to eight characters).
ASMi-52 responds to your entry with asterisks.

3. Press <Enter>.
The Main menu is displayed (see Figure 4-43 and Figure 4-44).

ASMi-52
Main Menu
1. Inventory
2. Configuration
3. Monitoring
4. Diagnostics
5. File Utilities
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll

Figure 4-43. Main Menu (Terminal Session)
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2l http:/#172.17.161.18%/configurad/Webhan - Microsoft Internet Explorer

FAD ASMi-52 'D

ConliguRbiyy

Main Menu

Inventory
ASMi-52 / Configuration

Main menu

ConfiguRAD —__
utilities

Monitoring
Diagnostics
File utilities

Status 1
Trace 1
roroch AN
Logout :‘.l'(

Figure 4-44. Main Menu (ConfiguRAD Session)

Displaying the ASMi-52 Inventory

The ASMi-52 inventory displays information on the functional blocks of the local
or remote modem.

ASMi-52 consists of the following components:

e SHDSL unit

e DTE unit

e Terminal control port

e 10/100BaseT port

e Alarm relay port

e Power supply.
To display the ASMi-52 inventory:

1. From the Main menu, select Inventory.
The Inventory screen appears (see Figure 4-45).

2. Use the following keys to move around the indices.
= L-move left, | - scroll left,
= R - move right, r —scroll right
= U -move up, u-scroll up
= D - move down, d — scroll down

* <Tab> - select next changeable cell.
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ASMi-52
Inventory
1
Index 1001
Description RAD-local ASMi-52 M SHDSL modem
Vendor type
Contained in 0
Class 3
Rel pos 0
Name SHDSL modem
HW ver 0.00
SW ver 1.00E54
->>
>
ESC-prev. menu; !'-main menu; &-exit; @-scroll; ?-help

Figure 4-45. Inventory Screen

Updating Software Releases

This section presents procedures for installing new software releases into the
ASMi-52 units, as well as swapping existing software versions in a local or remote
unit.

ASMi-52 stores two software versions, each of them in one of the two 512-byte
partitions of its flash memory, which also contains a boot program. The software is
stored in compressed format. The active version is decompressed and loaded into
the ASMi-52 RAM upon power-up. The passive software is kept for backup
purposes. By default, ASMi-52 is delivered with the active software only.

New software releases are distributed on diskettes as an *.img file, which is
downloaded to the local ASMi-52 using the TFTP or XMODEM protocol. Upon
downloading, the new software release becomes active, the former active software
turns into backup, and the former backup is erased.

If a failure occurs during downloading or decompression, the new version is erased
from the flash and the backup version becomes active. In this case, only one
version is left stored in the flash memory. If the active software becomes
corrupted, you can replace it with its backup.

Installing a New Software Release via TFTP
» To install a new software release via TFTP:

1. From the SW & File Transfer menu, select TFTP (Figure 4-46) (Main menu >
File Utilities > SW & File Transfer > SW Download > TFTP).
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ASMi-52
TETP
TFTP status (No operation)
TFTP error (No error)
1. TFTP IP server (172.17.160.103)
2. TFTP file name (201e24.img)
3. TFTP retry timeout (sec) [0-300] (15)
4. TFTP total timeout (sec) [0-4000] (1200)
5. Save
6. Transfer command
>
ESC - prev. menu ; ! — main menu ; & - exit

Figure 4-46. TFIP Menu

2. From the TFTP menu, perform the following steps:

= Select TFTP IP Server and enter the IP address of the TFTP server

= Select TFTP File Name and enter the name of the software file (for
example, 201e24.img).

= Select TFTP Retry Timeout and specify intervals between connection
retries (in seconds).

= Select TFTP Total Timeout and specify the TFTP connection timeout (in
seconds).

= Select Save to save the TFTP configuration.

= Select Transfer Command to start downloading file to ASMi-52.

ASMi-52 automatically erases the backup partition. Once downloading is
completed, ASMi-52 saves the new release as an active partition, the
former active partition becomes the backup.

Once downloading is complete, ASMi-52 decompresses the release file,
displaying the following message:

Final process download. Reset

After the decompression, ASMi-52 saves the new release as an active

partition, the former active partition becomes backup. Then the unit resets
itself. This causes the new software to be loaded into the modem's RAM.

Installing a New Software Release via XMODEM

Notes o |nstallation of the new software releases via XMODEM is not possible over
Telnet.

e To minimize the software downloading time, it is recommended to configure the
CONTROL port to the highest available data rate, see Changing the Control
Port Data Rate section above.

» To install a new software release via XMODEM:

1. From the SW & File Transfer menu, select XMODEM (Main menu > File
Utilities > SW & File Transfer > SW Download > XMODEM).
ASMi-52 responds with the following string:
PLEASE OPEN XMODEM APPLICATION.
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Note

2.

For exit press Q(uit)

If you press <Q>, ASMi-52 aborts the download process and displays
Download failure. Press Esc to continue. message in addition
to the previous display.

During the software installation, the TST indicator blinks.

Send the *.img file to ASMi-52 using the XMODEM protocol of your terminal
application.
Once downloading is complete, ASMi-52 decompresses the release file,
displaying the following message:
Final process download. Reset device after 5 seconds

After the decompression, ASMi-52 is automatically reset. This causes the
new software to be loaded into the modem's RAM.

Autoconfiguration through TFTP or XMODEM

Modem autoconfiguration is possible by means of TFTP or the XMODEM option.
A file has to be uploaded and/or downloaded to be able to copy a configuration
file from one modem acting as the source to the other modem(s). The modem
configuration can be uploaded to a different location (i.e., a PC) as a file that is not
in the modem or downloaded from the configuration source (i.e., modem).

The following functionalities are available for auto-configuration:

To Upload a current configuration from the database to a PC and/or a Flash
disk.

To download a configuration file from a source to the current configuration.

» To upload a configuration from the source device:

1.

ASMi-52 Ver. 2.5

From the SW & File Transfer, select Auto Configuration (Main menu > File
Utilities > SW & File Transfer > Auto Configuration) to select an auto-
configuration type.

The Auto Configuration menu is displayed.

Select Command (Upload/Download Full/Part Download) and select
Command and set to Upload (see Figure 4-48).

Select TFTP or XMODEM (as in software download).

ASMi-52
Auto Configuration

1. XMODEM
2. TFTP
3. Command (UPLOAD/DOWNLOAD FULL/DOWNLOAD PART)

ESC-prev. menu; !-main menu; &-exit

Figure 4-47. Software Version Screen

From the SW & File Transfer menu, select TFTP (Figure 4-46) (Main menu >
File Utilities > SW & File Transfer > SW Download > TFTP).
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5. From the TFTP menu, perform the following steps:

= Select TFTP IP Server and enter the IP address of the TFTP server

= Select TFTP File Name and enter the name of the software file (for
example, 201e24.img).

= Select TFTP Retry Timeout and specify intervals between connection
retries (in seconds).

= Select TFTP Total Timeout and specify the TFTP connection timeout (in
seconds).

= Select Save to save the TFTP configuration.

= Select Transfer Command to start downloading file to ASMi-52.

ASMi-52 automatically erases the backup partition. Once downloading is
completed, ASMi-52 saves the new release as an active partition, the
former active partition becomes the backup.

Once downloading is complete, ASMi-52 decompresses the release file,
displaying the following message:

Final process download. Reset

After the decompression, ASMi-52 saves the new release as an active
partition, the former active partition becomes backup. Then the unit resets
itself. This causes the new software to be loaded into the modem's RAM.

» To download a configuration file to the target device(s):

1. From the SW & File Transfer, select Auto Configuration (Main menu > File
Utilities > SW & File Transfer > Auto Configuration) to select an auto-
configuration type.

The Auto Configuration menu is displayed.

2. Select Command (Upload/Download Full/Part Download) and select
Download Full/Part to download the file (see Figure 4-48).

3. Select TFTP or XMODEM (as in software download).

Displaying the Software Version

You can display the information on the software revision of the local or remote
modem. The information includes a description of the active program, which is
currently used by ASMi-52, and also details on the passive software kept for
backup purposes.

» To display the software version:

1. From the File System menu (Main menu > File Utilities > File System > SW
Files), select SW Files to display the software revision of the ASMi-52 device.

The Software Version menu appears (see Figure 4-48).

4-44 Additional Tasks ASMi-52 Ver. 2.5



Installation and Operation Manual Chapter 4 Configuration

ASMi-52

SW files

Local Remote
Software active version: (2.01E24) (2.02000)
Software active partition: (0) (0)
Code size: (813110) (813161)
Date: (28-7-4) (2-8-4)
Software backup version: (2.01E24) (2.01E11)
Software backup partition: (1) (1)
Code size: (813110) (809233)
Date: (28-7-24) (9-6-4)
Boot version: (1.10) (1.10)
Boot mng version: (5.34) (5.34)

Press any key to continue...

ESC-prev. menu; !'-main menu; &-exit

Figure 4-48. Software Version Screen

Switching the Software Versions

If an active software becomes corrupted, you can switch it with the backup in the
local ASMi-52 units.

» To swap software versions:

1.

From the File System menu, select the SWAP Local SW Files (Main menu >
File Utilities > File System > Swap Local SW Files) to swap files in the local
ASMI-52.

ASMi-52 displays the following message:

Request to swap SW files!!! Confirm Y/N
Type Y to confirm the file swap.

ASMi-52 performs the swap and sends the following string:

Program Switching

The active software becomes the backup and vice versa. At this stage,
ASMI-52 is automatically reset.
If you try to switch the software versions when only one version is available,
ASMi-52 responds with the following message:
Impossible to switch - no other program
Press any key to continue

Resetting ASMi-52
ASMi-52 supports four types of reset:

ASMi-52 Ver. 2.5

Reset to the default setting
SHDSL interface reset
SHDSL repeater line reset

Overall reset.
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4-46

Resetting to Default Settings

You can reset the local or remote ASMi-52 to its default settings. Resetting to the

factory default does not affect the master clock setting. In addition, you can reset
the local ASMi-52 without affecting its management parameters (IP address, mask
and default gateway).

» To reset ASMi-52 to the factory default:

Note

1. From the System Configuration menu, select Factory Default. (Main menu >
Configuration > System Configuration > Factory Default).

The Factory Default menu is displayed (Figure 4-49).

ASMi-52
Factory default

Remote unit number (1)

1. Local factory default

2. Remote factory default

3. Local factory default W/O MNG

4. Remote factory default W/O MNG ...
>

E

SC - prev. menu ; ! - main menu ; & - exit

Figure 4-49. Factory Default Menu

2. From the Factory Default menu, perform one of the following steps:
= Select Local Factory Default to reset the local ASMi-52.
= Select Remote Factory Default to reset the remote device.

= Select Local Factory Default W/O MNG to reset all parameters, except for
the IP address, mask, default gateway and the manager list of the local
ASMi-52.

= Select Remote Factory Default W/O MNG to reset all parameters, except
for the IP address, mask, default gateway and the manager list of the
remote ASMi-52.

Local/Remote Factory Default W/O MNG parameters are available only for the
units equipped with the management LAN port.

ASMi-52 displays the following message:
Request to factory default !!! Confirm Y/N

3. Type Y to confirm the reset.

ASMi-52 resets all configuration parameters, except for the master clock
(and IP values), to their default settings and restarts the system.

Resetting the ASMi-52 Modem

You can reset the SHDSL interface of the modem or repeater, or perform the
overall reset of the modem.

» To reset the SHDSL interface or perform the overall device reset:

1. From the System Configuration menu, select Reset.
The Reset menu appears (see Figure 4-50).
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ASMi-52 Ver. 2.5

2. From the Reset menu, select Local Reset to reset the local modem or Remote
Reset to reset the remote device.

The Local/Remote Reset menu appears (see Figure 4-517).

3. From the Local/Remote Reset menu, select Local/Remote Device Reset to
perform the overall reset or select Local/Remote SHDSL Line Reset to reset
the SHDSL interface.

A confirmation message appears.

4. Type Y to confirm the reset.

ASMi-52
Reset
1. Local reset >
2. Remote reset >
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-50. Reset Menu

ASMi-52
Local Reset
Local Line number (1)
1. Local device reset
2. Local SHDSL line reset
>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-51. Local Reset Menu

Resetting the SHDSL Repeater

You can reset the SHDSL repeater line interface from the local ASMi-52 via the
Reset menu.

To reset the line interface of the SHDSL repeater:

1. From the Reset menu, select Repeater Reset (Main menu > Configuration >
System Configuration > Reset > Repeater Reset).

The Repeater Reset menu appears (see Figure 4-52).

2. From the Repeater Reset menu, select Repeater Number.

The Repeater Number menu appears.
3. From the Repeater Number menu, select the repeater that you intend to reset.

4. From the Repeater Reset menu, select Repeater SHDSL Line Reset to reset
the SHDSL line interface of the repeater.

5. TypeY to confirm the reset.
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ASMi-52
Repeater Reset

1. Repeater SHDSL line reset .
2. Repeater number > (1)
>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 4-52. Repeater Reset Menu

Exiting the Control Session

You can exit the terminal control session any time by typing & + Enter from any
management menu.

The software returns to the login screen.
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Chapter 5

Configuring a Typical
Application

5.1 Overview

This chapter provides detailed instructions for setting up two ASMi-52 modems in
a typical application.

ASMi-52 configuration is performed via a menu-driven embedded software using a
standard ASCII terminal or a PC running a terminal emulation application
connected to the rear panel CONTROL port. Alternatively, ASMi-52 can be
managed from a Telnet host connected to the 10/100BaseT port on the rear panel.
Read Chapter 4 to familiarize yourself with how to operate a terminal.

Two ASMi-52 modems operating opposite each other, one in the central office,
the second in the customer premises equipment. User traffic is E1 unframed.

ASCII
Terminal

E1 CcO CPE E1
E T Unframed =“ AN Unframed E T—
_ ———e
ASMi-52 ASMi-52
Router Internal Clock Receive Clock Router
123.456.78.90 123.456.78.91

Figure 5-1. Typical ASMi-52 Application

Guidelines for Configuring ASMi-52 Units

ASMi-52 Ver. 2.5

Each ASMi-52 unit must be configured individually. This typical application has the
following configuration steps:

1. Setting the system: Setting the clock mode and the device Host IP address
2. Setting the line interface: Setting the Wire mode (2W or 4W)
3. Setting the E1 port: Setting the framing mode.
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5.2 Configuring the ASMi-52 units

Two ASMi-52 units must be configured for this application. Both units have the
same configuration parameters, except for the host IP address and the master clock
mode.

» To prepare a control session:

1.
2.
3.

Connect the terminal cable to the CONTROL connector of ASMi-52.
Turn the control terminal on.

Configure the terminal to the default communication parameters: 9.6 kbps,
one start bit, eight data bits, no parity, one stop bit, VT100 emulation.

Select the full duplex mode.
Turn the terminal echo off.

Disable any type of flow control.
You are now ready to start a control session.

» To enter the user name and password:

1.

Type in your user name and press <Tab>.

Note  You can leave the user name field empty (default), the default password is 1234.

2.

3.

Type in your password at the > prompt (up to eight characters).
ASMI-52 responds to your entry with asterisks.

Press <Enter>.
The Main menu is displayed.

Setting the ASMi-52 System Parameters

» To configure the master clock:

1.

Display the Master Clock menu (Main menu > Configuration > System
Configuration > Master Clock)

The Master Clock menu appears.

ASMi-52
Master clock (Internal)
1. Receive
2. Internal
3. External E1
4. External V35
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 5-2. Master Clock (Internal) Menu

From the Master Clock menu, four clock modes are given Receive, Internal,
External E1 or External V35.
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= Set the CO ASMi-52 unit clock to Internal.
= Set the CPE ASMi-52 unit clock to Receive.

3. Select Save to save the changes.
» To set the device host IP address:

1. Display the host IP menu (Main menu > Configuration > System
Configuration > Management > Host IP.

The host IP screen appears.
2. From the host IP menu, configure the following:
= ASMi-52 IP address — 172.17.161.73
= Host IP mask — 255.255.255.0
* Host default gateway IP address — 172.17.161.1

ASMi-52
Host IP address (172.17.161.730)
Host IP mask 255.255.255.01)
172.17.161.1)

(

Host default gateway (
Read community (public)

(

(

Write community public)

Trap community public)

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 5-3. Host IP Menu

3. Press ESC to return to previous menu (Management menu).

4. Save the changes.

Setting the E1 Port
» To select E1 framing mode:

1. Display the Framed Mode menu (Main menu > Configuration > E1
Configuration > E1 Local Port menu > Framed Mode).

The Framed Mode menu appears.

ASMi-52
Framed mode (Unframed)
1. Unframed
2. G732N
3. G732S transparent
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 5-4. Frame Mode (Unframed) Menu
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2. From the Framed Mode menu, select Unframed to choose the unframed
operation.

The ET Local Port menu appears.
3. Save the changes.

After performing these configuration procedures, the ASMi-52 units are ready to
be connected.

Configuring the Line Interface Type

You can configure the ASMi-52 units with 4-wire interface to operate over 2-wire
lines. Selecting the 2-wire operation mode disables pin 1 and pin 2 of the RJ-45
line connector.

» To configure the line interface type for ASMi-52 units:

1. From the SHDSL Local Port Configuration menu, select Configured Wire
The display is refreshed and a new value appears (2W or 4W).

2. Select Save to save the changes

3. Reset ASMi-52 in order to active the change.

Configuring the Serial DTE Interface

5-4

If the ASMi-52 modem is equipped with a serial data interface, the configuration
software allows you to enable/disable the LLB/RLB activation from the DTE (except
for X.21) and select the modem’s data rate.

Configuring LLB/RLB Activation from DTE

» To enable/disable the LLB/RLB activation from DTE:

1. From the DTE Configuration menu, select DTE Local Port Configuration
(Main menu > Configuration > DTE Configuration > DTE Local Port) to
configure the DTE local port (see Figure 5-5).

The DTE Local Port menu appears (see Figure 5-6).

2. From the DTE Local Port menu, select LLB from DTE to enable the LLB
activation from the DTE or select RLB from DTE to enable the RLB activation
from the DTE.

The display is refreshed and a new value appears.

3. Select Save to save the changes.

ASMi-52
DTE configuration >
Port number (1)
1. DTE local port
2. DTE remote port
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 5-5. DTE Configuration Menu
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ASMi-52

DTE local port configuration >

1. LLB from DTE
2. RLB from DTE
3. Data rate

4. Save

>

ESC-prev. menu;

(Enable/Disable)
(Enable/Disable)
(1984 kbps)

!-main menu; &-exit; @-scroll

ASMi-52 Ver. 2.5

Figure 5-6. DTE Local Port Menu
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Chapter 6

Troubleshooting and
Diagnostics

This chapter describes the ASMi-52 diagnostic functions, which include:

Status indications, alarms, power-up self-test
Statistics collection
Bit Error Rate Test (BERT)

Diagnostic tests (loopbacks and LEDs test).

6.1 Monitoring Performance

Displaying SHDSL Statistics

ASMi-52 has capabilities to collect SHDSL performance statistics. The statistics data
is collected for the current 15-minute interval or current day. In addition ASMi-52
displays a statistics report for the last 96 intervals or the last seven days, elapsed
since the last modem power-up.

ASMi-52 Ver. 2.5

Displaying the Current SHDSL Statistics

SHDSL performance statistics for the current 15-minute interval and for the
current 24-hour interval can be displayed.

» To display the current SHDSL statistics:

1.

From the Monitoring menu, select Physical Ports Statistics (Main menu >
Monitoring > Physical Ports Statistics).

The Physical Port Statistics menu appears (see Figure 6-1).

ASMi-52

Physical Port Statistics

1. SHDSL port performances ...
2. E1l port performances ...

3. Bert performance......

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-1. Physical Port Statistic Menu

Monitoring Performance 6-1




Chapter 6 Troubleshooting and Diagnostics Installation and Operation Manual

2. From the Physical Port Statistics menu, select SHDSL Port Performances to
display the unit’s SDHSL statistics.

The SDHSL Port Performances menu appears (see Figure 6-2).

ASMi-52

SHDSL Port Performances

SHDSL current performances
SHDSL all intervals local performances

SHDSL all intervals remote performances

1

2

3

4. SHDSL current day performances

5. SHDSL all days local performances
6. SHDSL all days remote performances
7

SHDSL clear performances

>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-2. SHDSL Port Performances Menu

3. From the SHDSL Port Performances menu, select:
= SHDSL Current Performances to display the current SHDSL statistics
= SHDSL Current Day Performances to display the current day statistics.
The SHDSL Performance screen appears (see Figure 6-3 and Figure 6-4).

4. Press <Enter> to refresh the display or press <Esc> to exit the SHDSL
Performance screen.

ASMi-52

SHDSL current performances

Local A Local B Remote A Remote B
Port number (1)
Current ES (0) (0) (0) (0)
Current UAS (0) (0) (0) (0)
Current SES (0) (0) (0) (0)
Current LOSWS (0) (0) (0) (0)
Current CRC anomalies (0) (0) (0) (0)
Current Timer (578 sec) (578 sec) (578 sec) (578 sec)
Current noise margin (16 dB) (16 dB) (16 dB) (16 dB)
Current line attenuation (0.4 dB) (0.4 dB) (0.4 dB) (0.4 dB)
Current transmit power (8.5 dBm) (8.5 dBm) (8.5 dBm) (8.5 dBm)
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-3. SHDSL Current Performances Screen
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ASMi-52

SHDSL current day performances

Local A Local B Remote A Remote B
Port number (1) (1) (1) (1)
24 hour ES (1) (1) (1) (1)
24 hour UAS (1401) (1401) (1401) (1401)
24 hour SES (0) (0) (0) (0)
24 hour LOWS (0) (0) (0) (0)
24 hour CRC anomalies (3) (3) (3) (3)
Current Day Timer (22280sec) ( 22280sec) (22280sec) (22280sec)
Day Intervals (24) (24) (24) (24)
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-4. SHDSL Current Day Performances Screen

Table 6-1. SHDSL Statistics Parameters

Display Description

Current ES Number of errored seconds in which one or more CRC (Cyclic Redundancy Check)
error events occurred during the current interval. This value is updated every second.

Current UAS Number of unavailable seconds in which a failed signal occurred during the current
interval. This value is updated every second.

Current SES Number of severely errored seconds in which 832 or more CRC error events occurred
during the current interval. This value is updated every second.

Current LOSWS  Number of seconds with loss of sync word during the current interval. This value is
updated every second.

Current CRC Number of CRC error events recorded since the last time the register was cleared.

anomalies

Current TIMER

Time in seconds from the beginning of the interval. This value is updated every second.

ASMi-52 Ver. 2.5

Displaying the SHDSL Statistics for all Intervals

You can display a detailed SHDSL performance statistics for 96 last 15-minute
intervals or seven last days (24 hours) intervals elapsed since the last power-up.

To display the SHDSL statistics for all intervals:

1. From the SHDSL Port Performances menu (see Figure 6-2), select SHDSL All
Intervals Local Performances/SHDSL All Intervals Remote Performances to
display the SHDSL statistics for 15-minute intervals or select SHDSL All Days
Local Performances/SHDSL All Days Remote Performances to display the
SHDSL statistics for day intervals.

The SHDSL All Intervals screen appears (see Figure 6-3 and Figure 6-4).

2. Press any key to return to the SHDSL Port Performances menu.

Monitoring Performance 6-3
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ASMi-52

SHDSL all intervals local/remote performances ...

Line A Line B
INT CRC LOSWS ES SES UAS CRC LOSWS ES SES UAS
ESC-prev. menu; !-main menu; &-exit; ?-help; @-scroll

Figure 6-5. SHDSL All Intervals Local/Remote Performances

ASMi-52

SHDSL all days local/remote performances ...

Line A Line B
DAY CRC LOSWS ES SES UAS CRC LOSWS ES SES UAS
ESC-prev.menu; !-main menu; &-exit; ?-help; @-scroll

Figure 6-6. SHDSL All Days Local/Remote Performances

Clearing the SHDSL Performance Statistics

» To clear the SHDSL Port Performance statistics:

From the SHDSL Port Performances menu (see Figure 6-2), select SHDSL
Clear Local Performances or SHDSL Clear Remote Performances, and press
<Enter>.

All SHDSL statistics data are cleared.

Displaying E1/T1 Statistics

When ASMi-52 includes a G.704 E1/T1 port configured to the G732N framing,
the modem has the capabilities to collect E1/T1 performance diagnostics. Statistics
collection depends on the use of the CRC-4 function for E1 and T1:

6-4

CRC-4 Enabled (E1), ESF framing (T1)

When the CRC-4 functions are enabled, it is possible to monitor end-to-end
data transmission performance. Error detection is derived from the data
payload by performing a cyclic redundancy check (CRC). The resulting CRC
checksum is transmitted in addition to the raw data bits. The receiving end
recalculates the checksum and compares the results with the received
checksum: any difference between the two checksums indicates that one or
more bits are contained in the current data block being evaluated.

CRC-4 Disabled (E1), SF framing (T1)

When the CRC-4 option is disabled, ASMi-52 does not support the capabilities
listed above. However, the modem is capable of providing statistics of bipolar
violations.

Monitoring Performance ASMi-52 Ver. 2.5
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Note ,  For details on enabling the CRC-4 function, refer to Chapter 4.

e for the details on configuring T1 framing, refer to Configuring T1 Interface in
Chapter 4.

Displaying the Current E1/T1 Statistics
» To display the current E1/T1 statistics:
1. From the Physical Port Statistics menu (Figure 6-1), select E1/T1 Port
Performances to display the local/remote unit E1/T1 statistics.
The E1/T1 Port Performances menu appears (see Figure 6-7).
2. From the E1/T1 Port Performance menu, select E1/T1 Current Performances

to display the current E1/T1 statistics or select E1/T1 Current Day
Performances to display the current day statistics.

The E1/T1 Port Performances screen appears (see Figure 6-8, and
Figure 6-9).

3. Press any key to exit the E1/T1 Performances screen.

ASMi-52

E1/T1 Port Performances

E1/T1 current performances
E1/T1 all intervals local performances

E1/T1 all intervals remote performances

E1/T1 clear local performances

1

2

3

4. E1/T1 current day performances
5

6. E1/T1 clear remote performances
>

ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-7. E1/T1 Port Performances Menu

If CRC-4 is disabled, a typical E1/T1 Current Performance screen will include only
BPV statistics, as shown in Figure 6-8 and Figure 6-9.

ASMi-52
E1/T1 current performances
Local Remote
Port number (1)
BPV last minute (0) (0)
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-8. E1/T1 Current Performances Screen
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ASMi-52
E1/T1 current day performance
Local Remote
Port number (1)
No statistics collection
ESC-prev. menu; !-main menu; &-exit; @-scroll
Figure 6-9. E1/T1 Current Day Performances Screen
Table 6-2. E1/T1 Statistics Parameters
) .. Range
Display Description
15 min | 24 hour
CRC errors Number of CRC error events recorded since the last time the register was | — -
cleared.
CRC avrg The average number of CRC events per second. This value is updated - -
errors every second.
Current ES Number of errored seconds in which one or more CRC (Cyclic 0-900 0-65535
Redundancy Check) error events occurred during the current interval. This
value is updated every second for 15-minute interval or every 15 minute
for 24-hour interval.
Current SES Number of severely errored seconds in which 832 or more CRC error 0-900 0-65535
events occurred during the current interval. This value is updated every
second for 15-minute interval or every a 15 min. for a 24-hour interval.
Current UAS | Number of unavailable seconds in which a failed signal occurred during 0-900 0-65535
the current interval. This value is updated every second for a 15-minute
interval or every a 15 min. for 24-hour intervals.
Current BES Number bursty errored seconds, in which 2 to 831 CRC error events 0-900 0-65535
occurred during the current interval. This value is updated every second.
Current LOFC | Number of loss of frame alignment events measured during the current 0-255 0-255
interval. This value is updated every second for 15-minute interval or every
15 min. for 24-hour interval.
Current CSS Number of seconds with one or more controlled slip events measured 0-255 0-255
during the current interval. This value is updated every second for a
15-minute interval or every 15 min. for a 24-hour interval.
24 hour Total number of degraded minutes in the current 24-hour interval. A - 0-1440
degrade degraded minute is a minute in which the BER exceeded 1x10°. This
minute value is updated every minute.
24 hour last Total number of degraded minutes in the last 24-hour interval. This value | — 0-1440
degrade is updated every 24 hours.
minute
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Table 6-2. . E1 Statistics Parameters (Cont.)
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Display Description Range
Current DM Number of degraded minutes in which the BER exceeded 1x107°. This 0-1440 | 0-1440
value is updated every minute for 15-minute interval or every 24 hours for
24-hour interval.
BPV last Number of bipolar violation events detected in the last minute. This value | 0-1000 | 0-1000
minute is updated every minute.
BPV max Number of bipolar violation events detected in the worst minute since the | 0-1000 | 0-1000
minute last resetting of the BPV counter. This value is updated every minute.
Current Time in seconds from the beginning of the interval. This value is updated 0-900 0-96
TIMER every second.
For 24-hour interval — number of 15 minutes intervals the device has been
working after power up

ASMi-52 Ver. 2.5

Displaying E1/T1 Statistics for All Intervals

You can display detailed E1/T1 performance statistics for 96 last 15-minute

intervals elapsed since the last power-up.

» To display E1/T1 statistics for all intervals:

1. From the E1 Port Performances menu, select E1/T1 All Intervals Local

Performances or E1/T1 All Intervals Remote Performances (Main menu >
Monitoring > Physical Ports Statistics > E1/T1 Port Performances > E1/T1 All
Intervals Local/Remote Performances) to display the E1/T1 statistics for all 15-

minute intervals.

The E1/T1 All Intervals Local/Remote Performances screen appears (see

Figure 6-10).

2. Press any key to exit the E1/T1 All Intervals Local/Remote Performances

screen.

ASMi-52

E1/T1 all intervals local/remote performances

INTERVAL ES ©SES UAS BES LOFC CSS DM

ESC-prev. menu; !-main menu; &-exit; @-scroll;

?-help

Figure 6-10. E1/T1 All Intervals Local/Remote Performances
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Clearing the E1/T1 Statistics

» To clear E1/T1 statistics:

e From the E1 Port Performances menu (see Figure 6-2), select E1/T1 Clear
Local Performances or E1/T1 Clear Remote Performances (Main menu >
Monitoring > Physical Port Statistics > E1 Port Performances > E1/T1 Clear
Local/Remote Performances), (see Figure 6-7).

All E1 statistics data are cleared.

6.2 Detecting Errors

Power-Up Self-Test

ASMI-52 performs a hardware self-test upon power-up. The self-test sequence
checks the critical circuit functions of the modem.

The results of the hardware self-test for the local or remote ASMi-52 are displayed
in the System Status and Physical Status Port screens (see Chapter 4).

Front Panel LEDs

The status of ASMi-52 is indicated by the ALM, TST and SYNC LED indicators
located on the front panel. For the description of LEDs and their functions, refer to
Chapter 3.

6.3 Handling Alarms

ASMi-52 detects fault conditions and initiates alarms to alert the user. ASMi-52
supports the following alarm types:

e System alarms, relating to the ASMi-52 chassis
e Port alarms, relating to a specific interface (SHDSL or DTE)
e Information messages (warnings)

e Events that trigger alarm activation.

ASMi-52 maintains two separate displays for the system and port alarms. In
addition, the modem supports a local log file, holding up to 100 alarms.

An alarm or warning simultaneously activates the alarms display and generates a
log file, and the ALM LED turns on to indicate the condition. When the fault
condition that caused the alarm is cleared, the alarm is removed from the alarm
screen, but remains in the log file, enabling you to view the alarm history. Events
are generated into the log file.
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Displaying All Alarms

ASMI-52 allows you to display all alarms, irrespective of their origin (system or
port).

» To display all alarms:

1. From the Main menu, select Monitoring.
The Monitoring menu appears (see Figure 6-11).

2. From the Monitoring menu, select Total Alarms.
The Total Alarms Screen appears (see Figure 6-12).

The display of the alarms screen includes the source of alarm (local or remote
device), name of the alarm, its number, severity (major or minor) and status
(always ON), see Figure 6-12.

Once the event that caused the alarm is cleared, the ALM indicator turns off.

3. Press <Enter> to refresh the display.

ASMi-52
Monitoring
1. Total alarms <[]
2. System monitoring <
3. Physical ports status <
4. Physical ports statistics >
5. Open virtual connection
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-11. Monitoring Menu

ASMi-52
Total alarms
Source Name Num Severity Status
Remote 1 PSD NOT CONNECTED 8 MAJOR ON
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-12. Total Alarms Screen
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ASMi-52
System Monitoring
1. System status
2. System log file
3. System clear log file
>
ESC-prev.menu; !-main menu; &-exit; @-scroll

Figure 6-13. System Monitoring Menu

Working with the System Log File

ASMi-52 maintains system alarm buffer, which can store up to 100 system alarm
messages. The system log file specifies alarm or event name, severity (major or
minor), status (ON or OFF), and the time elapsed since the last ASMi-52 reset.

» To display the system log file:

e From the System Monitoring menu (Figure 6-13), select System Log File (Main
menu > Monitoring > System Monitoring > System Log File).

The System Log File screen appears.
» To clear the system log file:

1. From the System Monitoring menu (Figure 6-13), select System Clear Log File
(Main menu > Monitoring > System Monitoring > System Clear Log File) to
clear the log file.

A confirmation message is displayed at the bottom of the screen.

2. TypeY and press <Enter>.

All the system log file entries are deleted from the log file.

Displaying the Port Status

1. Follow the Monitoring menu, select Physical Port Status (Main menu >
Monitoring > Physical Port Status).

The Physical Ports Status menu appears.

2. From the Physical Ports Status menu, select one of the following (see
Figure 6-14):

= Port Status to display the port status

* Line Mask for the line mask

= Port Log File to display the log file of the port

= Port Clear Log File to clear the log of the log file.
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ASMi-52
Physical port status
Port Number (1)
1. Port status
2. Line mask (NO_MASK)
3. Port log file
4. Port clear log file
>
ESC-prev. menu; !-main menu; &-exit; @-scroll

Figure 6-14. Physical Port Status Menu

Masking Port Alarms

ASMi-52 allows you to mask alarms generated by local and remote devices.

» To mask ASMi-52 alarms:

e From the Physical Port Status menu (Figure 6-14), select Line mask (Main
menu > Monitoring > Physical Port Status > Line Mask).

The Line Mask value changes to Mask. ASMi-52 starts ignoring all alarms
generated devices connected to the modem.

Table 6-3. ASMi-52 Alarms and Warnings

Number Terminal Message Port Description Severity
1 SELF TEST ERROR - Failure occurred during self-test Major
2 SOFTWARE - Software download is in progress Warning
DOWNLOAD
4 LLB FROM DTE DTE Local loopback has been activated by a physical ~ Warning
connector (units with V.35 DTE interface only)
5 RLB FROM DTE DTE Remote loopback has been activated by a Warning
physical connector (units with V.35 DTE interface
only)
6 PROP PROT FAIL SHDSL FE Management by EOC failed Warning
8 LAN NOT DTE The Ethernet interface is not connected to the Major
CONNECTED LAN
9 LOOP ATTN. OVER SHDSL Line A loop attenuation has exceeded the alarm ~ Minor
LINE A threshold
10 LOOP ATTN. OVER SHDSL Line B loop attenuation has exceeded the alarm ~ Minor
LINE B threshold (4-wire units only)
11 SNR MARGIN OVER SHDSL Line A signal-to-noise margin has exceeded the Minor
LINE A alarm threshold

ASMi-52 Ver. 2.5 Handling Alarms 6-11
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Table 6-3. ASMi-52 Alarms and Warnings (Cont.)

Number Terminal Message Port Description Severity
12 SNR MARGIN OVER SHDSL Line B signal-to-noise margin has exceeded the Minor
LINE B alarm threshold (4-wire units only)
13 LOSW FAILURE OVER  SHDSL Loss of Sync Word is detected on line A Minor
LINE A
14 LOSW FAILURE OVER ~ SHDSL Loss of Sync Word is detected on line B Minor
LINE B (4-wire units only)
15 DATA RATE NOT DTE Mismatch in the line rate and data rate. Major
COMPATIBLE Applicable for the ASMi-52 units with V.35
interface, operating in adaptive rate mode
16 PSD NOT SHDSL  Mismatch between PSD mode selected by the Minor
COMPATIBLE user and PSD mode used by the line
17 SYNC LOSS LINE A SHDSL SHDSL line A is not synchronized Major
18 SYNC LOSS LINE B SHDSL ~ SHDSL line B is not synchronized Major
(4-wire units only)
19 MNGNT IS DOWN SHDSL  The management link between local and remote ~ Major
units is down
21 CRC ERROR OVER SHDSL Excessive CRC-6 errors have been detected on Minor
LINE A SHDSL line A
22 CRC ERROR OVER SHDSL Excessive CRC-6 errors have been detected on Minor
LINE B SHDSL line B (4-wire units only)
23 NO DTE INTERFACE DTE No DTE interface is detected Major
24 IR RATE NOT COMP DTE IR rates are not compatible Major
25 E1 REMOTE FAILURE DTE Red alarm is detected at the remote E1 or T1 port  Major
T1 REMOTE FAILURE
26 E1-TS NOT RATE DTE Current line rate does not support the number of ~ Major
COMP assigned E1 or T1 timeslots
T1-TS NOT RATE
COMP
27 ET SIGNAL LOSS DTE E1 or T1 loss is detected at the DTE port Major
T1 SIGNAL LOSS
28 ET1 BPV ERR EXC DTE E1 or T1 bipolar violation errors exceed the Minor
T1 BPV ERR EXC threshold
29 ET FRAME SLIP EXC DTE ET frame slips exceed the threshold Minor
30 ET EXCECIVE BPV DTE Bipolar violations rate exceeds 1x10° during the ~ Major
T1 EXCECIVE BPV last 1000 seconds
31 ET CRC-4 EXC DTE CRC-4 errors exceed the threshold Minor
6-12 Handling Alarms ASMi-52 Ver. 2.5
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Table 6-3. ASMi-52 Alarms and Warnings (Cont.)

Number Terminal Message Port Description Severity
32 ET EXCESIVE ERR DTE The bit error rate of the link exceeds 107 Major
RATIO
T1 EXCESIVE ERR
RATIO
33 ET AIS OCCURED DTE AlS is detected at the ET or T1 port Major
T1 AIS OCCURED
34 ET AIS AND SYNC DTE AlS and loss of frame alignment are detected at Major
LOSS the ET or T1 port
T1 AIS AND SYNC
LOSS
35 ET SYNC LOSS DTE E1 or T1 loss of frame synchronization occurred Major
T1 SYNC LOSS
36 ET CRC MF EXC DTE CRC errors detected in the frame synchronization  Minor
signal exceeded the threshold
37 E1T REMOTE SYNC DTE Remote loss of frame synchronization occurred Major
LOSS
T1 REMOTE SYNC
LOSS
38 ET MF SYNC LOSS DTE Local loss of frame synchronization Major
39 ET MF REMOTE SYNC  DTE Remote loss of frame synchronization Major
LOSS
40 ET TS NOT X128 DTE Number of timeslots assigned for the ASMi-52 Major
T1 TS NOT X128 unit with 4-wire line interface is not nx128
41 ET TS NOT COMP DTE Number of timeslots assigned for the local unit Major
T1 TS NOT COMP does not match the number of timeslots assigned
for the remote unit.
42 WIRE MODE NOT SHDSL Mismatch between line interface types (2/4-wire)  Major
COMP between local and remote units
43 SPAN IS NOT FULL SHDSL  The distance between adjacent repeaters is too Major
long. You can identify the problematic segment
by checking the Port Status screen. In the
Number of Repeaters line, it displays the last
repeater identified by ASMi-52. This means that
the distance between the last detected repeater
and the next repeater exceeds its maximum
range.
44 LOOP ATTN. OVER SHDSL Loop attenuation at the network side of the Major
NETWORK SIDE repeater has exceeded the alarm threshold
ASMi-52 Ver. 2.5 Handling Alarms 6-13
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Table 6-3. ASMi-52 Alarms and Warnings (Cont.)

Number Terminal Message Port Description Severity
45 LOOP ATTN. OVER SHDSL  Loop attenuation at the customer side of the Major
CUSTOMER SIDE repeater has exceeded the alarm threshold. (all)
46 SNR MARGIN OVER SHDSL  Signal-to-noise margin at the network side of the ~ Major
NETWORK SIDE repeater has exceeded the alarm threshold. (all)
47 SNR MARGIN OVER SHDSL  Signal-to-noise margin at the customer side of the ~ Major
CUSTOMER SIDE repeater has exceeded the alarm threshold (all)
48 LOSW FAILURE OVER ~ SHDSL Loss of Sync Word is detected at the network Major
NETWORK SIDE side of the repeater. (all)
49 LOSW FAILURE OVER ~ SHDSL Loss of Sync Word is detected at the customer Major
CUSTOMER SIDE side of the repeater. (all)
50 LINE PARAMERS NOT ~ SHDSL  Modem:s fail to synchronize due to the Major
COMP configuration parameters mismatch. For example:
e The modems operate in the adaptive mode
(Line Prob is set to Adaptive Rate) and the
distance between them exceeds the
maximum range.
e ASMi-52 with a V.35 interface operates
opposite a remote unit with an ET interface. If
the modem V.35 is set to the data rate which
is not supported by the remote unit, e.g.
2304 kbps, the units will not synchronize.
51 EXTERNAL TO DTE The device is in the external clock, but the clock ~ Major
INTERNAL CLOCK is not connected.
52 LOOP ATTN. OVER SHDSL Loop attenuation at the network side of the Major
NETWORK SIDE Line B repeater has exceeded the alarm
threshold.
53 LOOP ATTN. OVER SHDSL Loop attenuation at the customer side of the Line ~ Major
CUSTOMER SIDE - B repeater has exceeded the alarm threshold. (all)
LINE B
54 SNR MARGIN OVER SHDSL  Signal-to-noise margin at the network side of the ~ Major
NETWORK SIDE — Line B repeater has exceeded the alarm (all)
LINE B threshold.
55 SNR MARGIN OVER SHDSL  Signal-to-noise margin at the customer side of the ~ Major
CUSTOMER SIDE - Line B repeater has exceeded the alarm (alh
LINE B threshold.
56 LOSW FAILURE OVER ~ SHDSL  Loss of Sync Word is detected at the network Major
NETWORK SIDE — side of the Line B repeater. (all)
LINE B
57 LOSW FAILURE OVER  SHDSL Loss of Sync Word is detected at the customer Major
CUSTOMER SIDE — side of the Line B repeater. (all)
LINE B
58 LAN RATE NOT COMP  LAN LAN rates are not compatible Major
6-14 Handling Alarms ASMi-52 Ver. 2.5



Installation and Operation Manual

Chapter 6 Troubleshooting and Diagnostics

Table 6-4. ASMi-52 Events

Terminal Message

Description

CRC EVENT LINE A

CRC errors are detected on line A

CRC EVENT LINE B

CRC errors are detected on line B

SW DOWNLOAD FAIL

Software download failed

BUFFER OVERFLOW

More than 100 entries registered in the log file

WD RESET FROM GS

Watchdog error from the SHDSL chipset

GS OUT OF SYNC ABORT

SHDSL framer out of sync

GS LOSS OF CARRIER DETECT

SHDSL carrier loss

GS SQ ERROR DETECT

SHDSL signal quality value is more than 22.7 dB

GS CRC ERROR DETECT

More than three SHDSL CRC errors were detected during the last
second

REP SEGD ERROR DETECT

SEGD error from repeater: sync fail on another part of the span

TRAINING MODE STACK

CPE Training state timeout is exceeded (3 min)

DEVICE PRIMARY CALL FAIL

The primary number dial attempt has failed

DEVICE DIAL CALL FAIL

The dial out call cycle has failed

6.4 Troubleshooting

Working with the Port Log File

ASMi-52 maintains a port alarm buffer, which can store up to 100 alarm messages.
The port log file specifies alarm or event name, severity (major or minor), status
(ON or OFF), and time elapsed since the last ASMi-52 reset.

>» To display the log file:

e From the Physical Port Status menu, select Port Log File (Main menu >
Monitoring > Physical Ports Status > Port Log File).

The Log File screen appears (see Figure 6-15).

ASMi-52 Ver. 2.5
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ASMI 52

Port log file

Source Name Severity Status Time

1. Local MNGMNT IS DOWN MAJOR ON 0:00:00
2. Local E1 SYNC LOSS LINE A MAJOR ON 0:00:00
3. Local E1 SIGNAL LOSS MAJOR ON 0:00:00
4. Local SYNC LOSS LINE A MAJOR ON 0:00:00
5. Local E1 SYNC LOSS MAJOR OFF 0:11:48
6. Local E1 SIGNAL LOSS MAJOR OFF 0:11:48
7. Local SYNC LOSS LINE A MAJOR OFF 0:23:22
8. Local MNGMNT IS DOWN MAJOR OFF 0:24:25
9. Remote LAN NOT CONNECTED MAJOR ON 0:24:29
ESC-prev. menu; !-main menu; &-exit; @-scroll; ?-help

1 user(s)

Figure 6-15. Port Log File Screen

» To clear the log file:

1. From the Physical Port Status menu, select Port Clear Log File (Main menu >
Monitoring > Physical Port Status > Port Clear Log File) to clear the log file.
A confirmation message is displayed at the bottom of the screen.
2. TypeY and press <Enter>.

All the log file entries are deleted from the log file.

6.5 Testing ASMi-52

The user-controlled test functions of ASMi-52 consist of the loopback tests and
LEDs test. The purpose of these tests is to determine the source of a break in the
data flow.

Note o« Both local and remote ASMi-52 units must be configured and synchronized
properly to allow remote loopback activation.

e Only one loopback can be activated at a time, either on the local or remote
unit.
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Bit Error Rate Test (BERT)

It is possible to generate BERT+RLB or BERT (from both CO and CPE) in
multiplexer and E1 and DTE Serial single units.

ASMi-52 Ver. 2.5

The BERT, RLB + BERT can be set only if there is a connection to the FE unit.

BERT Patterns
The following are the BERT test patterns that can be selected:

2E15-1
Mark
Space

Alternate

BERT has a possible Single Error injection only.

The BERT performance counters are as follows:

Error bits — the total number of bit errors detected
BERT total time — the total time the test is running in seconds

Bert error time — the total number of seconds in which errors have been
detected — in seconds

BERT Sync Loss — the number of times Sync Loss was detected since BERT
started to run

BERT result — the number of error bits divided with the total number of data
bits. This item holds 1 byte for the exponent and 2 bytes for the mantissa
holding 1 byte before the period and 1 byte after the period

BERT Sync Loss state — the Sync Status while BERT runs. The BERT Sync Loss
state has the following values:

* SynclLoss = 0
= Sync=1

BERT sync run time — the total number of seconds in which sync have been
detected — in seconds

BERT total bits — the total number of bert bit.

To select the BERT patterns values for Local and Remote tests:

1.

2.

From the Diagnostics menu, select Local/Remote Test (Main menu >
Monitoring > Local/Remote Test).

The Local/Remote Test menu is displayed (see Figure 6-23).

From the Local/Remote Test menu, select BERT.
The BERT menu is displayed.
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6-18

ASMi-52
Bert
1. Bert (ON/OFF)
2. Bert + RLB (ON/OQOFF)
3. Bert pattern >
4. Save Bert parameters
>
ESC-prev. menu ; !-main menu ; &-exit terminal

Figure 6-16. BERT Menu

3. From the Bert menu, select Bert Pattern (see Figure 6-16).
The Bert Pattern selection is displayed (see Figure 6-17).

ASMi-52
Bert Pattern
>
2E15-1
Mark
Spare
Alternate

!-main menu ; &—exit terminal

ESC-prev. menu ;

Figure 6-17. BERT Pattern Menu

» To configure the BERT results:

1. From the Monitoring menu, select Physical Port Statistics (Main menu >

Monitoring > Physical Port Statistics).
The Physical Port Statistics menu is displayed, (see Figure 6-1.
2. From the Physical Port Statistics menu, select Bert Performance.
The Bert Performance menu is displayed, (see Figure 6-18).

ASMi-52

Bert Performances

Bert results

Inject single error local

Bert clear local performance

1

2

3. Inject single error remote

4

5. Bert clear remote performance
>

ESC-prev. menu; !-main menu ; &-exit terminal

Figure 6-18. Bert Performance Menu

3. From the Bert Performances menu, select Bert Results.
The Bert Result window is displayed, (see Figure 6-19)

Testing ASMi-52 ASMi-52 Ver. 2.5
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ASMi-52
Bert Results
Local Remote

Run time (seconds) 2000

Sync loss state sync loss
Sync run time (seconds) 2000

Sync loss counter 2000

Total bits 3000

Error bits 50

BER 5.5E-4

>
ESC-prev. menu; !-main menu ; &-exit terminal

Figure 6-19. Bert Results Menu

4. Configure the local/remote port accordingly.

Running Loopback Tests

ASMi-52 Ver. 2.5

ASMi-52 supports the local and remote loopbacks as per ITU V.54, by using the
following methods:

e From the supervisory terminal.

e Via corresponding pins of the synchronous interface, for the ASMi-52 with
V.35 interface and RS-530 interfaces only.

Loopback in Multiplexer Units
Figure 6-20 is an illustration of how loopback works in the local ASMi-52.
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Data

Clock

Tx

Local ASMi-52

Data

Serial DTE

Clock

A A

Data
Clock
Sync

Data
Clock
Sync

E1 Interface

Rx

Tx

Glue Logic
Line Interface

Rx

Figure 6-20. Loopback with Multiplexer Units

Running the Local Loopback

The local loopback (LLB) checks the performance of the local ASMi-52 modem,
the local DTE and the connection between them (see Figure 6-21). The LLB can be

performed separately on the local and remote modems.

ASMI-52 allows you to set the loopback timeout causing the LLB to deactivate

automatically after the required period of time.

Note  Timeout set to O (zero) is forever. Avoid setting timeout to O as the local control is

lost during LLB.

Local
DTE

Local ASMi-52
Data
Clock " | Transmit
Line
Glug Interface
Logic
 Data
: Clock Receive <

6-20 Testing ASMi-52

Figure 6-21. Local Loopback
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» To run the local loopback:
1. From the Main menu, select Diagnostics.
The Diagnostics menu is displayed (see Figure 6-22).

2. From the Diagnostics menu, select:
= Local Test to run the LLB on the local ASMi-52
= Remote Test to run the LLB on the remote ASMi-52.

The Local/Remote Test menu appears (see Figure 6-23).

3. Select LLB.

The LLB value in parenthesis changes to ON. Also, an additional
parameter, Loop Timeout, is displayed for the local ASMi-52.

4. Select Loop Timeout, if you want to set loopback timeout (in minutes).
The Loop Timeout value changes.

Note  Avoid setting timeout to O as local control is lost during LLB. O=Forever

5. Once you selected the loopback timeout, select Save to activate the LLB.

The LLB is initiated. The TST indicator lights up and the ASMi-52 units lose
synchronization.

ASMi-52
Diagnostics
5. Local Test >
6. Remote Test
7. Repeater Test
>
ESC-previous menu ; !-main menu ; &—-exit terminal

Figure 6-22. Diagnostics Menu

ASMi-52
Local Test or Remote Test
LLB from DTE: OFF
RLB from DTE: OFF
1. Bert >
2. LLB (ON)
3. Loop Timeout (min) (0-4095) ... (5)
4. LEDs test
5. Clear all
6. Save
>
ESC-previous menu ; !-main menu ; &—-exit; @-scroll

Figure 6-23. Local/Remote Test Menu
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Running the Remote Loopback

The remote loopback (RLB) checks the performance of both the local and remote
ASMi-52 modems, and the lines connecting them (see Figure 6-24).

ASMi-52 allows you to set the loopback timeout causing the RLB to deactivate
automatically after the required period of time.

Note  RLB cannot be initiated from a CPE unit if the CO operates with an external clock,
and is configured to one of the following data rates:
2-wire: 2112 kbps, 2176 kbps, or 2240 kbps
4-wire: 4224 kbps, 4352 kbps, or 4480 kbps

Local ASMi-52 Remote ASMi-52
Data ||
Clock " | Transmit — — Receive
Local Glue Line Line Glue Remote
DTE Logic Interface Interface Logic DTE
__ Data ]
h Clock Receive — — Transmit

Figure 6-24. Remote Loopback

» To activate the remote loopback:

1. From the Diagnostics menu (see Figure 6-22), select Local Test to run the RLB
on the local ASMi-52, or select Remote Test to run the RLB on the remote
ASMi-52 (Main menu > Diagnostics > Local/Remote Test).

The Local/Remote Test menu is displayed (see Figure 6-23).

2. Select RLB.

The RLB value in parenthesis changes to ON. Also, an additional
parameter, Loop Timeout, is displayed for the local ASMi-52.

3. Select Loop Timeout, if you want to set the loopback timeout (in minutes).

The Loop Timeout value changes.
Note  [oop timeout = O is forever!

4. Once you selected the loopback timeout, select Save to activate the RLB.

The RLB is initiated. The TST indicators light up on both local and remote
units.

Running Remote Loopback at a Repeater

Remote loopback can also be run at an SHDSL repeater installed in the line. The
RLB is activated from the CO unit only. The RLB checks the repeater’s
performance when it is activated, all preceding repeaters, the local ASMi-52 and
lines connecting them (see Figure 6-25).
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» To activate the remote loopback at the SHDSL repeater:
1. From the Diagnostics menu, select Repeater Test (Main menu > Diagnostics
> Repeater Test).
The Repeater Test menu appears (see Figure 6-26).
2. From the Repeater Test menu, select Repeater Number and choose a
repeater when you intend to activate the RLB Network.
3. From the Repeater Test menu, select RLB Network.
The RLB Network value in parenthesis changes to ON. Also, an additional
parameter, Loop Timeout, is displayed.
4. Once you selected the loopback timeout, select Save to activate the RLB
Network.
The RLB at the repeater is initiated.

Local ASMi-52 Repeater 1 Repeater 2
Data
< Clock Transmit — — —
Local Glue Line Network Customer Network Customer
DTE Logic Interface Interface Interface Interface Interface
 Data
| .
Clock Receive [— - L <
<

Figure 6-25. Remote Digital Loopback at the SHDSL Repeater

ASMi-52
Repeater Test
1. RLB Network (ON)
2. Loop Timeout (min) [0 - 4095] ... (5)
3. Repeater number > (1)
4. Save
>
ESC-prev. menu; !-main menu ; &—-exit

Figure 6-26. Repeater Test Menu

Deactivating the Loopbacks
» To deactivate a running loopback:

e From the Local or Remote Test menu, type the number corresponding to the
loopback in progress to change its value from ON to OFF and choose Save.

The TST indicator turns off.
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» To deactivate multiple loopbacks:

e From the Local or Remote Test menu, select Clear All.

The TST indicator turns off.

Running the LEDs Test

The user can perform the front-panel LED test to verify that the local unit
indicators are functioning properly.

» To run the LEDs test:

1. From the Diagnostics menu (see Figure 6-22), select Local Test (Main menu >
Diagnostics > Local Test) to run the LEDs test on the local ASMi-52.

The Local Test menu is displayed (see Figure 6-23).
2. Select LED Test.
All the front-panel LED indicators light up for two seconds.

6.6 Frequently Asked Questions
Question: In which cases is it not possible to loop the ASMi-52 modem via the
diagnostic screen?

Answer: There are two possible reasons why the loops options do not appear in
the diagnostic screen:

1. The modem has an ETH interface, and since there are no loops in ETH, this
option does not exist.

2. When two modems are connected back-to-back and one of them is in loop
mode, the other modem cannot access the loop options.

Question: What are the different types of SHDSL mapping supported by RAD

products?

Answer: There are 3 modes of transferring user data over SHDSL:
= Serial ATM

= Slotted ET
= nXo64

Since SHDSL defines its own framing, the data must be "converted" to one of the
three framing types defined above. Serial ATM uses ATM features (ATM cells,
UVR, VBR, CBR, and so on); while slotted E1 defines timeslots as the timeslots
used for E1 Tx (up to 2048 kbps). Finally, n x 64 defines the data rate of the serial
port data in steps of 64 kbps, starting from 64 kbps, and ending in 4.6 Mbps.
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6.7 Technical Support

Technical support for this product can be obtained from the local distributor from
whom it was purchased.

For further information, please contact the RAD distributor nearest you or one of
RAD's offices worldwide. This information can be found at www.rad.com (offices —
About RAD > Worldwide Offices; distributors — Where to Buy > End Users).
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Appendix A

Interface Connector
Specifications

A.1 DTE Interface Connectors

V.35, X.21 and RS-530 Interface Connectors

The V.35 interface of the ASMi-52 modem terminates in a 34-pin female
connector. The X.21 interface terminates in a 15-pin, D-type female connector.
The RS-530 interface terminates in a 25-pin, D-type female connector. Table A-1
lists the pin assignment of the V.35, X.21 and RS-530 interface connectors.

Table A-1. V.35, X.21 and RS-530 Connector Pinouts

Signal V.35 RS-530 X.21 Description
Function 34-Pin DB-25 DB-15
Pin Circuit Pin | Circuit Pin | Circuit
(Function)
Protective A Frame 101 1 1 - Chassis Ground. It may be
Ground (Shield) isolated from Signal Ground.
Signal B Signal 102 7 AB 8 - Common signal and DC power
Ground GND (GND) supply ground.
Transmitted P TD(A) 103 2 BA(A) 2 T(A) Serial digital data from DTE. In
licati h
Data S TD(®) 103 14 BA() 9 ®) sync applications, the data
T it translations must occur on the
ransmt rising edge of the transmit clock.
Received R RD(A) 104 3 BB(A) 4 R(A) Serial output from the modem
Data R(B) receiver. In sync applications,
T RD(®) 104 16 BB(®) R (Receive) the data translations occur on
the rising edge of the clock.
Request to C RTS 105 4 CA(A) 3 CA) A positive level to ASMi-52
Send 19 CAB) 10 C®) \r/;he;?rgjta transmission is
(Control) q '
Clearto Send | D CTS 106 5 CB(A) A positive level from
13 CB(B) ASMi-52 with delay, after
receipt of Request to Send, and
when ASMi-52 is ready to
transmit.

ASMi-52 Ver. 2.5
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Table A-1. V.35, X.21 and RS-530 Connector Pinouts (Cont.)
Signal V.35 RS-530 X.21 Description
Function -
34-Pin DB-25 DB-15
Pin Circuit Pin Circuit Pin | Circuit
(Function)
Data Set E DSR 107 6 CC(A) A positive level from ASMi-52
Ready when power is on, and ASMi-52
22 CC®) is (@) not in DIGITAL LOOP
mode, or (b) has not received a
REMOTE LOOPBACK signal
from the remote unit.
Data H DTR 108 20 CD(A) Not used
Terminal
Ready 23 CD(B)
Carrier F DCD 109 8 CF(A) 5 I(A) A positive level from ASMi-52,
Detect 10 | cr®) 12 e except (\;vh.en aI l'OSCT of thed
(Indication) received signal Is detected or
when Data Set Ready is
negative.
External u SCTE(A) 113 | 24 DA(A) 7 A) A serial data rate clock input
Transmit from the data source. Positive
Clock SCTE®) 113 R DA(B) 4o ® clock translations must
correspond to data
transmissions.
Transmit Y SCT(A) 114 15 DB(A) 6 S(A) A transmit data rate clock for
Clock ] SCT(B) 114 12 DB(B) 13 | s@) use.t?y an external daFa source.
. Positive clock translations
(Signal .
O correspond to data translations.
Timing)
Receive \% SCR(A) 17 DD(A) A receive data rate clock output
Clock 115 9 DD(B) used by an external data sink.
SCR(B) Positive clock translations
115 correspond to data translations.
Local Analog | L and j 18 LL A control signal input, which,
Loop when on, sets ASMi-52 into
Local Analog Loopback (V.54
Loop 3).
Remote N and h 21 RL A control signal input which,
Digital Loop when on, commands
ASMi-52 to send a remote
Loopback command (V.54 Loop
2) to the remote ASMi-52.
Test nand k 25 ™ A Control Signal output from
Indicator ASMi-52; positive during any
test mode.
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E1 and T1 Interface Connector

Note

The balanced E1 and T1 interfaces terminate in RJ-45 connector. Table A-2 lists
the balanced connector pin assignment.

Table A-2. E1/T1 Connector Pinout

Pin Function

1,2 Transmit (output)

4,5 Receive (input)

7 CPU ID for unbalanced interface detection
8 Earth GND

It is recommended to use 4-wire cables (pin numbers 1, 2, 4, and 5) only forE1/T1
connections. If 8-wire cable is used, verify that pin #7 is connected in the

equipment side.
For E1 unbalance, use the cable adaptor CBL-R]545/2BNC/ET.

Ethernet Connector

ASMi-52 Ver. 2.5

Table A-3. Ethernet Connector Pinout

Pin Function
1 Tx+

2 Tx—

3 Rx+

4,5 -

6 Rx—

7,8 -

DTE Interface Connectors A-3
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A.2 CONTROL Connector

The control terminal interface terminates in a V.24/RS-232 9-pin D-type female
connector that can be configured as DCE or DTE (see the Selecting the Control
Port Interface section in Chapter 4). Table A-4 lists the CONTROL connector pin

assignments. Table A-5 describes the control signal direction.

Table A-4. CONTROL Connector Pinout

Pin

Function

—_

Data Carrier Detect (DCD)

Receive Data (RD)

Transmit Data (TD)

Data Terminal Ready (DTR)

Ground (GND)

Data Set Ready (DSR)

Request To Send (RTS)

Clear To Send (CTS)

O | (N | |G| b~ W[DN

Ring Indicator (RI)

Table A-5. CONTROL Connector Signal Direction

Control Signal

Interface Type

DCE DTE
CTS Out Not Used
DCD Out Out
DSR Out Out
DTR In In
RI Not Used In
RTS In In
Note . . . .
When connected and turned on, the terminal sets the DTR line ON (active) to gain
control over ASMi-52 and starts a configuration or monitoring session.
When connecting a dial-out modem to the CONTROL port for the alarm
reporting, a cross cable must be used. Table A-6 provides the pinout of a typical
cross cable with two male DB-9 connectors.
CONTROL Connector

ASMi-52 Ver. 2.5
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Table A-6. Cross Cable Pinout

DB-9 Pin DB-9 Pin

2
3
4
5
6
7
8

N[ | |G || N | W

A.3 Alarm Relay Connector

The ASMi-52 alarm relay terminates in a 6-pin female connector, designated
ALARM. Figure A-1 lists the pinout of the ALARM connector. Figure A-2 shows the
pin functions. The relay positions are shown in the Alarm Active state.

6 54 3 21

Figure A-1. ALARM Connector Pinout

Alarm Connector

Minor Alarm Relay

e

o——0

Major Alarm Relay

O—%0

Minor-NO

Minor-COM

Minor-NC

Major-NO

Major-COM

Major-NC

Figure A-2. ALARM Pin Functions
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Appendix B

IR-IP Interface Module

B.1 Introduction

IR-IP is a high-performance, miniature IP router based on RAD's unique IP router
chip, the Chip Router. IR-IP has a 10BaseT (UTP) interface and complies with
IEEE 802.3. The router interface operates in either half-duplex or full-duplex
mode.

IR-IP filters the traffic, in accordance with the IP address of each packet, and
forwards only packets with foreign addresses through the WAN link. IP packets
received from the link are automatically forwarded to the LAN connected to the
local Ethernet interface if the IP net matches.

IR-IP includes hardware filters which handle all filtering operations at wire speed
from both LAN-to-WAN and WAN-to-LAN, without dropping a single packet.
Filtering and forwarding are performed at the maximum rate of 35,000 and
30,000 frames per second (wire speed), respectively. The buffer can hold

256 frames of maximum size of 1534 bytes and a throughput latency of one
frame.

ASMi-52 equipped with IR-IP interface module can be used as a Frame Relay
Access Device (FRAD) with an integral IP router. RFC 1490 is supported for a
single DLCI on the WAN link. Detection of the DLCI and the maintenance
protocol is performed automatically. This allows the IR-IP to be used as the
termination unit of IP services over Frame Relay at the customer premises,
opposite a Frame Relay switch in the backbone.

Alternatively, Point-to-Point Protocol (PPP) can be run on the WAN link with
automatic negotiation on power-up, as well as support for PAP and CHAP
authentication. With this feature, IR-IP can operate opposite any PPP compliant
access server or backbone router.

IR-IP supports HDLC-like framing, which is especially important for broadcast and
multicast applications where bandwidth overhead is critical.

IR-IP supports IP multicast at wire speed, making it suitable for any multicast
environment including high speed downstream environments, such as satellite and
xDSL. Users on the LAN who register with IR-IP for an IP multicast group using the
IGMP protocol filter IP multicast packets at wire speed.

Management and advanced configuration are performed via Telnet.

Introduction B-1



Appendix B IR-IP Interface Module Installation and Operation Manual

Application

Figure B-1 shows a typical application of the ASMi-52 unit equipped with the IR-IP
interface module.

SHDSL

ASMi-52 ASMi-52
with IR-IP with V.35 Interface Router

Figure B-1. Typical Application of the ASMi-52 Unit with IR-IP

B.2 Technical Specifications

Router Local IP Net Capacity Supports up to 256 hosts on the local LAN IP net
Filtering Rate 35,000 packets per second IR-IP: technical
specifications
Forwarding Rate 30,000 packets per second
Buffer 256 frames (maximum size — 1534 bytes)
Delay 1 frame
Configuration Telnet, through the 10BaseT interface
LAN Standard Conforms to IEEE 802.3
Data Rate 10 Mbps (20 Mbps for 10BaseT in full duplex mode)
Interface Type 10BaseT for use on UTP and STP media, terminated
in RJ-45 shielded 8-pin connector
Operation Mode Full duplex or half duplex user-selectable
WAN Protocols e PPP (PAP/CHAP)

e Frame Relay (RFC 1490)
e HDLC-like framing
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B.3 Physical Description

Figure B-2 shows the rear panels of ASMi-52 with the IR-IP interface module.

LINE LINE
EEmiss ™ Rk B A
Ell ALARM 12' 45" 2! 15
1234
A==l ©© U SETUP ERRQO | S | Q Act
10100 BASE-T CONTROL E1M1 SHDSL Rap

Figure B-2. IR-IP Ethernet Router
Table B-1 provides the pinout of the 10BaseT RJ-45 connector.

Table B-1. RJ-45 Pinout

Pin Name Function

1 D (+) Transmit data positive
2 D (-) Transmit data negative
3 RD (+) Receive data positive
6 RD (-) Receive data negative

IR-IP DIP Switch

IR-IP interface module contains a four-section DIP switch, used to configure the
basic operating parameters of the IP router. The switch is located on the ASMi-52
rear panel as shown in Figure B-2. Table B-2 lists the DIP switch functions.

Table B-2. IR-IP DIP Switch Functions

No Function Values Default
Setting

1 Enables IR-IP to learn its [P ON - IP address learning is enabled
OFF — IP address learning is disabled ~ OFF

Note: For details, see Assigning the Router LAN Interface Address on page B-7.

2 Selects the WAN protocol ON — PPP protocol

OFF — Frame Relay protocol OFF
3 Selects the LAN mode ON - Full duplex operation

OFF — Half duplex operation OFF
4 Controls the remote WAN test loopback, ON - The test loopback is activated

which returns packets received from the WAN

back toward the WAN OFF — The test loopback is disabled OFF

Note , i, . . . :
The switch can perform additional control functions, which are described below in

this appendix.

ASMi-52 Ver. 2.5 Physical Description B-3
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IR-IP LEDs

IR-IP contains three LEDs, which indicate the module activity. Table B-3 explains
the functions of the IR-IP interface indicators.
Table B-3. IR-IP Interface Indicators
LED Name Function Color
LINK Lights when the Ethernet interface is connected to an active Green
LAN
ACT Flashes when transmit and/or receive activity is present on the  Yellow
Ethernet interface
ERR Indicates erroneous events, such as collisions, buffer overflows, Red

etc. Also provides additional indications, described below in
this section

Normal Indications

B-4

The IP router card can start normal service only after it has been configured for
operation in the user’s network. To simplify the configuration procedure, when an
unconfigured IP router card is powered on, it enters the configuration mode.

Power-Up Indications for Unconfigured IP Router Card

LINK indicator  Lights steadily after power up when connected to an active
station (10BaseT only).

ERR indicator  Lights steadily for 12 to 15 seconds, until the card completes
software decompression.
After this interval, the ERR indicator starts flashing rapidly (about
3 times per second), to indicate that the card is in the
configuration mode.
Configuration instructions are described further in the appendix.

Power-Up Indications for Configured IP Router Card

LINK indicator  Lights steadily after power up when connected to an active
station (10BaseT only).

ERR indicator  After software decompression, turns off.

Indications during Normal Service

During normal service, the LINK indicator lights steadily, indicating LAN integrity.
The ACT indicator flashes in accordance with the Ethernet interface traffic.

The ERR indicator is normally off, however it may light momentarily from time to
time, to indicate an occasional buffer overflow. If the ERR indicator lights often,
the IP router configuration may have to be changed, e.g., it may need more main
link bandwidth.

Physical Description ASMi-52 Ver. 2.5
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B.4 IR-IP Management Subsystem

The IR-IP interface module management subsystem supports the following
functions:

e Preliminary configuration
e Configuration of management access parameters
e Advanced configuration of IR-IP parameters
e Collection and display of statistical performance data
e Maintenance functions, which include:
= Software downloading
= Resetting of various subsystems
= Display of error log
= Ping utility, for checking IP connectivity.

The management subsystem of the IR-IP interface module is a separate,
independent entity, and therefore it cannot be managed through the ASMi-52
management subsystem.

The communication with the IR-IP management subsystem is made through the
local LAN interface connector of the IR-IP module, designated 10BaseT, using the
Telnet protocol. Passwords can be used to prevent unauthorized access.

Accessing the IR-IP Management Subsystem

Note

ASMi-52 Ver. 2.5

The IR-IP interface module must be configured in accordance with the specific
requirements of the user’s application before it can be used in the user’s network.
As a result, it is not possible to supply default parameters to enable IR-IP to start
service without any preliminary configuration.

Therefore, to enable the user to establish Telnet communication and configure
IR-IP, IR-IP is delivered with a factory-default set of parameters. The factory-default
parameters are automatically used:

e Before the IP router is configured by the user, e.g., when a new ASMi-52 with
[R-IP interface module is put into operation

o After the user’s configuration parameters have been erased.

When the factory-default parameters are used, the ERR indicator located on the
ASMi-52 rear panel, near the IR-IP Ethernet interface connector flashes rapidly
(about three times per second).

The flashing of the ERR indicator also serves as a warning to the user that the IR-IP
WAN interface does not send, nor does it receive packets, and therefore IR-IP can
be accessed only from the LAN.

IR-IP Management Subsystem B-5
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After configuring IR-IP, it starts normal operation and routes the traffic in
accordance with the user-selected configuration parameters.

To change the parameters of an already-configured IR-IP, establish communication
from a Telnet host using the assigned IP address.

Default IP Communication Parameters

The factory-default IP communication parameters of the interface module are:

e The default IP address of the IR-IP Ethernet port is 192.168.205.1, and the
default IP subnet mask is 255.255.255.252.

e The port will accept IP communication only from the IP address
192.168.205.2. Therefore, as long as the factory defaults are in effect, you
must assign this address to the Telnet host used to configure IR-IP.

Using the IP learning mechanism, as explained below you can change the default
parameters.

Note In the default configuration, the IR-IP WAN interface is disabled. In order to enable
the WAN interface, you have to modify the Ethernet port address or the IP subnet
mask.

B.5 Performing Preliminary Configuration

The software necessary for performing all the management and configuration
functions is stored in the IR-IP interface module, and therefore you only need a
regular Telnet host to perform all the activities described in this appendix.

A Telnet host is any computer, e.g., an IBM PC or compatible that fulfills the
following minimum requirements:

e Astandard 10BaseT Ethernet interface

e A TCP/IP protocol stack, and therefore is capable of supporting IP
communication through the Ethernet interface

e Telnet client software

e A ping utility.

Outline of Preliminary Configuration
» To perform the preliminary configuration procedure:
1. Connect the Telnet host to the IR-IP interface module.

2. Configure the Telnet host to enable communication with the IR-IP interface
module using the default IP parameters.

3. Establish communication with IR-IP and assign the prescribed IP address to its
LAN interface.

4. Establish again communication with IR-IP and continue the preliminary
configuration in accordance with the Quick Setup section below.
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Connecting the Telnet Host

Before starting the management and configuration activities, it is necessary to
establish IP communication between your Telnet host and the IR-IP interface
module. For this purpose, it is necessary to provide a communication path.

Because of the method used to assign an IP address to IR-IP Ethernet port, it is
recommended to connect the Telnet host directly to the IP router 10BaseT
connector. This is made by connecting an Ethernet cross cable between the
Ethernet connector of the Telnet host and the IP router connector.

However, you may also connect through a common LAN: in this case, connect
your Telnet host and IR-IP to Ethernet hub ports using straight cables.

Preliminary Telnet Host Configuration

Note

You can use the IP learning mechanism to configure the IP. communication
parameters of the IR-IP LAN interface. In this case, skip to the Assigning the Router
LAN Interface Address section below.

If you prefer to use the factory-default parameters to establish [P communication
between your Telnet host and IR-IP, configure the Telnet host as follows:

1. Temporarily configure the host IP address as 192.168.205.2.
2. The initial destination IP address to be used by the host is 192.168.205.1.

The first step in the preliminary configuration process is to assign the desired IP
address to the LAN interface of the IR-IP interface module.

After an IP address is assigned and saved, you must change the destination IP
address of the Telnet host to the new address, otherwise it is not possible to
continue the configuration process. At the same time, you can also change the
temporary IP address assigned to the host (192.168.205.2) back to its permanent
address.

Assigning the Router LAN Interface Address

ASMi-52 Ver. 2.5

The IP address of the IR-IP LAN interface must be configured as part of the
preliminary configuration process. To simplify this process, IR-IP includes a simple
and convenient IP address learning mechanism.

The IP address can be configured and changed at any time, even after the
complete IR-IP configuration process has been performed, because it does not
affect other configuration parameters. Moreover, the IP subnet mask is
automatically adapted to the new IP address.

IP Learning Mechanism

To simplify the configuration process, IR-IP has a special mechanism for
configuring the IP address of its LAN interface. Setting section 1, called IP address
learning, of the IR-IP DIP switch (see Table B-2) to ON enables this mechanism.

The IP learning mechanism enables IR-IP to learn its LAN interface IP address by
receiving frames sent by a ping utility to the prescribed LAN IP address.
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B-8

Note

To use the IP learning mechanism, you do not need to know the current address of
IR-IP LAN interface, but only the prescribed IP address.

The IP address is actually retrieved from the ARP frames sent during pinging to
locate the ping destination, not from the ping frames.

To ensure that the process is correctly performed, it is recommended to check the
contents of the ARP table before starting the ping utility, to make sure that it does
not contain the address to be assigned to the IP router LAN interface.

To view and edit the ARP table contents:

If the Telnet host you are using runs under Microsoft Inc. Windows™ 95, 98 or
NT, use the following procedure to view and edit the ARP table contents:

1. Display the table using the arp -a command.

2. If the table includes the intended IP address, remove it from the table using
the arp -d command.

If for some reason the IP learning process does not succeed, before repeating it,
make sure to remove the IP address from the table.

Assigning a LAN IP Address to a New IR-IP

The following procedure enables you to configure the LAN [P address of a new
IR-IP router, i.e., a router using the default parameters (see the Accessing the IR-IP
Management Subsystem section above).

If ASMi-52 is already operating, skip Step 2 in the following procedure.
To configure the IP router LAN address:

1. Make sure the preparations described above have been completed, including
the configuration of the ping utility.

2. Turn ASMi-52 on and monitor the IP router indicators:
= The LINK indicator turns on

» The ERR indicator lights steadily for approx. 15 seconds, and then starts
flashing at a rapid rate (about three times per second).

If the ERR indicator turns off, skip to the section below.

3. Setsection 1 of IR-IP DIP switch to ON.
The ERR indicator starts flashing faster (approximately four times a second).

4. Send a ping to the new address to be used by IR-IP. A confirmation should be
received after the third ping: after the confirmation, the flashing will slow
down to approximately twice a second.

If your host does not begin to receive ping replies after three unsuccessful
attempts, skip to the section below.

5. Return section 1 of the IR-IP DIP switch to the OFF position.
The ERR indicator must turn off.
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At this stage, the communication with IR-IP router is lost, because its IP address
has been changed. Therefore, you must reconfigure the destination IP address of
the Telnet host. If you wish, you may also change the temporary IP address
assigned to the host (192.168.205.2) back to its permanent address.

Changing the LAN IP Address of a Configured IR-IP

The LAN IP address of an already-configured IR-IP can be changed while it
operates. This means it is not necessary to turn ASMi-52 off before starting the
configuration procedure. Note however that the IP traffic flow through IR-IP will
be disrupted until the other stations in the IP network learn the new address.

To change the LAN IP address of an already-configured IR-IP, use the procedure
described above for a new IR-IP with the following differences:

e Configure the destination address of the ping utility to the new LAN interface
[P address. It is not necessary to change the Telnet host source address.

e When ready, set section 1 of the IR-IP DIP switch to ON.
e The ERR indicator starts flashing faster (approximately four times a second).

e Perform steps 4, 5 of the procedure used for a new IR-IP.

B.6 IR-IP Management Utility

General Operating Procedures

Note

ASMi-52 Ver. 2.5

The IR-IP interface module is managed via a simple, menu-driven utility that uses a
basic terminal user interface. A typical screen is shown in Figure B-3.

As seen in Figure B-3, each screen has a header that identifies the device being
configured and its logical name, assigned by the user, followed by the running
software revision and date. The bottom line of the screen displays prompts that
guide you in the execution of the various activities.

Use the following general procedures to perform the desired activity:
e To change a parameter or to select a menu item, type the corresponding line
number.

e For a parameter, which has a discrete set of values, the parameter values are
enclosed in brackets [ ]. To select a new value, press the spacebar to scroll
among the available values until the desired value is displayed, and then press
<Enter> to select the displayed value.

e To enter a value which requires free text entry, type in the desired string and
then press <Enter>. Use backspace to erase the current string.

o After all the parameters have been selected, a prompt appears, requesting that
you confirm the changes.

For proper display of the screens, you must:

e Select a fixed-pitch system font for the display. Use your operating system
documentation to find how to select a proper font.

e Configure the Telnet utility to use VT-100 terminal emulation.
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The management utility is started automatically when Telnet communication is
established. If password protection is enabled (see the Defining Management
Access section below), you will be prompted to enter the Telnet password. The
opening screen, which appears after the Telnet session activation, is the IR-IP Main
menu (see fFigure B-3).

IR IP

1. Quick Setup

2. Management Access
3. Advanced Setup

4. Device Control

5. View

6. Diagnostic Tool

<IR-IP>

(PING terminal)

Press one of the numbers to select or ESC:

S/W Ver. 1.21

(date)

Figure B-3. IR-IP Main Menu

To end the utility, press <Esc> when the Main menu is displayed. This will also
end the Telnet session.

Menu Structure of Management Utility

Figure B-4 shows the menu structure of the IR-IP management utility.

Main Menu

1. Quick Se!up|— 2 Il\.ccess t 3.Ad d Setup 4. Device Control

6. Diagnostic Tool

5. View

PING Terminal

1.Telenet Password

2. Telenet Activity Timeout
3. SNMP Access

—14. SNMP Read Community
5. SNMP Write Community
6. SNMP Trap Community

7. SNMP Management Table

[
PNOORON S

LAN IP Address

LAN IP Mask

WAN IP Address

WAN IP Mask

Default Gateway

DHCP Server IP Address

Read Protocol From DIP Switches
Protocol

B-10

1. Device Identification
1. Device Name
2. Contact Person B
3. System Location

1. New Software Download
1. Server IP Address
2. File Name
3. Total Timeout

4. Start Operation

1. Configuration and Connection

g

Interface P:
1. LAN Status

H 2. WAN Status
3. WAN Throttle
4. Aging Timeout

2. View Error Log

3. Erase Configuration

w

. Protocol Parameters (FR)
1. Self Learn
2. Maintenance Protocol
3.DLCI

4. Resets
1. Reset Device
2. Reset LAN

4.CIR

3. Reset WAN

5. EIR

ol

Protocol Parameters (PPP)

2. Protocol Field Compression
3. Authentication Protocol

H 4. Security Host/Guest

5. User Name To Send

6. Password To Send

7. User Name To Accept

8. Password To Accept

1. Header and Control Field Compression

4. Multicast

L 1. Multicast Forwarding
2. Static Groups

2. ARP Tables
~| 3. Multicast Groups Table
4. Statistics

1. Ping IP Address
L 2. Start Pinging
3. Stop Pinging

Figure B-4. Management Utility, Menu Structure

IR-IP Management Utility
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B.7 Quick Setup Guide
The Quick Setup menu is used to select the main parameters’ values that must be
defined before you start using IR-IP.

Use the Advanced Setup menu (see the Advanced Setup section below) to specify
values for other IR-IP configuration parameters not included in this menu.

» To perform quick setup:

1. From the Main menu, type 1.
The Quick Setup menu appears (Figure B-5).

IR IP <IR-IP> S/W Ver. 1.21 (date)
Quick Setup

1. LAN IP Address :192.168.100.001
2. LAN IP Mask :255.255.255.000
3. WAN IP Address (empty for unnumbered) S
4. WAN IP Mask (empty for unnumbered) S
5. Default Gateway (empty - WAN interface) D e e e e
6. DHCP Server IP address (empty for relay disabled) S
7. Read Protocol From DIP Switches [ Yes ]

8. Protocol :[ Frame Relay ]

Press one of the numbers to select or ESC:

Figure B-5. Quick Setup Menu

2. Enter addresses for LAN IP, LAN IP Mask, WAN IP, WAN IP mask, default
gateway and DHCP server.

LAN IP Address — The LAN IP address for the IP router LAN interface, is the address to
which nodes connected to the local LAN send packets that are addressed
to the WAN.

LAN IP Mask — Used to enter the IP subnet mask. The IP router supports a maximum of
254 hosts on the LAN, therefore you must use Class C subnet masks. The
basic subnet IP mask for Class C addresses, which supports the maximum
possible number of hosts, 254, is 255.255.255.0. To help you understand
the selection of IP subnet masks, Figure B-6 provides a configuration
example for a LAN with 6 nodes: the IP subnet mask for a 6-node IP
network is 255.255.255.248.

ASMi-52 with IR-IP

o

LAN IP Address: 192.168.1.2
Mask: 255.255.255.248

[
IP Address 192.168.1.2 . . . .
Mask 255.255.255.248 .248 .248 .248 .248
Default Gateway 192.168.1.1 192.168.1.1 192.168.1.1 192.168.1.1 192.168.1.1

Figure B-6. Selecting the IP Subnet Mask
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WAN IP Address — Used to enter the IP address for the IR-IP WAN interface, i.e., the IP

address to be used by IP hosts on the WAN to reach this IR-IP interface
module.

If the WAN IP Address field remains blank, IR-IP operates in the
Unnumbered Router Mode.

WAN IP Mask — Used to enter the IP subnet mask for the WAN interface.

Default Gateway:

Operation without Default Gateway

The IP interface module is intended to enable the extension of LANs
through the

ASMi-52 link. Therefore, its default routing operation is different from the
default routing operation of standard IP routers:

= |R-IP forwards packets with destinations not located on the local LAN
through the WAN interface

" Packets received from the WAN interface and destined to hosts

located on the local LAN are forwarded to the LAN; other packets are
discarded.

The default operation is used when the Default Gateway field is blank.
Operation with Default Gateway

You can instruct IR-IP to send packets with destinations not located on the
local LAN to a specific router, which is called the default gateway. The
default gateway must be connected to the local LAN.

To use this option, enter the IP address of another router attached to the
local LAN in the Default Gateway field.

Note |t is very important to obtain the correct parameters from the system administrator
or ISP. The most common problem when establishing an IP connection is incorrect
configuration of IP parameters and default gateway. Do not try to guess these

parameters.

DHCP Relay — IR-IP can operate as a DHCP relay for computers on its LAN. In this

Quick Setup Guide

mode, the user does not need to configure the IP addresses and other
related parameters for the PCs on the LAN: they receive the configuration
from the DHCP server via the IR-IP module.
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Note

ASMi-52 Ver. 2.5

N\

r
QP Network

) O,

DHCP Server

Do)

ASMi-52 with IR-IP
LAN IP Address: 192.168.1.2

Mask: 255.255.255.248

Figure B-7. Selecting the IP Subnet Mask

Leaving the DHCP Server IP Address field blank disables the DHCP relay.

3. Set the protocol requirements.
Reading Protocol from DIP Switches —

Selecting YES for this parameter (Quick Start Menu) forces IR-IP router
card to use the WAN protocol selected by section 2 of its DIP switch: PPP
or Frame Relay.

If you want to be able to select the WAN protocol by means of the
Protocol field (parameter 7) of the Quick Setup menu, select NO.

Protocol - Used to select the WAN protocol to be used by the IP router card: PPP,
HDLC or Frame Relay.

This parameter is available only if the Read Protocol from DIP Switches
parameter is set to NO.
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>

B.8 Defining Management Access
The Management Access menu is used to enable the use of passwords to protect
the access to IR-IP management utility, and control the inactivity time-out interval.

When password protection is enabled, a Telnet management session can start only
after the correct password is entered.

To access the Management Access menu:

e From the Main menu, type 2.

The Management Access menu appears (Figure B-8).

IR TP <IR-IP> S/W Ver. 1.21 (date)
Quick Setup
Management Access

1. Telnet Password S

2. Telnet Inactivity Timeout (min) :300..

3. SNMP Access :Disabled

4. SNMP Read Community :public....

5. SNMP Write Community :public....

6. SNMP Trap Community :public....

7. SNMP Management Table >>>

Press one of the numbers to select or ESC:

Note

Figure B-8. Management Access Menu

Since the IP router card does not support SNMP management, the SNMP Read
Community, SNMP Write Community, SNMP Trap Community, and SNMP
Management Table parameters are not used.

Defining a Telnet Password

By default, management access to IR-IP via Telnet is unrestricted. To restrict
access, enter a Telnet password by selecting 1 in the Management Access menu.
The password can include up to 10 characters, and is case-sensitive. The next time
a Telnet session is opened, a password must be entered to enable you to access
the IR-IP menus.

At any time, only one Telnet connection to IR-IP is permitted. Any attempt to
open an additional connection while the current session is open is rejected.

Setting Telnet Inactivity Timeout

This parameter specifies the time a Telnet session is kept open when there is no
keyboard activity. When the specified time-out expires, the Telnet session is closed
and another user can access IR-IP.
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B.9 Advanced Setup
The Advanced Setup menu is used to select the desired group of IR-IP
configuration parameters.

The parameters accessed through Advanced Setup menu supplement the
parameters available on the Quick Setup screen, by providing control over all the
other IR-IP parameters.

» To perform advanced setup:

e From the Main menu, press 3.

The Advanced Setup menu appears (Figure B-9).

IR TP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access

Advanced Setup

1. Device identification
2. Interface Parameters
3. Protocol Parameters
4. Multicast IP

Press one of the numbers to select or ESC:

Figure B-9. Advanced Setup Menu

Defining the Device Identification

The Device Identification menu is used to define and store in the IR-IP logistic
information: the logical name of IR-IP, information on the contact person and
device location.

» To define the device identification:

1. From the Advanced Setup menu, type 1.
The Device Identification menu appears.

2. Assign a device name for identification by the system manager (up to eight
characters). The assigned name is displayed in the screen header.

3. Enter the name of the person to be contacted with matters pertaining to this
equipment unit.

4. Enter the physical location of the device.

Defining the Interface Parameters

The Interface Parameters menu is used to control the operation of IR-IP interfaces.
» To define the Interface Parameters:

1. From the Advanced Setup menu, type 2.

The Interface Parameters menu appears (Figure B-10).
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IR TP <IR-IP> S/W Ver. 1.21 (date)
Quick Setup

Management Access

Advanced Setup

Device identification

Interface Parameters

1. LAN Status [
2. WAN Status [
3. WAN Throttle :[ Full ]
4 5

. Aging Timeout (min)

Press one of the numbers to select or ESC:

Figure B-10. Interface Parameters Menu

2. Set the LAN status to enable/disable the flow of packets through LAN interface:
= Open - the flow of packets is enabled.

» Closed - the flow of packets is disabled. As a result, IR-IP does not accept,
nor sends packets to the LAN, but its WAN interface may still be active, and
can interact with other IP hosts on the WAN.

3. Set the WAN status to enable/disable the flow of packets through the WAN
interface:

= Open - the flow of packets is enabled.

* Closed — the flow of packets through the WAN interface is disabled. As a
result, IR-IP does not accept from, nor sends packets to the WAN.
However, the LAN interface of the IP router is still active.

4. Select the WAN Throttle. This is the maximum data rate at which frames are
sent to the WAN (i.e., to the SHDSL link).

The available selections are:
= 64 kbps

= 128 kbps
= 256 kbps
= 512 kbps
= 1024 kbps

= Full (no restriction on the rate).

Since the IP router buffers have a limited capacity (256 frames), it is
recommended to select the WAN Throttle parameter in accordance with the
line rate.

5. Specify the Aging Timeout. This is the time after which inactive LAN stations
are removed from the IR-IP ARP table.

A station is defined as inactive when no IP traffic is received from it by the
[R-IP LAN interface.

B-16 Advanced Setup ASMi-52 Ver. 2.5



Installation and Operation Manual Appendix B IR-IP Interface Module

Defining the WAN Protocol Parameters

Frame Relay Protocol

The Frame Relay Protocol Parameters menu is used to configure the parameters
Frame Relay WAN for protocol (the WAN protocol is selected by means of the
Quick Setup ) in Figure B-5.

» To define the Frame Relay protocol parameters:

1. From the Advanced Setup menu, type 3. (A typical Frame Relay Protocol
Parameters menu is shown in Figure B-11.)

2. Specify the Self Learn for the Frame Relay DLCI and maintenance protocol
= ENABLED = learned automatically
= DISABLED = manually entered

3. If the Self Learn parameter is DISABLED, specify the Maintenance Protocol

4. If the Self Learn parameter is DISABLED, specify the DLCI used for exchanging
maintenance protocol messages.

5. Specify the CIR. This is the maximum amount of data, in bits, which the Frame
Relay network guarantees to transfer during the measurement interval (the
measurement interval is usually one second).

The value of this parameter is obtained from your Frame Relay service
provider.

6. Specify the EIR. This is the maximum amount of data, in bits, that the Frame
Relay network will attempt to deliver during the measurement interval. The
value of this parameter is obtained from the Frame Relay service provider.

IR _IP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup

Device identification
Interface Parameters

Protocol Parameters

1. Self Learn [ Enabled ]

2. Maintenance Protocol :[ ANSI T1.617 ANNEX D ]
3. DLCI (0-None) 0

4. CIR 0. ...

5. EIR :64000. ..

Press one of the numbers to select or ESC:

Figure B-11. Frame Relay Protocol Parameters Menu
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PPP Protocol Menu

The PPP Protocol Parameters menu is used to configure the parameters PPP WAN
for protocol (the WAN protocol is selected by means of the (the WAN protocol is
selected by means of the Quick Setup ) in Figure B-5.

To define the PPP Protocol Parameters:

1.

From the Advanced Setup menu, type 3. A typical PPP Protocol Parameters
menu is shown in Figure B-12.

Define the use of Header and Control Field Compression type according to
RFC 1661. It is strongly recommended that this compression be used for
troubleshooting only.

Define the use of Protocol Field Compression type according to RFC 1661. It
is recommended that this compression be used for troubleshooting only.

Select the Authentication Protocol used by an IP router configured as host to
validate incoming connections.

Configure the IP router Security Host/Guest parameter.
= Cuest unit, to be authenticated by another router

= Host unit, that authenticates other routers.

Define the User Name To Send. An IP router card configured as guest
identifies itself by this name.

Define the Password To Send. The password by which an IP router card
configured as guest identifies itself.

Specify the User Name to Accept, by an IP router configured as host, when an
incoming connection request is received.

Specify the user password to be accepted by an IP router configured as host,
when an incoming connection request is received.

IR IP

Quick Setup
Management Access
Advanced Setup

O J o U b WD

<IR-IP> S/W Ver. 1.21 (date)

Device identification
Interface Parameters
Protocol Parameters

Header and Control Field Compression :[ No ]
Protocol Field Compression: :[ No ]
Authentication Protocol : [ NONE/NONE ]
Security Host / Guest :[ Guest ]

User Name To Send S
Password To Send S
User Name To Accept e e e
Password To Accept T

Press one of the numbers to select or ESC:

B-18

Figure B-12. PPP Protocol Parameters Menu
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Defining the Multicast Parameters

The Multicast IP menu is used to specify the IP multicast frame forwarding
parameters, and to access the static multicast groups’ table.

» To define the Multicast Parameters:

1. From the Advanced Setup menu, press 4.
The Multicast IP menu appears (Figure B-13).

IR IP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup

Device identification
Interface Parameters
Protocol Parameters
Multicast IP

1. Multicast forwarding : [ Disable ]
2. Static groups >>>

Press one of the numbers to select or ESC:

Figure B-13. Multicast IP Menu

2. Specify the Multicast Forwarding. Used to control the forwarding of IP
multicast frames. The following selections are available:

= DISABLED - Disables multicast forwarding in both directions.

= LAN to WAN - Enables forwarding of IP multicast frames addressed to
groups appearing in the Static Multicast Groups table, from the LAN to the
WAN.

= WAN to LAN - Enables forwarding of IP multicast frames addressed to
groups appearing in the Static Multicast Groups table, from the WAN to the
LAN.

= BIDIRECTIONAL - Enables forwarding of IP multicast frames addressed to
groups appearing in the Static Multicast Groups table, in both directions.

= WAN to LAN + IGMP — Enables forwarding of IP multicast frames
addressed to groups appearing in the Static Multicast Groups table, from
the WAN to the LAN. In addition, more groups can be added dynamically
(the additional can be viewed using the View menu — Figure B-18).

= TRANSPARENT - All the IP multicast frames are forwarded, irrespective of
the Static Multicast Groups table.

3. Select Static Groups to access the static multicast groups table. The table is
used to specify the IP addresses for up to 10 IP multicast groups.

ASMi-52 Ver. 2.5 Advanced Setup B-19



Appendix B IR-IP Interface Module Installation and Operation Manual

» To access the Static Groups menu:

1. From the Multicast IP menu, type 2.

The following screen appears:

IR IP <IR-IP> S/W Ver. 1.21 (date)

Static Multicast Groups Table

R O 00 J o U wWw N

Press 'A'-add, 'E'-edit, 'D'-delete, 'C'-clear all, 'ESC'-exit:

Figure B-14. Static Multicast Groups Table
2. Add, change, or delete IP addresses in the table (see the prompt line).

B.10  Using the Device Control Menu

The Device Control menu is used to download software from TFTP servers and
perform interface and device resets.

» To access the Device Control menu:
e From the Main menu, type 4.

The Device Control menu appears (Figure B-15).

IR IP <IR-IP> S/W Ver. 1.21 (date)
Quick Setup

Management Access

Advanced Setup

Device Control

New Software Download

1

2. View error LOG

3. Erase configuration
4

Resets

Press one of the numbers to select or ESC:

Figure B-15. Device Control Menu
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Downloading New Software

IR-IP operates as a TFTP client, and therefore it is possible to update its software
by downloading new software from another computer that operates as a TFTP
server.

The New Software Download menu is used to specify the software downloading
parameters.

» To download new software:

1. From the Device Control submenu, type 1.
New Software Download menu appears (Figure B-16).

IR TP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup
Device Control

Server IP Address S

1
2. File Name D e e e e e et e
3. Total Timeout (sec)

4

Start operation >>>

Press one of the numbers to select or ESC:

Figure B-16. New Software Download Menu

2. Define the Server IP Address of the TFTP server.

3. Enter the File Name and path of the file to be transferred from the TFTP
server.

4. Enter the Total Timeout time the IP router should wait for an
acknowledgment from the TFTP server, for example 60 seconds.

5. After defining all the necessary parameters, select Start Operation on the New
Software Download screen and then press <Enter> to start the downloading.

You can follow the progress of the downloading process (indicated by arrows).

Upon completion of the download process, the unit performs a reset. The Telnet
connection is lost and must be restarted if required.

Viewing the Error Log

This item of the Device Control submenu is used to view the error log file. This file
logs errors detected in IR-IP for debug and technical support purposes.
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Erasing Configuration

Selecting Erase Configuration allows you to reset all the configuration parameters
to their default values.

Note e Do this only if you need to reconfigure the module anew (all the parameters).
e After erase confirmation all connections with the IR-IP module will be lost. For
instructions on further configuration, refer to Performing Preliminary
Configuration on page B-6.

Resetting IR-IP

The Reset menu allows you to perform reset of IR-IP, or its interfaces.

This operation can be used to restore normal operation after service is disrupted
by an abnormal condition. Any data stored in the IR-IP buffers is discarded, and
the flow of traffic is temporarily interrupted.

IR IP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup
Device Control

New Software Download
View error LOG

Resets

1. Reset Device
2. Reset LAN
3. Reset WAN

Press one of the numbers to select or ESC:

Figure B-17. Resets Menu

» To restart IR-IP:

e From the Device Control menu, select Resets. From the Resets menu, type 1.

You will be prompted to confirm the reset operation.

Note  Resetting the device will restart the IR-IP interface module, and therefore traffic flow
is temporarily interrupted, and the Telnet connection is lost.

Reset LAN

» To reset the LAN interface:
e From the Resets menu, select Reset LAN.

You will be prompted to confirm the reset operation.
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This operation restarts the IR-IP LAN controller.
To continue your Telnet session, press any key within 15 seconds following the
confirmation of the reset operation.

Note

Reset WAN

» To reset the WAN interface:
e From the Resets menu, select Reset WAN.

You will be prompted to confirm the reset operation.

Note  Resetting the WAN interface causes the WAN controller to be restarted. This results
in renegotiation of the WAN protocol parameters.
To continue your Telnet session, press any key within 15 seconds following the
confirmation of the reset operation.

B.11 Viewing IR-IP configuration Data

The View menu is used to view the IR-IP configuration data, and display
information on its ARP tables, multicast Groups tables and statistics.

» To view the IR-IP configuration data:

e From the Main menu, select View.

The View menu appears (Figure B-18).

IR _IP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup
Device Control
View

1. Configuration and Connection
2. ARP Tables

3. Multicast Groups Table

4. Statistics

Press one of the numbers to select or ESC:

Figure B-18. View Menu

Viewing Configuration and Connection

This screen is used to view the configuration parameters of IR-IP. In addition, you
can also view the current status of the LAN and WAN interface.

» To access the Configuration and Connection screen:
e From the View menu, select Configuration and Connection.

The View Configuration screen appears (Figure B-19).
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IR TP <IR-IP> S/W Ver. 1.21 (date)
VIEW CONFIGURATION

BOOT Version: 1.06 18.03.1999

Device Name: IP router card

System Location: The location of this device

Contact Person: Name of contact Person

MAC Address: 00-20-D2-16-3F-9B

Default Gateway: WAN

Intrf Type Baud (kbps) Prot IP Address IP Mask Status
LAN UuTp @ -—————- Ethr 192.168.205.005 255.255.255.000 Connected
WAN V.110 FR Not Conn.

Press any key to continue:

Figure B-19. View Configuration Screen

Viewing the ARP Tables

This screen is used to display the IR-IP ARP table. This table shows the IP address

assigned to each station on the LAN (the stations are identified by their MAC
addresses).

» To access the ARP Tables screen:

e From the View menu, select ARP Tables.

The ARP Tables screen appears (Figure B-20).

IR IP <IR-IP> S/W Ver. 1.21 (date)
ARP Table
IP Address MAC Address IP Address MAC Address
192.168.205.003 00-40-33-20-C8-3C
Press any key for exit

Figure B-20. ARP Tables Screen

Viewing the Multicast Groups Table

This screen is used to display information about the multicast group IP addresses

and their status.

» To access the multicast groups table screen:
¢ In the View menu, select Multicast Groups Table.

The Multicast Groups Table screen appears (Figure B-21).
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IR TP <IR-IP> S/W Ver. 1.21 (date)

Multicast Groups Table

Group IP Address Status Group IP Address Status

Press any key for exit

Figure B-21. Multicast Groups Table Screen

Viewing the Statistics Screen

The Statistics screen is used to display statistical information on the traffic between
the networks connected by IR-IP. The data displayed on this screen enables you to
evaluate the IR-IP performance. Two different Statistics screens are used, one for
the LAN side and the other for the WAN side.

» To access the Statistics menu:

e In the View menu, select Statistics.

The LAN and WAN Statistics screens appear (Figure B-22 and Figure B-23).

IR TP <IR-IP> S/W Ver. 1.21 (date)
SYSTEM STATISTICS

Counter Name vVal Counter Name vVal
LAN in Octets 83504 LAN IP Header Errors 0
LAN Unicast Frames In 1 LAN IP Address Errors 0
LAN Non-Unicast Frames In 9 LAN Alignment Errors 0
LAN Out Octets 83504 LAN CRC Errors 0
LAN Unicast Frames Out 3560 LAN Single Collisions 0
LAN Non-Unicast Frames Out 0 LAN Multiple Collisions 0
LAN to WAN Frames Passed 1698 LAN Late Collisions 0
LAN IP Datagram Received 2638 LAN Excessive Collisions 0
LAN to CPU Frames Discarded 0 LAN Frames Too Long Errors 0
LAN to WAN Frames Discarded 0 LAN RX FIFO Overrun Error 0
LAN Out Errors 0 LAN SQE Transmitted 0
LAN RX Frames Errors 0 LAN Deferred Frames 1
LAN MAC Receive Errors 0 LAN Carrier Sense Lost 0
LAN MAC TX Errors 0 LAN FIFO Underrun 0

N - Next Screen. ESC - Back To Previous Menu.

R - Refresh Page. C - Clear The Counters Of This Page.

Figure B-22. LAN Statistics Screen
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IR TP <IR-IP> S/W Ver. 1.21 (date)
SYSTEM STATISTICS

Counter Name Val Counter Name Val
WAN in Octets 83504 WAN Alignment Errors 0
WAN Out Octets 1950 WAN Aborted Frames 0
WAN Out Frames 1723 WAN Short Frames 0
WAN to LAN Frames Transfer 1698 WAN RX FIFO Overrun Error O
WAN IP Datagram Received 1723 WAN to CPU Frames Errors 0
WAN to CPU Discarded 0 WAN Frame Too Long Errors O
WAN to LAN Discarded 0 WAN IP Header Errors 0
WAN Out Errors 0 WAN IP Address Errors 0
WAN CRC Errors 0
PPP Address Error 0
PPP Control Error 0
DLCI Unrecognized Error 0
Frame Relay Forward Conge 0
Frame Relay Backward Conge 0

P - Previous Screen. ESC - Back To Previous Menu.

R - Refresh Page. C - Clear The Counters Of This Page.

Figure B-23. WAN Statistics Screen

B.12  Using Diagnostic Tools (Ping Terminal)

This section provides information on the diagnostic tool provided with IR-IP (the
ping utility).
» To access the Diagnostic Tools menu:

e In the Main menu, select Diagnostic Tool.

The Diagnostic Tools menu appears (Figure B-24).

View

IR IP

Diagnostic Tools

<IR-IP> S/W Ver. 1.21 (date)

Quick Setup
Management Access
Advanced Setup
Device Control

(PING terminal)

Ping IP Address
Start Pinging

:192.168.100.011
1 >>>

Stop Pinging >>>

Press one of the numbers to select or ESC:

B-26

Figure B-24. Diagnostic Tools Menu

Using Diagnostic Tools (Ping Terminal) ASMi-52 Ver. 2.5




Installation and Operation Manual Appendix B IR-IP Interface Module

Using the Ping Function
The Ping option is used to confirm IP connectivity by pinging other IP hosts.
Connectivity is confirmed by receiving a reply from the remote (pinged) IP host.
» To ping a host:
1. From the Diagnostic Tools menu, type 1 and enter the desired host IP address.

2. Press <Enter> to confirm the destination IP address.

3. To start pinging, type 2 on the Diagnostic Tools screen.

After pinging starts, you can monitor the ping status. A typical screen is
shown in Figure B-25.

Note  After pinging is started, it continues in the background even if you exit the
Diagnostics Tools screen. In this case, a Ping Running message appears in the top
upper left-hand corner of the screen.

4. To stop pinging, type 3 from the Diagnostic Tools menu.

A Ping Stopped message is displayed.
To clear the message and return to the Diagnostic Tools screen, press any

key.

IR _IP <IR-IP> S/W Ver. 1.21 (date)

Quick Setup

Management Access

Advanced Setup

Device Control

View

Diagnostic Tools (PING terminal)

Ping IP Address :192.168.100.011
Start Pinging >>>
Stop Pinging >>>

Pinging 192.168.212.001 Sent 27 Recvd 25 Lost 2 Resp.Time 60 ms

Press one of the numbers to select or ESC:

Figure B-25. Diagnostic Tools Menu after Receiving Pinging Response
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Note

B.13 Erasing User’s Configuration

The user-defined configuration parameters are stored in the IP router card flash
memory. After the user-defined configuration parameters are erased, the IP router
card automatically loads the default parameters.

You may want to erase the current configuration parameters:
e Before IR-IP is prepared for operation in a new application.

e When you cannot configure IR-IP because its current LAN-interface IP address
and/or the Telnet password, are not known.

To erase the user’s configuration:
1. Turn ASMi-52 off.
2. Set all the four sections of the IR-IP DIP switch (see Table B-2) to ON.

3. Turn ASMi-52 on and monitor the ERR and LINK indicators: they must blink
alternately.

4. While ERR and LINK are blinking (within 15 seconds), set sections 1 and 2 of
the DIP switch to OFF.

The IP router configuration is erased. During the process of erasing, the
ERR indicator turns on and lights steadily.

If you do not set sections 1 and 2 to OFF within 15 seconds of power-up, the IP
router card ignores the setting of all the four sections to ON and starts normal
operation. In this case, it is recommended to turn ASMi-52 off and then back on.
To abort the whole operation, turn ASMi-52 off, return all the four-switch section to
the desired positions, and then turn ASMi-52 on again.

5. Turn ASMi-52 off, and then return all the four sections of the DIP switch to the
desired positions.

B.14  Erasing IR-IP Software

You may erase the IR-IP application software, without erasing the user-defined
parameters.

After the application software is erased, IR-IP starts its TFTP server application, and
waits for the downloading of software by a TFTP client connected to its LAN
interface. The procedure to be used to download the application software in this
case is also described below.

You may want to erase the application software if the downloading of new
software using the Device Control menu (see Figure B-15) fails, and the IP router
card does not function properly.
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Erasing Application Software

» To erase the application software:

Note

1. Turn ASMi-52 off.
2. Set all the four sections of IR-IP DIP switch to ON.

3. Turn ASMi-52 on and monitor the ERR and LINK indicators: they must blink
alternately.

4. While ERR and LINK are blinking (within 15 seconds), set sections 3 and 4 of
the DIP switch to OFF.

The IP router application software is erased. During the process of erasing,
the ERR indicator turns on and lights steadily.

If you do not set sections 3 and 4 to OFF within 15 seconds of power-up, IR-IP
ignores the setting of all the four sections to ON and starts normal operation. In this
case, it is recommended to turn ASMi-52 off and then back on.

Alternately, to abort the whole operation, turn ASMi-52 off, return all the four
switches to the desired positions, and then turn ASMi-52 on again.

5. Turn ASMi-52 off, and then return all the four sections of the DIP switch to the
desired positions.

Downloading New Software

ASMi-52 Ver. 2.5

After erasing the application software, you can download new software from any
computer that can serve as a TFTP client.

To enable the downloading, IR-IP automatically activates its TFTP server
application with the following factory-default IP parameters:

e [P address: 192.168.205.1
e Subnet mask: 255.255.255.252.

Connect the computer serving as a TFTP client to the IR-IP TOBASE-T connector in
the way as a Telnet host used for preliminary configuration (see the Performing
Preliminary Configuration section). The computer IP parameters must be
configured as follows:

e |P address 192.168.205.2
e Subnet mask 255.255.255.252
e Default gateway  192.168.205.1

To download new software:

1. If necessary, turn ASMi-52 off.

2. Set all the four sections of the IR-IP DIP switch to OFF.
3. Turn ASMi-52 on.
4

Connect the computer to the IP router LAN interface (for the 10BaseT version,
verify that the LINK indicator lights steadily) and configure its IP parameters as
explained above.
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B-30

Note

5. Run astandard TFTP client application on the Telnet host, and download the
appropriate software file.

= If the download is successful, IR-IP starts using the new software.

= |f the downloading fails, repeat the download process.

B.15 IR-IP Troubleshooting

What if the LINK indicator (10BaseT version) does not light immediately after
ASMi-52 is turned on?

The IR-IP interface module does not receive power from the ASMi-52 power
supply. Service is required.

After the power-up process ends, the LINK indicator shows LAN integrity. It may
stay turned off without indicating power supply failure.

What if the ERR indicator does not light immediately after ASMi-52 is turned
on?
IR-IP is faulty and must be replaced.

What if the ERR indicator lights for 15 seconds after turning it on and then
turns off. ACT lights from time to time, but there is no response from IR-1P?

One of the following:

No software loaded into IR-IP. Download software.

IR-IP has been configured. If you do not know the current IP address of the LAN
interface, erase IR-IP router configuration using the procedure given in the
section below.

What if there are no ping replies from IR-1P?

If your host does not begin to receive ping replies after three unsuccessful
attempts, check the physical connection path between the Telnet host Ethernet
interface and the IR-IP T0BaseT connector.

What to do if the IP learning process is not successful?
Check that the prescribed IP address does not appear in the ARP table.
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Easy Config Device

This appendix describes the Easy Config hand-held device intended for ASMi-52
configuration via the V.24 (RS-232) control port, eliminating the need for an ASCII
terminal. Using the Easy Config, the local user can perform the same configuration,
monitoring and diagnostic functions that are available from an ASCII terminal.

C.1  Physical Description

The Easy Config is a portable DC-powered device. Figure C-1 illustrates a 3D view
of the Easy Config with its front panel elements identified.

SWDC Jack

Cantral Port Pawver Switch

LED Scresn

ESC Buttan ENTER Buttan

Scroll Right Button

Scroll Crowen Bulton

Figure C-1. Easy Config, 3D View

C.2 Technical Specifications

LCD Screen Two rows, 16 alphanumeric characters each
Control Port D-type, 9-pin, male

Buttons Escape, Scroll Down, Scroll Right, Enter
Power e 5VDC, 1A via external AC/DC adapter

¢ 4 x AA non-rechargeable batteries
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C.3 Installation

Package Contents

The Easy Config package contains the following items:
e Easy Config device
e AC/DC power adapter

e Interface cable with DB-9 male and female connectors.

Connecting the Interface Cable
The control port of the Easy Config terminates in a D-type 9-pin male connector.
» To connect the Easy Config to ASMi-52:

1. Connect the female connector of the supplied interface cable to the Easy
Config port designated CONSOLE.

2. Connect the male connector of the interface cable to the ASMi-52 port
designated CONTROL.
Connecting the Power

Power is supplied to the Easy Config via an external AC/DC power supply or via
four AA non-rechargeable batteries.

To reduce the risk of electric shock and fire, use only AC/DC power adapters
supplied with the unit.

Warning
» To connect the external power adapter:

1. Push the external power adapter plug into the round DC socket designated
5V, 1A DC.

2. Connect the external AC/DC power adapter to the mains outlet.
» To insert batteries:
1. Loosen the four screws on the back cover of the Easy Config.
2. Remove the back cover by lifting it straight up.
3. Insert four AA non-rechargeable batteries into the battery compartment.

4. Replace the back cover by reversing the procedure described in steps 1-2.
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C.4 Operation

Turning the Easy Config On

» To turn the Easy Config on:

Set the top panel BAT switch to OFF if the Easy Config receives power from
the external AC/DC adapter.

or

Set the top panel BAT switch to ON if the Easy Config receives power from the
AA batteries.

Caution 1, o eave the Easy Config in the battery-fed mode if not in use. This drains
power from the batteries. The dead batteries may leak, damaging the unit.

Front Panel Controls

Figure C-T illustrates the Easy Config unit and designates its main components.
Table C-1 describes functions of the front panel controls.

Table C-1. Front Panel Controls

Name Function

ENTER Inputs data and confirms the changes made in the ASMi-52 operation

¥ (Scroll Down)  Scrolls the display down the LCD

» (Scroll Right) Scrolls the display horizontally across the LCD

ESC (Escape) Exits to the previous menu

Working with the Easy Config

Note

ASMi-52 Ver. 2.5

Once the Easy Config is powered up and connected to ASMi-52, it can be used for
managing the modem.

To start the Easy Config control session:

Immediately after the power-up press the ESC button when PASSWORD is
displayed on the LCD.

The ASMi-52 main menu is displayed.

If 10-minute security timeout is enabled for ASMi-52 (Configuration > System
Configuration > Control Port > Port Control > Terminal > Security Timeout),
and no user activity has been detected for this period of time, the modem
terminates the control session. In this case the Easy Config has to be powered
down and powered up again to re-initiate the session.

The Easy Config has be powered down and powered up again if it stops
responding to the user input.

Operation Cc-3
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Scrolling the ASMi-52 Menus

The Easy Config enables the user to scroll through the ASMi-52 menus. The menu
structure is circular — the menu screens are displayed on the LCD one after
another in cyclic order.

» To scroll down the menus:
e Press the ¥ (Scroll Down) button.

» To scroll across the menus:
e Press the # (Scroll Right) button.

» To increase the scroll speed:

e Press and immediately release the # (Scroll Right) button.

» To reduce the scroll speed:
e Press and hold down the ¥ (Scroll Right) button.

Accessing the ASMi-52 Menus

» To access a menu:

e Use the ¥ and # buttons to move the cursor to the desired menu and press
the ENTER button to access the menu or submenu.

» To exit a menu:

e Press the ESC button to exit to a previous menu.

Choosing Options
» To choose an option:

1. Use the ¥ and ¥ buttons to move the cursor to the desired option and press
the ENTER button to select it.

2. Select Save from the current menu to save your change.

Entering Alphanumeric Values

The Easy Config also allows entering of alphanumeric values, when, for example,
you need to define the host IP address or enter device information.

» To enter an alphanumeric value:
1. Display the desired menu.
2. Press the ENTER button.
enter is displayed in the top row of the LCD.

3. Hold down the ¥ button, and press the # button several times.

Display scrolls through the available characters and numbers in the top row
of the LCD.

4. Keep on holding the ¥ button, until the desired value is displayed, then press
the # button to select the value.

The selected value is displayed in the bottom row of the LCD.
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Repeat steps 3—4 to complete the selection.
= Use the s character as a space
= Use the ESC button to delete the last entered character.

Press the ENTER button to accept selected values.

If an invalid value is entered, Error Reconfigure message is displayed
on the LCD. Press the ESC button to return to the previous menu.

When it is necessary to confirm or cancel the selected action (for example,
when resetting the unit), follow steps 3—4 to choose y or n from the available
character list and press the ENTER button to accept the selection.

For example:
» To assign 111.222.33.44 IP address to the ASMi-52 host via the Easy Config:

1.

ASMi-52 Ver. 2.5

Move the cursor to the Host IP Address menu (Configuration > System
Configuration > Management > Host IP).

Press the ENTER button.
The following display appears:

Hold down the ¥ button, and press the # button several times.

Display scrolls through the available characters and numbers in the top row
of the LCD.

0

Keep on holding the ¥ button, until the desired value is displayed, then press
the % button to select the value.

The selected value is displayed in the bottom row of the LCD.

1
1

Press the % button two more times to complete the first portion of the host IP
address.

1
111

Hold down the ¥ button, until s is displayed in the top row.

s
111

Operation C-5
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7.

9.

10.

Press the # button to select the value.
The s character designating space is stored in the bottom row:

s
111s

Repeat steps 4-7 to enter the remaining values. Mind the spaces between the
IP address portions.

The resulting display should look as follows:

s
111s222s33s44s

Press the ENTER button to complete the data entry.

Select Save from the Management menu.

Assigning Timeslots

The Easy Config offers an alternative method of the E1 or T1 timeslot assignment.
Instead of moving the cursor in the menu to every timeslot and assigning it to carry
data or idle code, it is possible to specify assigned timeslots directly.

» To assign timeslots:

1.

4,
Notes

5.

From the Time Slot Assignment menu (Configuration > E1 Configuration > ET
Local Port Configuration > Time Slot Assignment), select 34 CLEAR to
disconnect all timeslots.

Hold down the ¥ button, and press the # button to initiate the alphanumeric
value enter mode.

Enter the numbers of the timeslots to be assigned to carry data, as explained in
the Entering Alphanumeric Values section above. The timeslot number must be
separated by spaces (character s).

The resulting display should look as follows:

s
11s12s13sl4s

Press the ENTER button to complete the entry.

Up to four timeslots can configured at a time.
Timeslot O can be configured to the loop or transparent mode only via the
menu.

Save the changes.

Turning the Easy Config Off
» To turn the Easy Config off:

C-6 Operation

Set the top panel BAT switch to OFF and disconnect the AC/DC power
adapter from the mains.
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Adapter cable
CBL-RJ-45/2BNC/E1, 1-5
Aging timeout, 4-9
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Alarm Relay, 1-14
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clearing, 6-10
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—B—
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Configuration
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network managers, 4-3
physical ports, 4-22
port control mode, 4-18
power spectral density, 4-25
preliminary telnet host, B-7
QoS mapping, 4-9
remote card mode, 4-15
Serial DTE interface, 5-4
SHDSL interface, 4-22
SHDSL repeater, 4-27
Snext margin, 4-24
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terminal port, 4-18
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AC power, 2-4
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DC Power, 2-4
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control, A-4
DTE, A-1
E1/T1, A-3
Ethernet, A-3
Control port
CTS state, 4-17
DSR state, 4-18
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interface characteristics, 3-7
parameters, 4-16
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—D—
Data forms
navigating, 3-9
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Dedicated timeslot, 3-10, 4-5
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Default IP communication
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application, B-2
ARP table, B-24
assigning LAN IP address, B-8
changing LAN IP address, B-9
data port, B-3
default parameters, B-6
device control, B-20
device identification, B-15
DHCP relay, B-12
diagnostics, B-26
downloading new software, B-21
erase current configuration, B-28
erasing software, B-28
frame relay protocol parameters, B-17
interface parameters, B-15
learning mechanism, B-7
LEDs, B-4
management access, B-14
management subsystem, B-5
management utility, B-9, B-10
menu map, B-10
multicast forwarding, B-19
multicast IP, B-19
new software, B-29
PPP protocol parameters, B-18
preliminary configuration, B-6
quick setup menu, B-11
reset, B-22
Reset LAN, B-22
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reset to default values, B-22
Reset WAN, B-23

resetting, B-22

static groups, B-19
statistics, B-25

technical specifications, B-2

—l—

LAN
Aging timeout, 4-9
autonegotiation, 4-12
Configuration, 4-7
fault indication, 4-12
rate, 4-10

LEDs, 1-12
front panel, 3-3, 6-8
IR-IP, B-4
test, 6-24

Line interface, 1-1, 1-4, 1-13

Line Interface
SHDSL, 1-12

LLB/RLB
activation, 5-4

Log file, 6-10

Logging out, 3-15

Loopback, 1-14
activating, 6-19
clearing, 6-24
deactivating, 6-24
local, 1-14, 6-20
mux units, 6-20
remote, 1-14, 6-22
repeater test, 6-23
tests, 6-19

Low speed mode, 4-16

—M—
Management, 1-9, 3-9
ConfiguRAD, 1-9, 3-9
RADview, 1-9
Management access
controlling, 4-4
Management parameters
configuration, 4-1
Management port
10/100BaseT, 1-12
Ethernet port, 1-14
V.24/RS-232 control port, 1-14
Management utility
IR-IP, B-9
menu structure, B-10
starting, B-10
Manager list, 4-3
Map Timeslot, 4-5
Menus
BERT, 6-18
BERT pattern, 6-18
BERT Performance, 6-18
BERT results, 6-19
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configuration, 4-13

control port, 4-16

control port rate, 4-17

device information, 4-2

diagnostics, 6-21

DTE configuration, 5-4

DTE local port, 5-5

DTS configuration, 4-5

E1 local port, 4-29

E1 port performances, 6-5

E1 sync mode, 4-31

factory default, 4-47

framed mode, 4-30

host IP, 4-3, 5-3

inventory, 4-42

inventory and configuration, 3-12

LAN Configuration, 4-7

local reset, 4-49

local/remote test, 6-22

main, 4-41

management, 4-1

management access, 4-4

manager list, 4-3

master clock, 4-14

master clock (internal), 5-2

monitoring, 4-37, 6-9

navigating the management, 3-8

physical port statistics, 6-1

physical port status, 4-39, 6-11

port status, 4-39

repeater reset, 4-49

repeater test, 6-24

reset, 4-48

SHDSL local port, 4-23

SHDSL port performances, 6-2

SHDSL remote port, 4-23

Snext margin, 4-24

sync mode, 4-31

system configuration, 4-14

system monitoring, 6-10

terminal, 4-19

TFTP, 4-43

timeslots mapping, 4-33

typical data rate, 4-28
Modem glue logic, 1-12
Monitoring

performance, 6-1
Multiplexer

conditions, 1-7

—N—

Normal indications, 3-3, B-4
service, B-4

—0—

Operating temperature, 2-2

—p—
Package Contents, 2-2
Password, 4-40
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changing, 4-20

default, 4-40
Performance monitoring, 1-14
Physical

description, 1-10

Plastic Enclosure, 1-15
Pinout

RJ-45, B-3

Point-to-Point Protocol (PPP), B-1

Port alarms
masking, 6-11
Port log file, 6-15
Port status, 6-10
display, 4-39
Power Cables, 2-4
Power Source, 1-15
Power-up
self-test, 6-8
Power-Up Indications
configured IP router card, B-4
unconfigured IP router card, B-4
Preliminary Configuration, B-6
Prerequisites, 2-2

—Q—
QoS Mapping
LAN rate, 4-10

—R—
Rem Agent Table, 4-5
Remote ASMi-52
accessing, 4-39
Remote loopback
repeater, 6-23
Reset
factory default, 4-47
SHDSL interface, 4-48
Router
IR-IP Ethernet, B-3

Router LAN interface address, B-7

—S—

Screen
E1 current day performances, 6-6
E1 current performances, 6-5
password request, 4-40
port log file, 6-16

SHDSL current day performances, 6-3

SHDSL current performances, 6-2
software version, 4-46
system status, 4-38
total alarms, 6-9
Setting communities, 4-3
SHDSL
clearing statistics, 6-4
current margin, 4-25
line interface, 5-4
line probing, 4-26

-4
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loop attenuation, 4-26
Power backoff, 4-23
power spectral density, 4-25
repeater, 1-10
repeater reset, 4-49
Signal-to-noise ratio, 4-26
Snext margin, 4-24
statistics, 6-1
statistics parameters, 6-3
Site Requirements, 2-2
SLIP, 4-18
Software
swapping, 4-46
update, 4-42
version, 4-46
Statistics
collection, 1-10
Status
display, 4-37
Subnet mask, 4-3
Sync mode, 4-34
Sync Mode, 4-31
System log file, 6-10
System parameters
setting, 5-2

.,
T1
configuration, 4-35
Fbit transmission, 4-35
framed mode, 4-35
interface, 4-35
line coding, 4-35
receive gain, 4-35
statistics, 6-4
transmit signal mask, 4-35
Technical Specifications
LAN, B-2
router, B-2
WAN, B-2
Technical Support, 6-25
Telnet
password, B-14
setting inactivity timeout, B-14
Terminal
change access, 4-19
pop-up alarms, 4-20
preparation, 3-7
rate, 4-17
security timeout, 4-20
Terminal port
configuration, 3-7
Tests
BERT, 6-17
loopback, 6-16
TFTP
installing new software, 4-43
Timeslots mapping
ET mux, 4-33
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Timeslots mapping
E1, 4-32

Timing, 1-8, 1-14

Troubleshooting, 6-15

TSA, 4-34

Turning off, 3-15

—U—

Unit enclosure, 1-2
Unit identical settings, 4-34
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User name, 4-40

—\V—
Versions, 1-1
Virtual connection, 4-39

—X—
XMODEM

installing new software, 4-44
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Supplement
Drilling Template for Wall Installation

Front Panel

176 mm (6.92 in)

101.6 mm (4 in)

>
[

v

This panel is drawn to scale.
To drill the holes for a wall installation, tear this page out

of the manual or print it on letter-size paper (8.5"x11.0") and
hold it against the wall.

LEDs facing up - drill at 1.
LEDs facing down - drill at 2.
LEDs facing left - drill at 3.
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m 24 Raoul Wallenberg St., Tel Aviv 69719, Israel
Tel: +972-3-6458181, Fax: +972-3-6483331, +972-3-6498250
E-mail: erika y@rad.com, Web site: www.rad.com

Customer Response Form

RAD Data Communications would like your help in improving its product documentation.
Please complete and return this form by mail or by fax or send us an e-mail with your
comments.

Thank you for your assistance!

Manual Name: ASMi-52

Publication Number: 148-200-04/06

Please grade the manual according to the following factors:

Excellent  Good Fair Poor  Very Poor
Installation instructions 3 0 0 0 0
Operating instructions 0 0 ) ) O
Manual organization 0 0 ) ) O
llustrations 0 O 0 0 0
The manual as a whole 0 O 0 0 0

What did you like about the manual?
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Error Report
Type of Error(s) Incompatibility with product
or Problem(s): Difficulty in understanding text
Regulatory information (Safety, Compliance, Warnings, etc.)
Difficulty in finding needed information
Missing information
lllogical flow of information
Style (spelling, grammar, references, etc.)
Appearance

Other

uaaoaaoaaaoaaan

Please list the exact page numbers with the error(s), detail the errors you found (information missing,
unclear or inadequately explained, etc.) and attach the page to your fax, if necessary.

Please add any comments or suggestions you may have.

You are: Distributor
End user
VAR

Other

aaaa

Who is your distributor?

Your name and company:

Job title:
Address:

Direct telephone number and extension:

Fax number:

E-mail:
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